
Concur Travel & Expense Release Notes 

How to Find Information in this Document 

This compilation of release notes may be searched using Adobe's search 
functionality. If you are looking for a specific issue number or feature, use the 
following instructions to bring the information to view. 

 To use Adobe's search feature: 

1. With the document open in Adobe Reader, type a search word in the box 
provided in the toolbar. 

 

2. Click Find Next in Current PDF. 

3. The document opens to the first instance of the search criteria. 
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Release Notes – January 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• Processor Can Now Recall an Expense Report 
Under selected conditions the Processor can now elect to recall an expense 
report. 

• Cash Advance Admin Email Notification for Pending Cash Issuance 
The Cash Advance administrator can now receive an email notification stating 
that a cash issuance is pending their approval. 

• Pending Card Transaction Payment Type 
This payment type lets a user put an expense in a holding state to prevent 
submission until it is matched to a transaction. 

• New Audit Rule Amount-Yearly Total 
This new audit rule is available for clients who wish to check for variances 
above and below an amount against the Calendar year. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 2:  Expense 

The following features are included in this service release. 

Processor Can Now Recall an Expense Report 

Overview 

The Processor can now recall an 
expense report from within the Expense 
report list. This function allows the 
Processor to return a report pending 
payment to the previous processor step 
of workflow for additional review or changes. The button appears alongside the Send 
Back button as shown in the figure below: 

 

The button is available under the following circumstances: 

• When the report has not yet been extracted or paid 

• When any payments for that report are in open batches for Expense Pay 

• When a processor workflow step was skipped, the result of the recall to now 
include that previously skipped step in the updated workflow 

• Only when the report has passed a Processor step, but not during the time it 
is in a Processor's queue (this prevents recall under a two-processor workflow 
model where the report is with, or pending, the second processor) 

Once recalled, the workflow is rolled back to the most recent processor workflow step 
(if multiple processor steps are included), noting again that, if a processor step is 
skipped, it will not be skipped following the recall action. In addition, no notification 
email is sent to the employee on recall, but the employee will receive notification 
when the report is approved and continues through workflow. 

Configuration 

To enable this feature, submit a Service Request to Concur. 

 Refer to Expense: Expense Processor User Guide for more information. 

Business Purpose 

This enhancement gives the Processor 
flexibility when working with expense 
reports. 
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Send Email Notification When a Cash Advance is Pending the Admin 

Overview  

A new option available when assigning 
the Cash Advance Administrator role 
allows this user to receive a workflow 
email notification when a cash advance 
arrives in their queue for issuance. 

 

How It Works 

The system will look up the correct cash advance administrator based on the 
hierarchy of the cash advance. This means the system will "walk" up the hierarchy 
until it finds the correct cash advance administrator. Then, every administrator at 
that node (level) is notified via email notification if they are configured to receive the 
email notification. 

 Refer to Shared: User Administration User Guide and Expense: Cash Advance 
Setup Guide for more information. 

Business Purpose 

This enhancement alerts the Cash 
Advance admin to a pending issuance. 
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User is Alerted that Caps Lock is On When Logging In 

Overview  

Concur has added a new feature to 
assist with failed login attempts. Users 
are locked out after X number of failed 
login attempts. To prevent a failure due 
to the Caps Lock being on, Concur has 
added a message to the user based on the Password field on the Login page that 
would show/hide as the user is typing depending on whether or not Caps Lock was 
detected. 

This is the message that is displayed when Caps Lock is on and the user has entered 
the first letter: 

Warning: Caps Lock is ON! 
Passwords are case sensitive.  

What the User Sees 

When the Caps Lock is off: 

 

When the Caps Lock is on: 

 

Business Purpose 

This enhancement saves the user time 
and frustration when logging into the 
service.  
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Delegate List Filtered by Approval Limits 

Overview  

The delegate list that appears to 
approvers can now be filtered to only 
show approvers with the same or higher 
approval limits. When using an 
authorized approval hierarchy, the 
approvers are evaluated on each level. The approver still selects individuals to 
promote to delegates. If the delegate has an equal or higher approval limit compared 
to the selecting approver on any level the Can Approve check boxes will be 
editable. Delegates without the proper limit authority will have inactive Can Approve 
check boxes. 

In the following image, Pat Davis has the correct limit approval authority to delegate, 
while Bailey Gato does not. 

 

NOTE: This feature is available in both Expense and Travel Request Delegate 
Configurations, however the feature always uses the Expense Authorized 
Approver information. Refer to the Travel Request Release Notes for more 
information. 

Example 

AUTHORIZED APPROVER TABLE 

 

Approver Level 1 Level 2 Limit Exception 
Approval 
Authority 

A Acme Sales 2000 USD No 

A Widgets Sales 1000 USD No 

B Widgets Sales 2000 USD No 

C Acme  10000 USD Yes 

D Widgets Sales 1000 USD No 

D Acme Ops 2000 USD Yes 

E Acme Sales 1500 USD No 

F Acme Ops 2000 USD No 

G Acme  500 USD No 

Business Purpose 

This new feature helps restrict 
delegation of approval authority, based 
on approval limits. 
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Approver A has two different approval limits based on the authorized approver 
hierarchy. The following approvers are eligible to be approver delegates for Approver 
A: 

B: This approver has a higher limit approval than A at the Widgets-Sales level of 
the hierarchy. 

C: This approver has a higher limit approval than A at the Acme level of the 
hierarchy. 

D: This approver has an equal limit approval than A at the Widgets-Sales level of 
the hierarchy. 

The following approvers will not be eligible to be approver delegates: 

E: This approver has a lower limit approval than A at the Acme-Sales level of the 
hierarchy. 

F: This approver does not have a limit approval at any of the hierarchy levels 
available to A. 

G: This approver has a lower limit approval than A at the Acme level of the 
hierarchy. 

Configuration 

This setting is applied on the Delegate Configuration page of Expense Admin: 

 

If this setting is selected, the delegate list presented to approvers will only contain 
other approvers with the same or higher limit approval. 
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Authorized Approvers: Workflow Step Goes Straight to Approver with 
Required Limit Approval 

Overview  

A new configuration option has been 
added to the Workflows page, called 
Use default approver lookup to find 
authorized approver. When selected, 
the authorized approval workflow step will select the next approver within the user’s 
default approver chain that has the required limit approval to approve the report. 
The other approvers in the chain that do not have authority to approve the report 
amount will not receive the report in their approval queue.  

Please note the following about this feature: 

• The workflow can only contain one Authorized Approval step when using this 
option. 

• The approver field for the Authorized Approval step should not be editable by 
the user or approver. 

• If user-added steps are enabled, they should not be set as Authorized 
Approval steps. 

• This feature does not apply to the Cost Object Approval step. 

• This feature works best with a flat (no levels) hierarchy.  If levels exist, 
default approvers may be disqualified as appropriate approvers for the report 
when they are not authorized approvers in the appropriate place in the 
hierarchy. 

Examples 

Workflow configuration 

Step 1 – Regular Approver 

Step 2 – Department Manager 

Step 3 – Authorized Approver 

Step 4 – Processor 

AUTHORIZED APPROVER TABLE 
Approver Limit Default approver for this 

user 

A1 100 A2 

A2 1000 A3 

A3 5000 C10 

C1 100 C2 

Business Purpose 

This new feature streamlines the limit 
approval process. 
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Approver Limit Default approver for this 
user 

C2 1000 C3 

C3 5000 C10 

C10 Unlimited  

EXAMPLE 1 

Employee submits a report for 4000. Employee’s default approver is A1. 

Workflow 
Step 

Type Role Approver Logic 

1 Regular Approver Line Manager A1 Report goes to A1, 
employee’s default 
approver. 

2 Regular Approver Department 
Manager 

A2 Report goes to A2, A1’s 
default approver 

3 Authorized 
Approver 

Signing Manager A3 Authorized Approver 
resolution starts with 
A1, the employee’s 
default manager. A1 
has insufficient 
authority and is 
discarded. A1’s default 
manager is evaluated 
next. A2 has 
insufficient authority 
and is discarded. A2’s 
default manager is 
evaluated next. A3 has 
sufficient signing 
authority and is 
assigned to this step. 

4 Processor Processor   

EXAMPLE 2 

Employee submits a report for 12,000. Employee’s default approver is A1. 

Workflow 
Step 

Type Role Approver Logic 

1 Regular Approver Line Manager A1 Report goes to A1, 
employee’s default 
approver. 

2 Regular Approver Department 
Manager 

A2 Report goes to A2, A1’s 
default approver 
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Workflow 
Step 

Type Role Approver Logic 

3 Authorized 
Approver 

Signing Manager C10 Authorized Approver 
resolution starts with 
A1, the employee’s 
default manager. A1 
has insufficient 
authority and is 
discarded. A1’s default 
manager is evaluated 
next. A2 has 
insufficient authority 
and is discarded. A2’s 
default manager is 
evaluated next. A3 has 
insufficient authority 
and is discarded. A3’s 
default manager is 
evaluated next. C10 
has sufficient signing 
authority and is 
assigned to this step. 

4 Processor Processor   

Additional Notes 

The assigned approver is re-evaluated at the point in time that the report enters the 
authorized approver step. If the approver data has changed since submission, the 
assigned approver may also change. 

• If the default approver for the employee or any approver in the lookup path 
has been changed, the new default approver data will be used. 

• If an approver has been inactivated, that approver is no longer eligible to 
approve the report. 

• If a default approver has been removed and not replaced (blank field) from 
one of the user profiles in the lookup path AND that approver was previously 
selected as the authorized approver, that approver will still be used so that 
the report continues to move through the workflow. 

Configuration 

This setting is configured on the General step of the Workflows page. 
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When this option is selected, the following settings are ignored: 

• Only display approvers at or above the current approver’s level 

• Restrict approvers to those with limit authority for employee-added steps 

Pending Card Transaction Payment Type Prevents Submit Before Match 

Overview  

Often, clients wish to place an expense 
in a holding state to prevent submission 
until that transaction can be matched to 
an actual card transaction. For example, 
when an expense created from a travel 
booking, lacking a matching card transaction, is submitted erroneously as cash.  

With this release, a new system payment type of Pending Card Transaction allows a 
user to do this with these copied card transactions and their One-Click transactions 
as well.  

What The User Sees 

In practice, a user under a Group segment that includes this payment type and 
supports cash can elect to change the Cash value to Pending Card Transaction at the 

Business Purpose 

This enhancement allows control over 
card transactions that might otherwise 
be erroneously submitted.  
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entry level. Then, when they match the card transaction to the expense, the 
payment type is overridden to correspond to the configured payment type for the 
associated card. Most importantly, when expenses are created automatically by the 
system they will be created with this payment type until they are matched to a card 
transaction. 

Scenario 

The user completes a trip booked in the Travel part of the system. On the last day of 
the trip, the one-click icon appears on the trip list, allowing the user to auto-create 
an expense report from that trip. Each reservation in the travel booking trip will 
create a corresponding entry on the expense report. Airfare transactions have an 
amount, as the system knows what the actual cost was that was charged for airfare 
since it was purchased in Travel. Other types of expenses like hotel or car rental are 
created with a zero amount as a placeholder for the actual charge, since the booking 
reservation does not know what the final charge will be, due to additional charges 
such as fuel for car or room service for hotel. 

With this option on, these transactions would be assigned the Pending Card 
Transaction payment type. An expense with this payment type may never be 
submitted, as the system will block the submission and provide an exception 
message to the user. The user is allowed to edit the payment type, as there are 
always valid business reasons for an exception to policy where the user may have 
used a personal card or other payment method to settle the bill. Each time the user 
opens an unsubmitted expense report, the system will check all expenses not yet 
matched to a card transaction against any card transactions that have arrived since 
the last check to look for new matches to propose to the user.  

NOTE: A user without an active company card assigned to them will never see this 
payment type, even if active for their group. 

Configuration 

The new Pending Card Transaction payment type is not linked to any group by 
default with the release - this task must be performed before the payment type can 
be used within the group. The new payment type is available via Expense Admin > 
Group Configuration > Modify (Payment Types), and is shown in the figure 
below: 
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 Refer to Expense: Payment Types Setup Guide for more information. 

Expense Categories Now Available in the New Interface 

Overview  

With this release the Expense 
Categories functionality is moved from 
the classic interface to the current 
interface. Clients using Authorization 
Requests will see the new Expense 
Categories tab under the Expense Types administrative function (Expense Admin > 
Expense Types). Each category exists as a single row with the associated expense 
types. Selecting a row allows the user to add, edit, and delete the category.  

Business Purpose 

This enhancement brings the very last 
Expense administrative function to the 
new user interface! 
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Note that this feature appears for users whose authorization request policy attributes 
include the Authorization Request Workflow and a defined Authorization Request 
Header form. 

 Refer to Expense: Expense Types Setup Guide for more information. 

Audit Rules: Amount-Yearly Total 

Overview  

A new audit rule, Amount-Yearly Total, 
is now available for clients who wish to 
check for variances above and below an 
amount against the Calendar year. 

The audit rule is used with the Entry 
type Data Object for Submit Events. It allows the administrator to specify an amount 
against which a user creating entries of the same base currency and expense type, 
within reports generated in a Calendar year, will be flagged should the user exceed 
the set amount.  

The new audit rule is shown in the figure below: 

Business Purpose 

This enhancement adds another audit 
rule that can track expenses across a 
specific time period. 
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 Refer to Expense Audit Rules Setup Guide for more information. 
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Section 3:  Expense Pay 

The following features are included in this service release. 

Expense Pay EMEA: Support for Euro Payments to Employees in 
Switzerland 

Overview  

The Bank Information page of Profile 
has been enhanced to allow users in 
Switzerland to enter Euro bank 
accounts.  

Configuration 

No additional configuration is required to use this feature. 

Expense Pay EMEA: Support for Euro Payments to Employees in Sweden 

Overview  

The Bank Information page of Profile 
has been enhanced to allow users in 
Sweden to enter Euro bank accounts. 

Configuration 

No additional configuration is required to use this feature. 

Funding Account: Additional Fields That Trigger Account Confirmation 

Overview  

The Funding Account page only begins a 
new account confirmation when certain 
fields change. This release adds the 
Mandate ID and Date Bank 
Authorized Debits from Concur fields 
to the list of fields that trigger a new account confirmation.   

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This new feature expands support for 
Euro user bank accounts. 

Business Purpose 

This enhancement supports European 
banking requirements.  

Business Purpose 

This new feature expands support for 
Euro user bank accounts. 
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Funding Account: Secondary Contact Information Fields Added 

Overview  

The Funding Account page has been 
enhanced with fields to enter a 
secondary contact person for the 
funding bank account.   

 

Configuration 

No additional configuration is required to use this feature. 

 

 

Business Purpose 

This enhancement provides an 
additional contact for funding banks.   
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Section 4:  Documentation Updates 

The following documentation changes are included in this service release. 

Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  

 

This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 5:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 7.0 

Support for Firefox version 7.0 under both the Mac OS X and Microsoft Windows 
operating systems is certified for this release. 

Support for Google Chrome v. 15.0 

Support for Google Chrome version 15.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Firefox v. 8.0 

Support for Firefox 8.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Chrome v. 16.0 

Support for Google Chrome 16.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 



Concur Release Notes Page 21 Expense Professional / Premium 
January 2012 Concur Clients 

Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, January 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – January 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

101203-
000040 

Expense / Search Functionality 
Searching in the User Permissions and Proxy search fields using a value with a 
leading space causes no results to appear. 

110721-
001178 

Expense / Search Functionality 
Attendee Search Criteria Reset button is not functioning properly. 

110805-
000783 

Expense / Smart Expenses 
Business Purpose field configured as Copy Down at entry level is not auto-
populated. 

110913-
001426 

Expense / Personal Attendee Import 
An import including double-byte characters, such as the Japanese and Chinese 
languages, is causing an error.  

110929-
000359 

Expense / Forms & Fields 
Hidden fields Country and State/Province in Expense detail form do not 
appear and thus cannot be extracted. 

111004-
000327 

110721-
000203 

 

Expense / Processor 
Approving multiple reports within which a line entry has been sent back 
causes the system to not alert the Processor to send back the report. 

111031-
000658 

Expense / Austria Travel Allowance 
Extended Trip using Calendar Days in a Month not functioning. 

111101-
000065 

Expense / German Translation 
Client request to reword German language travel allowance string text. 

111109-
000326 

Expense / Czech Travel Allowance 
Incorrect Meal Per Diem amount calculation of 85% instead of 100% 
performed under Czech travel allowance. 

111121-
000062 

Expense / Mileage Reimbursement 
Mileage reimbursement rates cannot be modified. 

111121-
001076 

Expense / Imaging - Receipt Store 
JPG images emailed to Receipt Store cannot be rotated and saved using the 
Rotate Image functionality. 

111127-
000124 

Expense / Forms & Fields 
Receipt Number field number value cannot be saved - system appears to 
continue cycling. 

111129-
000174 

Expense / Imaging 
Resizing an image within a window can cause the window to disappear and 
the image to not remember the resizing. 

111205-
000015 

Expense / Email Notifications 
Delegates incorrectly receive recall report email notification when the Receives 
Email setting is cleared (inactive). 
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Case ID Case/Defect Description 

111207-
000058 

Expense / User Interface 
Column headings are difficult to read in the Single Day Itinerary grid form, 
especially in German.  

111208-
000001 

Expense / Attendees 
The Cost Per Attendee calculation is not precise; this is especially true for 
larger amounts. 

111208-
000055 

111121-
000013 

111213-
000002 

Expense / Authorization Requests 
Incorrect currency appears in expense report header under Authorization 
Requests. 

111209-
000284 

Expense / Expense Reports 
Attempt to delete a report only results in the expense entries being deleted - 
the report itself is not deleted. 

111212-
001239 

Expense / Credit Card 
Viewing Credit Card Activity & Current Statement drop down control causes 
the system to fail to show other credit card transaction history. 

111222-
001197 

Expense / Search Functionality 
Apostrophe causes Search functionality in Approver, BI Manager, and User 
Admin to fail; user can search using same technique for Proxy however. 

111227-
000848 

Expense / Account Codes 
Accounting tree view is incomplete - it does not display all accounting codes. 

111230-
000000 

Expense / Forms & Fields 
Country field, set as Visible on Report Header form, does not take the value, 
but instead defaults to the system employee value instead. 
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Section 2:  Resolved Issues - Jobs 
Case ID Description 

111116-
000139 

Expense / Company Card: 
Recognize and categorize AdjustmentReasonCodes for Citibank Korea 
MasterCard CDF 3.0 feeds. 

111121-
001601 

Expense / Company Card: 
Recognize additional Argentinian payment transaction in American Express 
GL1022.  

111130-
000218 

Expense / Company Card: 
Recognize and categorize AdjustmentReasonCodes for HSBC MasterCard CDF 
3.0 feeds. 

111213-
000238 

111215-
000352 

111219-
000143 

111221-
000514 

Expense / Jobs: 
Prevent socket write error causing multiple job failures. 

120106-
001165 

Expense / Company Card: 
Recognize and categorize AdjustmentReasonCodes for Charter One 
MasterCard CDF 3.0 feeds. 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 

 

With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, January 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – February 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• Next Button Appears On Adding or Editing Itinerary 
To ensure a user makes adjustments in Travel Allowance after adding an 
itinerary to a report, a Next button is added to remind the user to proceed 
through these tasks before finishing. 

• View of Who a User Can Delegate for in Profile and Emp Admin 
A new view in Profile and User Admin allows a user to view who they are 
allowed to act as a Delegate for. 

• New Read-Only Employee Auditor Role Available 
A new Employee Auditor (Read-Only) role allows a user assigned this role to 
view employee information, but restricts them from editing or creating a new 
employee record. 

• Password Suppression Forces User to Log In via SSO 
The ability to provide and use a password can be restricted, forcing users to 
log in using SSO rather than presenting the typical username and password 
credentials. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 2:  Expense 

The following features are included in this service release. 

New Module Setting to Suppress Password Access 

Overview  

With this release, there is a new setting 
that will prevent any password changes 
within Concur. If the new setting is ON, 
all password fields in Company Admin 
(User Administration or Password 
Administrator) become non-editable (deactivated): 
 

 

When a new user is added – either via the import or when manually added by the 
User Admin – the system provides a randomly generated 20-character password.  

This feature will be helpful for customers using Single Sign On (SSO). In most cases, 
the user won’t know their password and the customer will not want an administrator 
to have the ability to change the random password. Used in conjunction with the 
existing setting for removing password access from users, this can completely block 
sign on outside of the SSO validation. 

Configuration 

This setting (module property) is managed by Concur. Clients interested in using the 
feature should open up a support ticket via Concur Client Central. Please advise that 
you would like the Prevent Administrative Password Changes module set to 
True.   

! IMPORTANT: Module properties are only accessible by Concur. If you would like 
to enable one of these new module properties, open a support ticket via Concur 
Client Central.  

Business Purpose 

This enhancement provides an 
additional level of security for the ultra 
security conscious company. 
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Travel Allowance Wizard: Next Button Directs User to Adjustments 

Overview  

Often when creating a report that 
includes itineraries the user can forget 
to access the Expenses & 
Adjustments tab to adjust and create 
fixed allowances.  

To force the user to this tab and its 
options, a Next button is now displayed when the report owner access the 
Create/Edit Itinerary screen and attempts to add another itinerary or edit an 
existing itinerary in the report.  

Configuration 

The button will only show for users who also see the Expenses & Adjustments tab. 
Otherwise, no additional configuration is required to use this feature. 

Employee Can Now View Who They Can Delegate For 

Overview  

Employees and employee administrators 
can now quickly determine who the 
employee can delegate for. This new 
view gathers the names and 
permissions of these delegates into the 
Delegate For tab, available to the 
employee via Profile, and to the Employee Administrator role by opening User 
Administration and reviewing delegate assignments for a user. 

How It Works 

In the figure below, Erin Fletcher has added Terry Brown as a Delegate. Terry can 
now open Profile and find Erin's name as a user she can delegate for.  

Business Purpose 

This enhancement brings additional 
visibility to the Delegate configurations 
for employees and administrators. 

Business Purpose 

This usability enhancement helps travel 
allowance users to remember to 
complete necessary steps. 
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This feature provides a broader view of the delegate arrangement, and allows the 
delegate to review what permissions they have been granted in a single view that 
matches that of the Employee Administrator.  

The employee administrators benefit from the ability to add new delegators from this 
page, allowing them to quickly set up a new user with access to the employees that 
person will act for as a delegate.  Previously the administrator would have to log into 
each employee to grant the new user delegate access for that employee. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Delegate Configuration Setup Guide for more information. 

Read-Only Employee Administrator Role Now Available 

Overview  

A new role, Employee Administrator 
(Read-Only) is now available via User 
Administration. This role can view 
employee information, but is restricted 
from creating or editing any employee 
data.  

Business Purpose 

This enhancement provides another 
tool for Help Desk or auditors. 
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This means this user can perform auditing tasks, but cannot actually change the data 
they review. Note also that a user with this read-only role who is also assigned the 
Employee Administrator role is granted the role with greater rights; in this case, 
Employee Administrator. 

The figure below shows the role in User Administration > User Permissions: 

 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Shared: User Administration User Guide for more information. 

Option to Restrict an Expense Report to Single Cash Advance 

Overview  

Clients working under specialized 
configurations have requested that 
expense reports created by users within 
a Group be restricted to allow only a 
single Cash Advance item per report.  

Configuration 

Concur will provide this ability at the Group level via a script, and not as an 
administrative entry point in the user interface. Clients interested in using the 
feature should open up a support ticket via Concur Client Central. Please advise that 
you would like the Restrict Report to a Single Cash Advance feature activated, 
and provide a list of the groups that should have the restriction.   

Business Purpose 

This enhancement provides necessary 
support for financial systems that 
cannot handle more than one cash 
advance on a report. 
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Section 3:  Expense Pay 

The following features are included in this service release. 

Expense Pay APA: Singapore Now Available 

Overview  

Expense Pay APA has been expanded to 
include payments in-country in 
Singapore. The payments are in 
Singapore Dollars. The program uses 
the Interbank GIRO direct debit process, which takes place over five days. This 
offering includes the following features: 

• Localized Funding Bank Account page 

• Localized Employee Bank Account page 

• Support for American Express Singapore Card Program 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

This feature requires a contract with Concur. Contact Concur Client Support to begin 
the process of adding this feature. 

Expense Pay APA: Australia Support for New Card Program 

Overview  

Support for the following card program 
has been added to the Expense Pay 
APA: Australia offering: 

• American Express Australia 

This card program supports negative payments. 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This new product expands the Expense 
Pay support in the Asia Pacific region. 

Business Purpose 

This enhancement expands card 
program support in Australia. 
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Section 4:  Documentation Updates 

The following documentation changes are included in this service release. 

Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  

 

This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  

 



Concur Release Notes Page 10 Expense Professional / Premium 
February 2012 Concur Clients 

Section 5:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 8.0 and 9.0 

Support for Firefox versions 7.0 and 8.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Support for Google Chrome v. 16.0 

Support for Google Chrome version 16.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Firefox v. 10.0 

Support for Firefox 10.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Chrome v. 17.0 

Support for Google Chrome 17.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, February 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
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Release Notes – February 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

120120-
001142 

Expense / Validation Rules 

Validation field update set to blank when parent entry validation field is 
modified and copied to child. 

111229-
000021 

Expense / Receipt Processor Role 

Expense Receipt Processor role appears to have access to Concur Classic, but 
there is no reason for this role to have this access. 

120103-
000153 

 

Expense / Merchant Code Mapping 

Expense type shows as None when modifying the merchant code mapping. 

120104-
000202 

Expense / Exchange Rates 

The Exchange Rate Variance audit rule fires when reverse exchange rates are 
found on the exchange rate table in the database (internal). 

120106-
000034 

Expense / Allocations 

A duplicate expense entry appears on creating and saving the entry under 
Google Chrome browser. 

120113-
000062 

Expense / Expense Entries 

An expense entry copied from another expense entry showing cities 
incorrectly carries that city over to the new, copied expense entry. 

120123-
000039 

Expense / Employee Maintenance Role 

Employee Maintenance role is not able to reset or update passwords for end-
users. 

120123-
000276 

120123-
000393 

Expense / Processor 

A processor reviewing reports finds that the Search fields are missing when 
attempting to search for attendees. 

120123-
000372 

120123-
001026 

Expense / Processor 

Exporting a list of reports onto an Excel sheet incorrectly results in the 
Employee Name field generating no value - it is blank. 

120123-
000447 

Expense / Attendees 

The total of an expense entry does not equal the costs per attendee when 
totaled up. 

120123-
000529 

Expense / Workflows 

New Authorized Approver workflow from approver to processor generates an 
Unexpected Software Error (UE). 

120123-
001237 

Expense / User Admin 

A server error is generated when attempting to assign the Expense User role. 
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Case ID Case/Defect Description 

120127-
000548 

Expense / Groups 

The Expense Configuration Administrator role has access to the Group 
Configurations link, but when it is clicked a Security Breach error message is 
incorrectly displayed. 

N/A Expense / User Administration 

The employee export from Expense to Travel was not respecting the company 
setting used to prevent employee name synchronization between products. 
The setting now handles name synchronization as expected by either 
enforcing or preventing synchronization depending on clients’ needs 
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Section 2:  Resolved Issues - Jobs 
Case ID Description 

111209-
000103 

Expense / User Permission: 
Support granting a user the Travel Profile permission as a standalone without 
additional roles. 

120209-
001667 

Expense / Company Card: 
Read the ROC ID field for American Express KR1025 APA feeds 

120127-
000041 

Expense / Company Card: 
Read the additional Description field for American Express TMKD feeds 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 

 

With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, February 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – March 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Please Note the Following Alerts 

Updates for French Language 

The updates listed below are planned for the French language in Expense. 

Planned for June Release 

The Concur team in France will be reviewing and revising the French (fr) language 
translations with changes to some core terminology anticipated for the June release.  
Clients with internal training materials and documents in French should expect that 
revisions will be necessary to match the updated terminology.   

 Refer to French Language Changes 2012 Fact Sheet for more information, 
including a table showing the changed terminology. 
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Section 2:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• New Attendee Administrator Roles and Attendee Management Screen 
Two new roles, Attendee Administrator and Attendee Administrator (Read 
Only) are now added, plus a new screen available from Expense Tools within 
which each role can work with attendees as their permissions allow. 

• Report Summary and Entry Summary Panels for Ease of Approving 
Approvers who cannot easily move from an expense view to the 
corresponding travel request entry to verify an expense can now work with 
two new panels that display this information together. 

• Best Practice Dashboard Includes Adoption Rate of Receipt Store 
Several enhancements are included in this release, including the ability to 
now measure the adoption rate among users for the Receipt Store feature. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 3:  Expense 

The following features are included in this service release. 

New Expense Report Summary View for Submitted Expense Reports 

Overview  

A new summary view of the expense 
report enhances the current view of 
reports for the approver and processor 
roles, and for users viewing their report 
after submission. This view is designed 
to bring together key elements of the report into a summary view, allowing rapid 
review and approval and processing without need to move from screen to screen. 

NOTE: This view will become the default view for a submitted report with the 
upgrade to this service release.  

What the User Sees 

Opening to the Initial View 

When the user first opens the submitted expense report, Expense displays a window 
on the right side showing details of the report in the right pane. When the user 
selects a specific expense on the expense list, this summary information remains in a 
new tab on the Expense pane, which is joined by the (optional) Receipt Image 
tab, used to view receipt images associated with the entry, if required.  

 

Business Purpose 

This enhancement displays the 
expense report in a summarized view 
for quick approval and processing. 
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This view allows the approver/processor to more readily review all of the information 
required to approve and process the report.  

Working With Receipts 

For the approver reviewing a report with line item receipts for the first time, the 
system will display a tutorial that explains how to work with receipts in Expense - 
this can be dismissed either for this session or all sessions.  

NOTE: This information overlays the main work pane and must be dismissed before 
the new summary area is visible. 

 

Returning to the Report-Level Summary View 

A new button, Summary, is available within the button bar above the listed 
expenses on the left side of the summary view. Clicking this button returns the 
window to the initial report-level view that summarizes those travel requests, 
authorization requests, and cash advances that are associated with the report.  
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A Detail View of Travel Requests 

With the new summary view, travel requests now feature a link that opens a window 
from which the user can review the travel request in detail format via a printed 
request view. 

 

Configuration 

The administrator will define the appropriate travel request print format for this view 
in the Print Format for Report Summary field on the Travel Request policy in 
order to configure how the printed report will appear when clicking the summary 
travel request link to view the printed report. 

To do this, click Travel Request Admin > Travel Request Policies to display the 
Modify Travel Request Policy page: 
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 Refer to Travel Request: Policies and Groups Setup Guide for more 
information about choosing the printed report format. 

Mexico Digital CFD XML Enhancements 

Overview  

The following enhancements are 
included in this release for the Mexico 
CFD file upload in XML feature. 

Upload File On Entry Creation Prior 
to Report Save  

With this release the user can now upload the CFD file prior to saving the expense 
entry the file is to be associated with. Prior to this change, the user would save the 
entry, then reopen it to attach the single file required for the entry. Now, the user 
can upload the file and save the entry in sequence. 

Support for CFDi Versions of the Digital CFD XML file 

The release includes support for the CFDi versions of the XML file required for 
electronic invoicing in the Mexico market. These include versions 3.0 and 3.2. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Receipt Handling - Receipt Imaging Setup Guide and 
Expense: Receipt Handling - Receipt Store Setup Guide for more information. 

New Attendee Administrator Screen and Supporting Attendee Roles 

Overview 

The new attendee admin tool allows the 
user to view, modify, and activate or 
inactivate any attendee record in the 
system from a single new screen. 

THE NEW ATTENDEE ADMIN SCREEN 

This screen allows the attendee admin to perform real-time update and correction of 
records that need intervention. For example, where imported attendee records 
require corrections that cannot wait for the next import event, etc. 

What The User Sees 

Business Purpose 

This enhancement allows an Attendee 
Admin to perform real-time search for 
and updates on existing attendee 
records. 

Business Purpose 

These enhancements increase 
efficiency, reduce the possibility of 
mistakes, and keep the feature 
current. 



Concur Release Notes Page 9 Expense Professional / Premium 
March 2012 Concur Clients 

The Attendee Admin is located on the Expense Tools menu. The following screen 
displays when you first open the Attendee Admin page: 

 

Searching for Attendees 

You can search for attendees using two modes: 

• Search: In this mode, you can search for an attendee by using External ID, 
Last Name, First Name, Attendee Title, Company, or Attendee Type and by 
using the Begins With, Contains, Ends With, or Equals search criteria. 

• Advanced Search: In this mode, you select one of the attendee types, then 
you search on any additional field that is on the attendee form. 

Under both modes, there is an additional filter to just filter by a specific employee 
who created the attendee (Created By user) and to only show Active or Inactive 
records or both. 

Activating/Inactivating Attendee Records 

To do this, after the desired attendee(s) is found, select one or more attendee(s) and 
click Activate or Inactivate. 

NOTE: You cannot do this if you have an Admin Attendee (Read Only) role. 

Editing Attendee Records 

To do this, after the desired attendee is found, either double-click on the row or 
select it in the list and click Modify. 

NOTE: You cannot do this if you have an Admin Attendee (Read Only) role. 

NEW SUPPORTING ATTENDEE ROLES 

The new feature has added the following two roles: 

• Attendee Administrator: The user assigned this role can access, view, and 
edit information for any attendee in the system and also activate and 
deactivate attendees 
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• Attendee Administrator (Read Only): The user assigned this role is 
considered a read-only auditor; therefore, the user can access and view but 
not modify and activate or inactivate an attendee record in the system 

 

Configuration 

The correct roles must be applied to a user before this feature can be used. 

 Refer to Shared: User Administration User Guide and Expense: Attendee 
Administrator User Guide for more information. 

Best Practice Dashboard: Enhancements in this Release 

Overview  

The following enhancements are 
included in this release for the Best 
Practice Dashboard feature. 

Receipt Store Adoption Rate and 
Percent of Expense Receipts Attached 

Receipt Store allows the user to upload one or more receipt images at the entry 
level, for entries requiring receipts. The Dashboard will now record the percentage of 
users who are uploading receipts and attaching them to their expense entries using 
Receipt Store.  

This adoption rate is a 90-day "look back' view, measuring the percentage of active 
users who have attached receipts at the entry level at least once within the 90-day 
period. 

Business Purpose 

This enhancement brings additional 
measurements to the Best Practice 
Dashboard. 
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Report on the Send Back to User (Split Report) Feature 

The final measurement added to the Best Practice Dashboard records if the site has 
adopted the Send Back Expense feature that allows an approver to send back 
portions of an expense report to the report originator. This feature allows timely 
payment of selected expense entries in the overall report, while allowing further 
scrutiny and verification of those entries that are suspect or inaccurate. 

Percent of Users Using the "Other" Spend Category 

When a client has a significant number of expense types associated with the Other 
spend category they miss opportunities for meaningful reporting data they can draw 
on. With this release, the Dashboard will detail what percentage of your expense 
reports include the Other expense type. 
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Configuration 

The correct roles must be applied to a user before they can run the Dashboard report 
from the Reporting tab. Consult the documentation for more information. 

 Refer to Shared: Best Practice User Guide for more information. 

Additional Languages 
 

Nine additional Tier 2 languages are now available. They are: 
 

• Czech (cs) 

• Danish (da) 

• Finnish (fi) 

• Greek (el) 

• Latvian (lv) 

• Lithuanian (lt) 

• Norwegian (no) 

• Slovak (sk) 

• Turkish (tr) 

 

Tier 2 languages are less used than other languages and – for now – may not include 
the granularity and localization nuances provided in the other, more-popular 
languages. Also, these languages are available to users in Profile but they will not be 
available as links at the top of the login page.  

To change languages, the user will: 

1. Navigate to Profile > System Settings.  

2. Select the preferred language from the Default Language dropdown menu.  
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Configuration 

These languages are added by submitting a Service Request to Concur Support. 

Updates to Attendee Field Sizes 

Overview  

Within the Attendee Fields, the following 
fields have been increased: 

• First Name (From 32 to 50 
characters) 

• Company (From 32 to 150 
characters) 

• Custom Fields 1 to 20 (From 48 to 100 characters) 

! Clients using the Attendee Details Extract must validate that their target systems 
receiving this data can accommodate the larger field sizes. The field sizes may be 
reduced to the original by adjusting the field definition maximum size if needed. 

Business Purpose 

This enhancement provides increased 
attendees field sizes to support 
healthcare professional provider 
partners. 
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Configuration 

No additional configuration is required to use this feature. 

 Refer to Chapter 5 - Attendee Import of the Expense – Import and Extract 
Specifications for more information. 

Documentation: New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 
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Section 4:  Expense Pay 

The following features are included in this service release. 

Payment Manager: Employee Banking Page Now Available 

Overview  

The Payment Manager tool has been 
enhanced with the new Monitor Payee 
> Employee Banking tab. The 
administrator can use this tab to search 
for employees by bank account status, 
name, and employee ID. The 
administrator can choose to reconfirm the failed bank accounts from this tab.  

 

The functionality has been enhanced with the following features: 

• The Status Date column allows the administrator to see when the account 
status last changed. 

• Country and Currency columns have been added to the tab. 

• The View History button allows the administrator to see the full history of 
the selected account.  

• The administrator can now search by account status. 

NOTE: The Employee Banking page will no longer appear in Reimbursement 
Manager. 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Business Purpose 

This enhancement moves an 
administrative function from the classic 
user interface to the current user 
interface. 
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Configuration 

No additional configuration is required to use this feature. 

Payment Manager: Batch Definitions Page Now Available 

Overview  

The Payment Manager tool has been 
enhanced with the new Configure 
Batches > Batch Definitions tab. The 
administrator can use this tab to add 
new and edit existing batch definitions.  

 

 

The administrator can edit existing batch definitions, even if they have been used by 
a batch, in the current user interface. This is an enhancement over the existing 
functionality in Reimbursement Manager. 

NOTE: The Batch Definitions List page is now disabled in Reimbursement 
Manager. All batch definition changes should be made in Payment Manager. 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement moves an 
administrative function from the classic 
user interface to the current user 
interface and provides some 
enhancements. 
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Payment Batch Scheduling: New Options 

Overview  

Clients can set the closing schedule 
for the Expense Pay payment 
batches on the Batch Definitions 
tab of Payment Manager. Two new 
options, Every other week and 
On Demand, have been added to 
the available scheduling options. 

On Demand: 

This schedule causes the batch to remain open until manually closed in Payment 
Manager. 

Every other week: 

When the administrator selects the weekday, they are setting the beginning of the 
two week cycle.  

Example: On Monday, the administrator chooses the Every other week schedule and 
selects Thursday as the weekday. The next Thursday (3 days later) marks the end of 
the first week. The Thursday after that is when the batch closes for the first time.   

Configuration 

No additional configuration is required to use this feature. 

Payment Manager: Funding Account Accounting Fields Moved to Batch 
Definitions Tab 

Overview  

The Liability Account Code and Cash 
Account Code fields have been moved 
from the Funding Account tab to the 
Batch Definition tab. This allows 
clients to use the same funding account for different groups, and maintain separate 
account codes by batch definition.  

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement provides additional 
accounting flexibility. 

Business Purpose 

This enhancement gives clients more 
options for the payment batch 
scheduling.  
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Payment Manager: Return Reason Added to Funding Account Tab 

Overview  

The Funding Account tab has been 
enhanced to show the Return Reason 
field when a funding account status is 
set to Failed. The return reason 
provides additional insight into why the account failed. 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Payment Manager: US/CA Funding Accounts Read-Only in 
Reimbursement Manager 

Overview  

Funding accounts for the United States 
and Canada are now read-only in 
Reimbursement Manager, and can only 
be edited in Payment Manager. 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Expense Pay UK: New Funding Bank Support 

Overview  

The following bank is now supported as 
a funding bank for Expense Pay – UK: 

• Bank of Scotland 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Business Purpose 

This enhancement helps administrators 
resolve funding account issues. 

Business Purpose 

This enhancement standardizes 
funding account management. 

Business Purpose 

This enhancement provides another 
funding bank option. 
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Configuration 

No additional configuration is required to use this feature.  
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Section 5:  Documentation Updates 

The following documentation changes are included in this service release. 

Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  

 

This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 6:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 9.0 and 10.0 

Support for Firefox versions 9.0 and 10.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Support for Google Chrome v. 17.0 

Support for Google Chrome version 17.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 

Support for Internet Explorer 10.0 under Microsoft Windows operating systems will 
be included in an upcoming release. 

Support for Firefox v. 11.0 

Support for Firefox 10.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Chrome v. 18.0 

Support for Google Chrome 17.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, March 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – March 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

111018-
000360 

Expense / Receipt Matching 

Unable to match Mobile receipts with credit card charges. 

111215-
000779 

120125-
001209 

Expense / Google Maps 

Accessing Google Map feature causes "...slow-moving/nonresponsive script 
error - continue?" message to appear. 

120104-
000016 

Expense / Audit Trail 

Audit Trail does not enter an entry that the delegate is viewing receipt images 
on behalf of the approver. 

120109-
001591 

Expense / Expense Types 

The use of a formula for a specific expense type requires the user to save the 
expense twice to calculate the required value. Initial save returns incorrect 
value of 0.00. 

120118-
001452 

Expense / Itineraries 

An imported itinerary is now displaying properly. 

120124-
000593 

Expense / Validation Rules 

A Null value appears until an entry is resaved. This happens on entry save 
action if the account code is attached to a report entry field and is populated 
by an entry save validation rule. 

120201-
000813 

Expense / Archive 

Data issue is causing the archive to fail. 

120206-
000566 

Expense / Audit Trail 

The Cash Advance administrator cannot view the Action column in the audit 
trail as other roles can - the Cash Advance administrator should be able to see 
it. 

120206-
001876 

Expense / Cash Advance 

Approve Cash Advances columns Starting Balance and Available Balance 
are shown but are always shown as "Not available" and 0.00 respectively as 
they are not populated until the CA is issued. This causes unnecessary 
confusion and calls to Support. 

120207-
000011 

Expense / User Import 

Russian characters are being successfully imported but are not stored 
correctly, resulting in Unicode "???" display. 

120208-
000005 

Expense / Attendees 

An error occurs when attempting to deactivate a Policy expense type if it has 
values in the Exclude Attendee Types field. 
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Case ID Case/Defect Description 

120208-
001766 

Expense / Personal Attendee Import 

User with correct language selected and locale as well uses personal attendee 
import and receives error Error uploading or processing excel file. Unable to 
read the Attendee data. Please verify that the template you are using matches 
your current language setting. 

120209-
000933 

Expense / Workflows 

Editing or modifying a workflow results in an Unexpected Software Error (UE). 

120209-
001613 

Expense / Fields 

Unable to select an Expense Entry Custom field in Internet Explorer version 
8.0. 

120213-
000471 

Expense / Card Transactions 

System incorrectly asks if user wants to delete a card when the user only 
wishes to unassign the card - error message should indicate that there are 
existing unassigned transactions tied to the card. 

120213-
001168 

Expense / Receipt Image - CFD 

Support version 3 of the Mexico CFD XML digital file format. 

120213-
001734 

Expense / User Admin (Roles) 

The Expense Configuration Administrator (Restricted) and Request 
Configuration Administrator (restricted) roles should allow the user to see the 
authorized approver level from the authorized approver list. Instead, the level 
is missing. 

120216-
000148 

Expense / Attendees 

Editing multiple expense entries causes the This Employee attendee to 
incorrectly update all entries to have a transaction amount equal to the entry 
transaction amount, causing the sum to exceed the entry amount. 

120220-
000951 

Expense / Card Transactions 

An error appears when importing card transactions if Flight Fee fields are 
incorrectly set up for the Policy.  

120221-
000572 

Expense / Implementation 

The Implementation server is generating errors where itinerary services are 
not set up. 

120222-
000656 

Expense / Card Transactions 

The Match button allowing match of Air e-receipts to card transaction is not 
appearing even when both items are checked for match. 

120223-
001197 

Expense / Login 

A login ID that includes a space prevents the user from logging in. Instead, an 
invalid character prompt appears. 

120224-
000353 

120221-
001732 

Expense / Receipt Image - CFD 

User must perform Save action before they can upload the CFD XML digital 
receipt file - should be upload, then save. 



Concur Release Notes Page 5 Resolved and Known Issues Case List 
March 2012 Concur Clients 

Case ID Case/Defect Description 

120224-
001041 

Expense / My Concur 

A single report to be approved appears in My Concur three times. 

120301-
000183 

Expense / Travel Allowance 

An error is displayed when attempting to open a travel allowance itinerary. 

120305-
000263 

Expense / Login 

A login ID that includes a space prevents the user from logging in. Instead, an 
invalid character prompt appears. 

120306-
001945 

Expense / Travel Allowance 

A search of Rate Location Name plus All Other Locations cannot be performed. 

N/A Expense / Exceptions 

The Expense List page shows the ability to sort the Exceptions table, but the 
functionality does not work. 
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Section 2:  Known Issues - Expense 
Case ID Description 

N/A Expense / Attendee Admin 

Description: An issue with versions 8.0 and 9.0 of the Internet Explorer 
browser results in poor field layout and occasionally no vertical scroll bar  in 
the Search section of the  Search tab whenever the browser is minimized.  
Workaround: Maximizing the browser window or adjusting the size of the 
search portion of the page will resolve the issue. A fix will be included in a 
future service release. 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 



Concur Release Notes Page 8 Resolved and Known Issues Case List 
March 2012 Concur Clients 

  

Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 
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With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, March 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – April 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Upcoming Features and Alerts 

Review the following features and alerts for the Expense product. 

Planned for May Release 

The following features are planned for the May service release. Please note that a 
feature functionality can change, and the release date as well. 

Copy an Expense Report 

A user can now select and copy an existing expense report, using it to create a new 
report. The report can be in any state (Unsubmitted, Paid, etc.) as this status will not 
apply to the copied report. 

 

 Refer to Copy Report Fact Sheet for more information. 

Choose Favorite Allocations 

This feature allows you to create and save groups of allocations as a favorite. This 
allows you to: 

• Mark an allocation set as a favorite and give it a name 

• Pick an expense and apply the set allocation 

• Delete the favorites that are no longer required 

The figure below shows the a user clicking Favorites to open their list of favorite 
allocations to apply to the expense entry: 
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 Refer to the Allocations Favorites Fact Sheet for more information. 

Planned for June Release 

The following features are planned for the June service release. Please note that a 
feature functionality can change, and the release date as well. 

Updates for French Language 

The Concur team in France will be reviewing and revising the French (fr) language 
translations with changes to some core terminology anticipated for the June release.  
Clients with internal training materials and documents in French should expect that 
revisions will be necessary to match the updated terminology.   

 Refer to French Language Changes 2012 Fact Sheet for more information, 
including a table showing the changed terminology. 
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Section 2:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• Copy Attendees from a Travel Request into Expense 
Attendees included in a travel request entry can now be copied into the 
related expense when the user associates their request with an expense 
report. 

• Addition of the Spanish - Latin America Language to Expense 
A new language, Spanish - Latin America, is now supported within Concur 
products. 

• Redirect Reimbursements to Card Payments 
Users can now redirect a reimbursement (due to the user from the company) 
directly toward personal expenses on the company card. This provides an 
easy way for the user to pay the card and helps keep card accounts current. 

• Email HTML Attachments to the Receipt Store 
The receipt store now supports email attachments in HTML format, making it 
even easier to send receipts to Concur via email. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 3:  Expense 

The following features are included in this service release. 

Announcing the Concur Purchasing Card Feature 

Overview  

With the April release Concur offers 
their Purchasing Card feature to clients. 
This feature is designed to help 
organizations who need greater 
flexibility, manageability, and visibility 
into their Company Bought Company 
Paid (CBCP) card programs. With the increased adoption of the Purchasing Card 
model, and associated volume of transactions, it is more important than ever to ease 
the burden of the individual expensing the transactions while providing the visibility 
the organization requires. 

How It Works 

The Card administrator creates the Purchasing Card (PCard) program, providing the 
Card Issuer and statement frequency with start date. With the first PCard import the 
system creates the Statement Report and sets the statement period. Each 
subsequent imported transaction is added to the statement report and automatically 
assigned the correct expense type and Merchant Code and, if data exists, 
automatically itemized as well.  

 

As with an expense report, the owner validates the purchasing transactions and 
allocates, reviews, adds images, and corrects any issues, such as with compliance 

Business Purpose 

This enhancement adds a critical 
component to the company card 
offerings, offering the client increased 
visibility and cost savings. 
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flags, then submits the report. Finally, the statement report passes through workflow 
and is extracted to the client's financial system. 

What Concur Offers in a Purchasing Card Program 

Most similar features offered by other companies do not provide complex workflow, 
advanced imaging, or comprehensive spend reporting.  Concur Expense offers all of 
these, and gives the client an easier way to switch card issuers if needed. 

Using Concur to process purchasing cards allows organizations to benefit from a 
structured, timely, and complete payment of purchasing card statements. Clients can 
identify volume, frequency, and spending patterns by utilizing Concur Reporting to 
recognize cost-saving opportunities and negotiate better volume-based pricing by 
analyzing spend by supplier.   

With Concur Expense, clients will: 

• Manage spend 

• Streamline payments 

• Uncover savings 

More Information About the Purchasing Card Feature 

Clients should contact Concur directly to arrange a demonstration and determine 
pricing.  

Receipt Store: Support for HTML Email Attachments to Receipt Store 

Overview  

The Receipt Store user can now send 
email attachments of their images in 
HTML format. The system will detect 
these attachment types and add them 
to Receipt Store, making them available 
to the user when attaching receipts at the line-item level. 

NOTE: This feature allows HTML email attachment; it does not support direct upload 
of HTML files to Receipt Store from within the application. 

Configuration 

Receipt Store must be configured for use at the client site to use this feature. 

 Refer to the Expense: Receipt Handling – Receipt Store & Line Item Receipts 
Setup Guide for more information. 

Business Purpose 

This enhancement adds another 
popular image format to the supported 
format types for Receipt Store. 
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Latin American Spanish Language (es-LA) Added to Expense 

Overview  

A new language, Spanish - Latin 
America, is now supported within 
Concur products. This language may be 
selected when logging in by clicking the 
language directly. 

 

Configuration 

The user may see the fixed text within the user interface using Latin American 
Spanish; however, as with all Expense languages, the language must be added to 
your company database to allow for variable text, such as Expense Type names to be 
localized for this language. 

NOTE: Please submit a change request to Support requesting that this language be 
activated for your company.  

User Can Elect to Redirect Funds for Payment to Company Card 

Overview  

An Expense user can elect to redirect 
funds owed them by their company to 
pay all or part of the balance they may 
owe on a company card. This feature is 
available to users: 

• With a company card 
arrangement where the company (the card holder) pays the card provider 
directly for authorized business expenses. 

• Where the card holder also pays the card provider for personal expenses 
when the card provider and the card user(s) are both owed funds by the 
company for expenses an expense report. 

• Where the card user also has an outstanding personal balance on that 
company card. 

 How It Works 

The user may indicate on the report header an amount to be redirected to a selected 
company card. 

Business Purpose 

This enhancement adds another 
language to the Concur product line. 

Business Purpose 

This enhancement provides payment 
flexibility and streamlines the payment 
process between card provider, user, 
and the company. 
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When the user submits the report, the system validates that the amount due to the 
employee as cash reimbursement equals or exceeds the amount requested by the 
employee for payment to the card.    The user is presented with the summary 
information so that they may review and validate that this what they intend. 

 

If no amount has been requested for payment to the card, an informational message 
appears explaining how the user can redirect funds. 

 

By canceling from the Final Review dialog box, they can update their expense 
report for the amount they want redirected to the card account using the new fields 
available in the Report Header: 

 

Special Conditions Pre- and Post-Submit 

If a user attempts to redirect more funds than available, an exception is displayed in 
the Report List - the user must adjust the amount in order to submit the report: 
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Sometimes, after submit and final processing, some amount of funds due the 
employee are disallowed by an approver, reducing the available amount balance 
below the amount originally requested for redirection to the card provider. The 
system includes this information in both the audit trail: 

 

As well as the final email confirmation sent to the report owner: 

 

Configuration 

To see this option each user must have an IBCP card assigned to them, and the 
Redirect Funds To Card Account field must be added to the Expense report 
header using the Forms & Fields tool. To do this, most clients will need to submit a 
change request to Concur support. The request should specify the report header 
forms to be altered and the position of the field on the form. 
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 Refer to the Expense: Forms and Fields Setup Guide and the Expense: 
Payment Types Setup Guide for more information. 

Excel User Import: Addition of Locate and Alert Role 

Overview  

A new role, Locate and Alert, is now 
available as an assignment option in the 
Excel-based User Import feature. This 
field is used to specify one of three 
possible user-levels of participation in 
the L&A program: 

• Enrolled: This user may be located by and receive alerts from an L&A 
Administrator or an L&A Operator  

• Sensitive: This user may be located by and receive alerts only from an L&A 
Administrator. Executives and other travelers whose locations need to be more 
guarded are most likely assigned this status.  

• Not Enrolled: This user is not a participant in the L&A program. 

The role only appears in the Excel spreadsheet if the Locate and Alert feature is 
activated. 

 

NOTE: Neither the overnight or Excel-based imports have the capability to assign the 
Administrator or Operator roles required to work with the program - these are 
still assigned from within the User Permissions module under Travel.  

Overnight (ONP) Employee Import Available 

This role can also be assigned using the employee import available via the overnight 
job process. 

 Refer to Employee Import: Addition of Locate and Alert Role in the Jobs 
section of this document for more information. 

Configuration 

The role is assigned using options in the User Import feature, available by clicking 
Administration > User Administration > User Import. 

Business Purpose 

This enhancement allows assignment 
of employees to the Locate and Alert 
program. 
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 Refer to Shared: User Administration User Guide and the Locate and Alert 
User Guide for more information. 

Attendees: Copy Attendees from a Travel Request to Expense 

Overview  

Attendees included in a travel request 
entry can now be copied into the related 
expense when the user associates their 
request with an expense report by 
clicking the Create Expense Report 
button or icon.  

Attendees are copied to the expense entry by clicking the Copy Attendees from 
Request (#) button that appears when the system detects that the linked request 
entry has attendees as shown in the figure below:  

 

Note the inclusion of a number that denotes how many attendees are included in the 
travel request entry. If any of these attendees cannot logically be copied, due to 
group or expense type restriction of attendee type or otherwise, they will not be 
added to the expense entry. This is a data entry tool; once the attendees have been 
copied to the expense they may be edited in the same manner as a manually-added 
attendee. 

Configuration 

The Attendees field must be resident on the expense entry form and the travel 
request entry to activate the functionality. The expense entry must be linked to a 
travel request entry with attendees. 

 Refer to the Expense: Forms and Fields Setup Guide for more information. 

Business Purpose 

This enhancement provides for rapid 
data entry when working with travel 
requests and attendees. 
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Travel Allowance: Czech Enhancements 

Overview  

With this release, two functional 
changes are now applied to Czech travel 
allowance in Expense: 

• All the Czech system calculation 
properties are upgraded to be 
configurable by minute rather than hour for more precision and flexibility 

• For foreign trips, meal deductions will not reduce the pocket money portion of 
the amount 

Configuration 

No additional configuration is required to use this feature. 

 Refer to the Travel Allowance Configuration Guide – Czech Republic for more 
information. 

 

Business Purpose 

This enhancement updates 
requirements for the Czech travel 
allowance. 
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Section 4:  Expense Pay 

The following features are included in this service release. 

Payment Manager: Report Payees Page Added 

Overview  

The Report Payees page has been 
added to the Payment Manager tool. 
This page has not yet reached parity 
with the classic user interface, but does 
provide one new feature. The page will 
reach parity with the classic user interface in the May release.  

Please note the following about this page:  

• The ability to manually create a payment demand has been added. This 
feature allows the Reimbursement Manager to create a new payment demand 
for the selected report payee. 

• Three new columns are added: 

♦ Payee Type: Employee, Card, or Any 

♦ Currency 

♦ Payment Method: Expense Pay, ADP, or Company Check 

• A new Status list item is added: Closed 

 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement begins the transition 
of the Report Payees page to Payment 
Manager. 
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Payment Manager: View Funding Page Added  

Overview  

The View Funding page has been 
added to Payment Manager. This page 
allows you to view a daily summary of 
account activity for all funding accounts. 
The Reimbursement manager can 
search for specific funding accounts or 
date ranges. The Reimbursement manager can also drill down to view funding 
details. This page has not yet reached parity with the classic user interface. The page 
will reach parity with the classic user interface in the May release. 

Configuration 

No additional configuration is required to use this feature.  

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Expense Pay EMEA Sweden: New Funding Bank Support  

Overview  

The following bank is now supported as 
a funding bank for Expense Pay EMEA - 
Sweden: 

• Royal Bank of Scotland N.V. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Business Purpose 

This enhancement begins the transition 
of the View Funding page to Payment 
Manager. 

Business Purpose 

This enhancement provides another 
funding bank option for Sweden. 
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Section 5:  Jobs 

The following features are included in this service release. 

Employee Import: Addition of Locate and Alert Role 

Overview  

A new assignable role, Locate and Alert, 
is now available as a field within the 
310 User Primary Field Addendum 
import record set. This field is used to 
specify one of three possible user-levels 
of participation in the L&A program: 

• Enrolled: This user may be located by and receive alerts from an L&A 
Administrator or an L&A Operator  

• Sensitive: This user may be located by and receive alerts only from an L&A 
Administrator. Executives and other travelers whose locations need to be more 
guarded are most likely assigned this status.  

• Not Enrolled: This user is not a participant in the L&A program. 

The role is only assigned to the user if the Locate and Alert feature is activated, 
otherwise the role assignment fails silently. 

NOTE: Neither the overnight or Excel-based imports have the capability to assign the 
Administrator or Operator roles required to work with the program - these are 
still assigned from within the User Permissions module under Travel.  

Excel-Based On Demand User Import 

This role can also be assigned using the on demand Excel user import available 
within User Administration. 

 Refer to Excel User Import: Addition of Locate and Alert Role in the Expense 
section of this document for more information. 

Configuration 

This role is assigned using the data file - for more information consult your Concur 
representative. 

 Refer to Chapter 4: Employee Import of the Expense – Import and Extract 
Specifications and the Locate and Alert User Guide for more information. 

Business Purpose 

This enhancement allows bulk 
assignment of employees to the Locate 
and Alert program. 
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Lodge Accounts: Search Return Now in Alphabetic Order 

Overview  

Users working with a large number of 
Lodge accounts who must work through 
a lengthy list in the Manage Lodge 
Transactions page will now see the list 
in alphabetized order. 

 

This change lets the user who knows the name of the account quickly access it by 
scrolling to the name in the alphabetic order in which it is listed. 

Configuration 

No additional configuration is required to use this feature. 

 

 

 

Business Purpose 

This enhancement increases 
productivity by ordering the list in a 
more meaningful way. 



Concur Release Notes Page 19 Expense Professional / Premium 
April 2012 Concur Clients 

Section 6:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  
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This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 7:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 10.0 and 11.0 

Support for Firefox versions 10.0 and 11.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Support for Google Chrome v. 17.0 and v. 18.0  

Support for Google Chrome version 17.0 and 18.0 under both the Mac OS X and 
Microsoft Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Firefox v. 12.0 

Support for Firefox 12.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Chrome v. 19.0 

Support for Chrome 19.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Safari 5.2 and Mac OS X 10.8 

Support for Safari 5.2 under Mac OS X version 10.8 will be included in an upcoming 
release. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, April 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – April 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

111117-
000440 

Expense / Delegate Approver 

An unacceptable amount of time is required to open, approve, and then wait 
for the report list to refresh when approving hundreds of reports. 

120207-
000011 

Expense / Locale Support 

The locale "ru_RU" (Russian - Russian Federation) is disallowed by the 
system.  

120213-
001509 

120217-
001177 

Expense / Forms & Fields 

A VAT field added to a report from a travel allowance itinerary is incorrectly 
added as a locked down (view-only) field and is not editable. 

120229-
001523 

Expense / Processor 

Processor can adjust their list settings within an expense report but find that 
they must either resave or close and reopen the report to make the child 
entry values display (they are blank). 

120307-
000380 

Expense / Attendees 

Attendees that have been deleted from the system are available to be added 
back through the Duplicate Check dialog box when the user creates a new 
attendee that matches the deleted one. 

120309-
000931 

Expense / Attendees 

An attendee entry has another entry's excluded attendee type rules applied to 
it if the first entry is being reviewed using the hover pop-up and the second 
entry is in focus or selected on the screen. 

120313-
001879 

Expense / Configuration Report 

The Custom Lists / Connected Lists area of a configuration report incorrectly 
shows list items that were deleted via an import. 

120314-
000006 

Expense / Test User 

Purging test data incorrectly results in the server error "Warning: Null value is 
eliminated by an aggregate or other SET operation". 

120314-
000677 

Expense / User Admin 

A server error is appearing when trying to add a new user. 

120314-
001309 

Expense / Processor Recall 

After recalling the report to a Processor, that Processor cannot send back an 
expense entry; an application error warning appears instead. 

120322-
000410 

Expense / Processor Recall 

The VAT values cannot be edited within a report that has been recalled by the 
Processor. 

120322-
000894 

Expense / Travel Allowance Itinerary 

Hotel reservations reserved for a future date cannot be imported when 
importing travel allowance itinerary information. 
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Case ID Case/Defect Description 

120325-
000149 

120326-
000075 

120326-
000666 

120326-
000750 

Expense / Report - Summary View 

The recently introduced Summary view of an expense report is not listing the 
actual amount due to a company card. 

120325-
000154 

120326-
001594 

120326-
000386 

120326-
001908 

120327-
001213 

120327-
000591 

Expense / Role Permissions 

The Expense Configuration administrator (Restricted) role is prevented from 
changing their limits, Groups, and  Authorized Approvers even though they 
should have this ability. 

120326-
001809 

Expense / Itineraries 

User cannot review air itinerary by hovering over the icon - instead, an 
application error is generated and displayed. 

120328-
000673 

Expense / E - Receipts 

E-receipts are appearing with duplicate information in them. 

120330-
000924 

Expense / Expense Pay 

An expense report placed either on hold or is manually paid causes the 
processing queue to stop processing when that report is put back into the 
queue. 
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Section 2:  Resolved Issues - Jobs 
Case ID Case/Defect Description 

120312-
000563  

120320-
001253  

Jobs / Card Import 

The Custom field types are not being included in the bad character check - 
this can prevent successful card import. 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 

 



Concur Release Notes Page 9 Resolved and Known Issues Case List 
April 2012 Concur Clients 

With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, April 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – May 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Please Note the Following Alerts 

Review the following features and alerts for the Expense product. 

Updates for French Language 

The updates listed below are planned for the French language in Expense. 

Planned for June Release 

The Concur team in France will be reviewing and revising the French (fr) language 
translations with changes to some core terminology anticipated for the June release.  
Clients with internal training materials and documents in French should expect that 
revisions will be necessary to match the updated terminology.   

 Refer to French Language Changes 2012 Fact Sheet for more information, 
including a table showing the changed terminology. 
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Section 2:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• Automated Capture of Australia Travel Diary Data 
Expense will now allow user entry of data to capture required Travel Diary 
information. This will allow audit rule validation and additional checks not 
currently available in the faxed paper image now affixed to reports requiring 
this proof under Australian regulation. 

• Allocation Favorites 
Concur end users often allocate many expenses in an identical manner. For 
example, they will allocate 20% of an expense to Cost Center A, and 80% to 
Cost Center B. The new Allocation Favorites feature allows the user to save a 
group of allocations, to use on other expenses. 

• Copy an Expense Report 
A user can now select and copy an existing expense report, using it to create 
a new report. The report can be in any state (Unsubmitted, Paid, etc.) as this 
status will not apply to the copied report. 

• Send to Excel Feature Available in Most Tabs of Company Card 
The Company Card Manage Transactions, Manage Lodge Transactions, 
and Manage Accounts screens now include the Send to Excel feature that 
allows the user to export the card data to an Excel worksheet. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 3:  Expense 

The following features are included in this service release. 

Training Page and Training Administration Now Available 

Overview  

Clients can now use options in this 
release to create their own customized 
landing page of training materials and 
contact information, all designed 
specifically for their site and its users.  

This enhancement lets each company 
grant the Training Administrator role directly to one or more employees who are 
responsible for their site's training content. This saves the client time by removing 
the requirement to contact Concur for changes to their page, but still allows the 
client to post their custom training materials side-by-side with guides and 
simulations created and offered by Concur for the client's use.  

New Training Administrator Role and Training Link 

A new role, Training Administrator, is available from the Expense, Travel Request, 
and Invoice tabs under User Permissions (it is not available within any other tab). 

 

Assigning the role under any of these tabs assigns the role for all Concur products 
and allows this role access to the new Training Administration link, available by 
navigating via Expense Admin > Training Administration. 

Business Purpose 

This enhancement lets the client 
customize their Training landing page 
for contact information and selected 
training collateral from Concur and the 
user's own material. 
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What the Administrator Sees 

When the Training Administrator selects the Training Administration link, the 
Training Configuration page appears. 

 

This page feature four tabs with options as follows: 

• Simulation Resources: A list of available Concur and client-created training 
material you can display or hide, arrange in specific order, and add, modify, 
or remove the material as required. 

• Document Resources: Quickstart guides and similar collateral are available 
here, and can be customized for display just as under Simulation Resources. 

• Mobile Resources: Mobile-specific user guides and FAQs are available here. 

• Contacts: Create a company-specific contact name, number, and email your 
users will see and use for training or desktop questions. 

The page also allows filter of material by language so that the training 
documentation and simulations appear to the user in the native language (as 
available). New content is added using the New button, with options to modify and 
remove content as needed, or activate and deactivate an existing Concur training 
resource. 

What the User Sees 

The end user experience starts when they click the Training menu command from 
the Help menu.  
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This opens the Concur Travel and Expense Training Site page (shown below) in a 
separate window, allowing the user to continue work in the product. The user may 
click and view any link on the page in order to review a simulation or guide. 

 

What the user sees is restricted to the product(s) they work with, the supported 
languages a simulation or guide is available in (not all resources exist for all 
languages), and what Concur or client-created material is posted to this page.  

Configuration 

The Training Administrator role must be assigned to an employee for configuration 
purposes; all users have access to the Training menu link by default. The page 
appears with training material for each product the client is using. Customization of 
what displays, its content, the order of appearance, language preference, and 
customized content is the responsibility of the client. 

Clients provide their own material using instructions in these release notes and the 
associated guide. To alert the employee, configure Company Info to display 
information about this new Training page, the Help link, and a link using the Info title 
to help them find this page. 
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When configuring a link within the body text, be sure to select the page option to 
display in a separate window so that the user does not "lose" their Concur session by 
preventing display of the page using the Concur window. 

 

 Refer to Shared: Training Administration Setup Guide and the Shared: 
Company Info User Guide for more information. 

Support for Travel Diary 

Overview  

A travel diary is required of travelers in 
some circumstances to avoid taxation 
under the rules of the Fringe Benefits 
Tax. Under this governmental provision, 
the traveler must use a travel diary to 
identify where they traveled, the dates and times of travel for the entire duration of 
the trip, and finally the nature of the business activity itself. 

To automate this process and expose the travel diary to audit rules, Expense can 
now (optionally) display a table into which the required information can be entered, 
and the Report data object Has Travel Diary may be used for audit rules.  

Business Purpose 

This enhancement supports the 
Australian Fringe Benefits Tax 
requirement for travel diaries. 



Concur Release Notes Page 9 Expense Professional / Premium 
May 2012 Concur Clients 

What the User Sees  

The user sees the Travel Diary table when they enter data for their new expense 
report, within the report header.  

 

Clicking Add opens a new entry line, where the user adds their travel information. 
Date is chosen from a calendar, or type a number and that becomes the date of the 
current month. Time is entered by typing a 24-hour time, such as 21, that resolves 
to 9:00PM, or type in a number - the system resolves the number within a current 
workday of 7am to 6pm (thus, the number 5 is 5:00PM; the number 11 is 11:00AM). 

 

What the Approver Sees 

Once submitted, the approver can review the diary information by opening the report 
and using the Summary button to view the report in summary view. In this view, 
the Travel Diary link is available: 
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Clicking the Travel Diary link opens the diary into a read-only table that the 
approver can use to review the travel for compliance: 

 

NOTE: Changes to the diary must be performed within the report, in the report 
header as they cannot be changed within this review window. 

Audit Rules and Audit Trail Support 

The Has Travel Diary field can be specified as a Report level data object when 
configuring audit rules for the feature. 

 

As with most fields, an audit trail entry is created for changes made after submission 
if the report has been modified. 

 Refer to Expense: Audit Rules Setup Guide for more information. 
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Support for Travel Diary in Printed Reports 

By adding the new Report Diary Data content type to new or existing print 
templates, the user has the option to print a report that includes the diary in table 
format.  

 

Four columns appear above the travel rows within the table, including Activity 
Location, Start Date/Time, End Date/Time, and Activity Purpose.  

 

 Refer to Expense: Printed Reports Configuration Setup Guide for more 
information. 
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Configuration 

The table grid appears only when the Travel Diary field is added to the Expense 
Report Header form type. Before adding the field, the administrator can set the 
employee, approver, and processor field access permissions as with any field. Then, 
the field is added using the Forms and Fields tool: 

 

This field may be positioned relative to the Travel Request/Authorization 
Request field; however it will always occur after other fields on the form definition. 
In the figure below, the Form Fields tab is opened and the field moved above the 
request grid tables: 

 

The field labels may be altered to match the company needs. The Travel Diary field 
is changed on the Report header form, and the columns Activity Location and 
Activity Purpose are changed using options in the Localization administrative area. 

 Refer to Expense: Forms & Fields Setup Guide for more information. 
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Create Allocation Favorites 

Overview  

Concur end users often allocate many 
expenses in an identical manner. For 
example, they will allocate 20% of an 
expense to Cost Center A, and 80% to Cost 
Center B. The Allocation Favorites feature 
allows the user to save a group of 
allocations, to use on other expenses.  

When the user applies these allocation favorite ‘sets’ to another expense, the data in 
those stored allocation records is validated to ensure any project codes or other list 
fields are still valid, and alerts the user if data needs to be corrected. Once the 
allocations are added to the expense, they can be edited just like a manually-entered 
allocation row. 

 To create allocation favorites: 

1. Create an expense report and create the allocations. 

2. Click Add to Favorites. The Add to Favorites screen opens. 

 

3. Enter a name for the allocation favorite and click Save. 

 

The allocation is added to your favorites. 

Business Purpose 

This enhancement provides speed of 
data entry, allowing users to allocate 
certain expenses in a nearly identical 
manner. 
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 To assign your allocation favorites: 

1. Create a new expense report. 

2. Click Allocate. 

3. Click Favorites. A list of allocation favorite(s) displays. 

 

4. Select the desired allocation and click Save.  

5. Click Save. 

6. Click Done. 

Allocation Favorites Maintenance 

Removing Favorite Allocations 

Over time, allocation favorites will become incorrect or obsolete. The user can 
remove out of date allocation favorites by clicking on the red X icon next to the name 
as shown in the figure below.   

 

Editing Favorite Allocations 

The user can update the set by using it on an expense, making needed corrections, 
then saving the resulting allocations to the same allocation favorite name. The 
system will confirm that the user wants to overwrite the existing set.  
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Configuration 

This feature is enabled (selected) by default, so that all companies using allocations 
will have it available to their users. If you do not wish to have this usability feature 
on for your users, you may turn it off. Do this using options on the Site Settings 
page of Expense Admin. Select the Allow users to manage favorite allocations 
check box to enable this feature and remove the check to turn it off. 

 

 Refer to Expense: Allocations Setup Guide for more information. 

Copy an Expense Report 

Overview  

Concur users can now select an expense 
report and copy it, regardless of the 
report's status. The user can then edit 
the copied report as desired.  

Note the following when copying a 
report: 

• The new name of the report is Copy of <report name> 

• Copied expense entries are automatically incremented the same number of 
days forward as the date specified in the Copy Report dialog. 

Business Purpose 

This enhancement makes report entry 
easier for users who want to create 
similar reports. 
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• Attendees and allocations are copied to the new report 

• Japanese Public Transportation (JPT) trip data is not copied to the new report 

NOTE:  

When the user first opens Expense after the service update, the new Copy Report 
splash screen appears with text explaining the new feature. The user can elect to 
turn this off for subsequent sessions by clicking Never show this prompt again. 

 

 To copy a report: 

1. At My Concur in the Expense Reports section, click View Reports. 

 

2. Select the check box of the report to be copied. 

3. Click Copy Report. 
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4. The Copy Report screen appears: 

 

5. At this point, you can either: 

Click OK. This copies the report as Copy of <reportname> and 
automatically increments the date of each expense by one day. 
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Or enter the following information: 

• In the Report Name field, enter the desired name of the report. 

• The Earliest Date of Expense Entries on Source Report field is a 
read-only field that displays the oldest transaction date in the list of 
entries for the source report.  

• In the Starting Date for Expense Entries on New Report field, 
enter the desired starting date of the new report entries. The system 
calculates the remaining entries on the new report based on the new 
starting date (that is, takes the number of days difference and then 
increments the date for each entry on the new report by the same 
number of days). 

 

6. Click OK. The report is copied with the new name and information. 
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Additional Information 

Note the following: 

• If an entry cannot be copied over, you receive a message about the issue.  

• If none of the entries can be copied over, the report header is copied but the 
report will have no expense entries. 

• Entries with company card payment types will automatically be set to Pending 
Card Transaction if that payment type is active; otherwise they will be set as 
Cash. 

Configuration  

The Copy Report functionality is enabled by default. To suppress this feature and 
hide it from the user a setting is used in the Site Settings page.  

 To disable Copy Report functionality: 

1. On the My Concur page, select Administration > Expense Admin > Site 
Settings. 

 

2. In Site Settings, select the Allow users to copy expense reports setting. 
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3. Click Save.  

4. Click My Concur to return to the main page. 

5. Click View Reports. The Copy Report function is available. 

 Refer to the Copy Report Fact Sheet and the online Help for more information. 

E-Receipts Feature New Logo Icons 

Overview  

Selected transactions imported into 
Expense will now display with the 
company-specific logo as the icon 
identifier for the charge.  

Configuration 

No additional configuration is required to use this feature. 

Company Card: Export Card Data into Excel Worksheet 

Overview  

The Send to Excel function that allows 
Expense to generate an Excel-
compatible worksheet is now available 
within Company Card in the Manage 

Business Purpose 

This enhancement provides quick 
visual identification of a receipt type by 
its logo brand. 

Business Purpose 

This enhancement allows the Company 
Card administrator to quickly export  
card-related data into a printable copy. 
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Transactions, Manage Lodge Transactions, and Manage Accounts screens. 

To use the feature, the Company Card administrator accesses the option in the 
selected tab (in this case, the Manage Lodge Transactions tab as shown below) 
and searches for the account whose imported transaction information they want to 
export to Excel.  

 

With the transactions displayed, the administrator clicks Send to Excel: 

 

The Save As dialog box appears, allowing the administrator to save the Excel 
worksheet to the folder of their choice. Once saved, the worksheet can be opened 
within Excel, allowing modification using the options available within that application. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to the Expense: Company Card User Guide for more information. 
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Section 4:  Expense Pay 

The following features are included in this service release. 

Payment Manager: New Functionality is Added to Report Payees Page 

Overview  

Additional functions are now added to 
the Report Payees page on the Payment 
Manager tool.  

• The ability to implement Place 
On Hold function is now 
available on the Payment Manager. This feature allows the Reimbursement 
manager to delete an associated payment demand and change the status to 
On Hold. It stays in that status until the Reimbursement manager can use the 
Assign to Next Batch feature.  

• The ability to implement Assign to Next Batch function is now available on 
the Payment Manager. This feature allows the Reimbursement manager to 
move a payment demand that is in a closed but not sent batch to an open 
batch.  

• The ability to implement Client Pay function is now available on the Payment 
Manager. This feature allows the Reimbursement manager to delete the 
associated payment demand and change status to Client Pay. The report 
payee is not processed by Expense Pay. 

 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement begins the transition 
of the Report Payees page to Payment 
Manager. 
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Payment Manager: Send to Excel Function to Funding Amount Detail 
Page is Now Added  

Overview  

You can now export data to an Excel 
spreadsheet when you are in the 
Funding Amount detail screen.  

 To export data to an Excel 
spreadsheet: 

1. Click the View Funding tab. 

2. Click the number link in the Track Number column.  

 

The Funding Amount Detail page opens. 

3. Select the desired file and click Send to Excel. This opens an Excel 
spreadsheet.  

 

Business Purpose 

This enhancement now provides you 
the ability to send data to an Excel 
spreadsheet.  
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NOTE: The columns displayed in the Funding Amount Detail page are the same 
that display in the Excel spreadsheet. 

Payment Manager: Batch Definitions and Funding Accounts Now Use 
Expense Groups  

Overview  

Prior to this release, the Funding 
Accounts and Employee batch 
definitions used the Employee feature 
hierarchy to populate the Available 
for: groups field. In the May release, 
these pages will use the Expense groups from the Expense feature hierarchy in this 
field instead. This change simplifies the process of managing permissions for the 
Payment Manager functionality, by making it all Expense group aware.  

Most clients will not see a difference with this change, as they either have identical 
Expense and Employee hierarchies, or use the Global group for all users.  

Clients who are using different Expense and Employee hierarchies will have their 
funding accounts and batch definitions set to be Available for the Global group as 
part of this update. If they wish to limit the availability to certain Expense groups, 
they must modify their funding accounts and batch definitions after the May release.  

 Refer to Expense Pay User Guide For Concur Professional/Premium for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

 

Business Purpose 

This enhancement makes all the 
Payment Manager features Expense 
group-aware. 
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Section 5:  Jobs 

The following features are included in this service release. 

Improved Recognition of Travel Agency Fee Transaction in Import 

Overview  

The card transaction importer can now 
identify an agency fee transaction based 
on the presence of an ARC code, and 
automatically apply the default 
merchant code to it on import. This allows the system to distinguish agency fee from 
ticket booking transaction types, which in turn adds clarity to Reporting data and 
increased accuracy to expense report creation. 

How It Works 

A carrier code is contained in the first 3 digits of a ticket number, and it identifies if 
the ticket originated as a travel booking (027 = Alaska Airlines) or an agency fee 
(890 = Airlines Reporting Corporation). This same unique 3-digit sequence lets the 
importer differentiate between a ticket booking transaction and an agency fee 
transaction. With this information, the system will now automatically identify and 
apply a merchant code of  "Travel Agency" (4722) to all transactions with a ticket 
number starting with 890. 

NOTE: This change impacts only transactions imported after the May upgrade. 

Configuration 

To use this feature, be sure the appropriate Travel Agency booking fee expense type 
is mapped to the merchant code (MCC) 4722. In the figure below, the agency 
booking fee is named "Travel Agencies", but the company may choose any name 
they wish to identify their booking fee expense type: 

 

Business Purpose 

This enhancement allows for better 
distinction of travel agency fees. 



Concur Release Notes Page 26 Expense Professional / Premium 
May 2012 Concur Clients 

Next, enable the feature (it is disabled by default) by navigating to the 
Administration > Expense Tools > Company Card > Settings tab. Under the 
General Settings area, select (enable) the Identify Travel Agency fees using the ARC 
code in the ticket number setting.  

 

 Refer to Expense: Company Card Administrator User Guide for more 
information. 
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Section 6:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  
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This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 7:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 11.0 and 12.0 

Support for Firefox versions 11.0 and 12.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Support for Google Chrome v. 17.0 and v. 18.0  

Support for Google Chrome version 17.0 and 18.0 under both the Mac OS X and 
Microsoft Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Chrome v. 19.0 

Support for Chrome 19.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Safari 5.2 and Mac OS X 10.8 

Support for Safari 5.2 under Mac OS X version 10.8 will be included in an upcoming 
release. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, May 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – May 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

120424-
000186 

Expense / User Import 

Import is incorrectly passing the Name field data from Expense to Travel, and 
is not honoring the entity setting preventing this behavior. 

120419-
000844 

Expense / Air Itinerary Information 

Air itinerary associated with an expense entry causes an error when user 
hovers over the icon to view the itinerary (this seems to be isolated to this 
report). 

120124-
001507 

Expense / Audit Rules 

The audit rule exception code AVSBCOST is being incorrectly appended to 
reports that have not caused this exception type. 

120405-
000028 

Expense / User Administration 

An employee record cannot be deleted because the currency they are 
associated with has expired. 

120313-
001265 

Expense / Requires Review Feature 

User wants to require a review on a report with a status of Approved and In 
Accounting Review using Return to Processor but cannot do so - an error is 
generated. 

120321-
001017 

120402-
000017 

120409-
000006 

120507-
001739 

Expense / Tax Administration 

Saving a tax configuration results in certain tax condition expression values 
being invalidated. 

120203-
000840 

120228-
001415 

120322-
001236 

120330-
001596 

120426-
001685 

120427-
000289 

120406-
000176 

Expense / Printed Reports 

The PDF image of the printed report appears to "fall" off the right side of the 
page, preventing display and viewing of the printed report page preview. 
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Case ID Case/Defect Description 

120321-
001357 

Expense / Localization 

The Expense Settings heading on the Profile tab is not correctly translated for 
the French Canadian properly. 

120201-
000849 

Expense / Travel Allowance 

Some Custom fields and the Benefits in Kind field do not display their values, 
even where the values are in the database or are manually added, they are 
cleared when saved. 

120302-
000870 

Expense / Field Display 

The Expense Type and Date field data of a deleted expense report being 
reviewed through its audit trail are only available for viewing for reports in the 
English (US) language. 

120423-
000036 

120423-
000044 

Expense / Approvers 

User is unable to add an approver to the workflow as expected. Instead, an 
error message appears that states the user is not authorized to view the web 
page. 

120404-
001561 

Expense / Travel Allowance 

The Next button is missing and should be available for the user who wants to 
add additional itineraries to their expense report. The only available action is 
Done, but the Expenses and Adjustments page still needs to appear. 

120419-
000374 

Expense / Lists 

Updating a list in List Admin incorrectly updates other list data that uses the 
same list item code. 

120423-
000101 

Expense / Payment Manager 

The Search button is not visible or available for use in the Report Payees 
screen when the screen resolution is 1024 x 768. 

120403-
001209 

Expense / Smart Expenses 

A car trip segment is not matched to the card charge because they are of 
different currencies, one USD, the card charge in Euros. 

120321-
001897 

Expense / Imaging 

The green image attached icon appears, but the user cannot view the receipt 
image at the line level. 

120416-
000523 

Expense / Smart Expenses 

User is asked more than once to match a smart expense they have already 
declined to match - the system should recall this choice and not ask again. 

120504-
000114 

120504-
000117 

Expense / SAML SSO 

The current XML Signature validation for the Expense iteration of SAML SSO 
requires that the XML signature encompass the entire SAML response. 
However, this is not a requirement of XML Signature as it can sign any level of 
the document. 

120426-
000435 

Expense / Travel Expense 

An import of an itinerary with a hotel to be used at a future date incorrectly 
includes an extra line (an extra hotel night) at the end of the itinerary. 
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Case ID Case/Defect Description 

N/A Expense / Attendees (Japan) 

A comma is incorrectly inserted between the last and first names for Japanese 
attendees - this is not required for this language. 

N/A Expense / Receipt Image (Japan) 

The non-ASCII portions of a Japanese character receipt image file name 
appear to the user as question marks. 

N/A Expense / Print Report (Japan) 

An expense report to be printed in PDF format previews without any Japanese 
characters displayed even though the report has many of these characters to 
display. 

N/A Expense / Print Report (Japan) 

An expense report to be printed in PDF format previews without any Japanese 
characters displayed even though the report has many of these characters to 
display. 
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Section 2:  Resolved Issues - Jobs 
Case ID Case/Defect Description 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 
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With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, May 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – June 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Please Note the Following Alerts 

Quick Expenses Grid View Will Debut in July Release 

The Quick Expenses feature allows a user to input their expense entries one after 
another in rapid succession. This view will become the default view and method to 
input an expense entry beginning in the July release.  

The grid appears as the figure below: 

 

The page will dynamically include the columns of Location (city), From Location and 
To Location (typically for mileage) based on the expense types selected by the user 
and form fields applicable to those expense types. All of the normal field validations 
and audit rules logic will be employed as part of the save process, so expense types 
with additional required fields will be saved with the usual missing required fields 
notifications for later edit by the user. 

The user will see a Concur assistant advisory notice when they access this page after 
the feature is enabled, to assist with informing users about the new option. 
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Clients who wish to suppress this feature from users will be able to turn it off under 
Administration > Expense Admin > Site Settings following the July service release. 
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Section 2:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• Web Accessibility Enhancements: 
Additional enhancements for accessibility to Concur products are included in 
this service release. (US Section 508, W3C Accessibility Guidelines.) 

• Authorization Request Administrator Available in the Current 
Interface: 
The Authorization Request Administrator tool is now moved from the Classic 
interface to the Current interface. 

• Set Simple Amount Limits on Expense Types: 
You can now set a simple amount limit by currency that can be configured to 
warn or prevent a user from submitting any report whose line item expense 
types amounts exceed the amount limits. 

• Configurable "From" Sender Email Address for Email Notifications 
The administrator for Workflow and Email Notifications can now configure the 
"From" email address when creating their email notifications. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 



Concur Release Notes Page 7 Expense Professional / Premium 
June 2012 Concur Clients 

Section 3:  Expense 

The following features are included in this service release. 

Define Simple Expense Limits 

Overview  

The Expense administrator can now 
quickly set a warning or blocking 
amount limit on any expense type. 
When the warning limit is exceeded, the 
system will warn the user that they are over the limit.  When the blocking limit is 
exceeded, the system will warn the user and prevent submission of the report, until 
the expense type amount is corrected in the report.  This type of behavior is possible 
to configure via audit rules; this new user interface makes it even easier to enter 
simple limits by expense type. 

This allows a company to easily configure the system to identify and control 
excessive costs in reports based entirely on the expense types that represent these 
cost overruns. As an example, if a company is seeing repeated excessive charges 
based on the Bank Fees expense type, they would take action by configuring that 
expense type as shown in the figure below. 

 

Under this scenario, when the report is submitted, the system performs a check and 
if the expense type is limit-configured, it notes the currency and amount and 
determines if the set amount has been exceeded and what action to take. In the 
example above, the system will warn for any amount over $500, and prevent 
submission if the amount exceeds $1,000. 

Configuration 

No additional configuration, other than setting up each expense type, is required to 
use this feature. 

Business Purpose 

This tool allows quick entry of simple 
expense type limit rules. 
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 Refer to Expense: Expense Types Setup Guide for more information. 

Authorization Request Administration Available in Current Interface 

Overview  

The Administer Authorization Requests 
tool (formerly "Authorization Request 
Administrator" tool) is now available in 
the current user interface. This tool is 
used by the Authorization Request administrator role to manage these request types.  

While this tool is not required for completion of the authorization request process, 
the tool, and the associated role, is the only available method to  clear exceptions on 
an authorization request. 

NOTE: The classic Authorization Request Administrator tool will be retired with the 
September 2012 release. 

Accessing the Authorization Request Administrator Tool  

To access the tool in the current interface, click Expense > Administer 
Authorization Requests (note the naming change to "Administer Authorization 
Requests"):   

 

The Requests Ready for Processing page appears: 

Business Purpose 
This enhancement moves an Expense 
administrative function to the current 
user interface. 
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Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Authorization Requests Setup Guide for more information. 

Notify Card Admin When Unassigned Account is Created on Import 

Overview 

A new option available on the Settings 
tab of Company Card allows the Card 
administrator to receive notification 
whenever an account is created through 
an import with a status of Unassigned.  

This setting, Notify the Company Card 
Administrator via email when a card account is created and needs to be manually 
assigned to an employee, as shown in the figure below. 

 

Business Purpose 

This enhancement lets the system 
notify the Card admin about 
unassigned accounts, freeing up the 
admin's time for other tasks. 
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This check box setting is off (cleared) by default. To enable, click Administration > 
Expense Tools > Company Card and click the Settings tab. Then select the 
setting to enable the feature. Now, email notification is generated and sent to each 
card administrator alerting them when card accounts are created that cannot be 
assigned to an employee. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Company Card User Guide for more information. 

Card Admin Can Now See Level 3 Data Via Hover on Card Icon 

Overview 

Many card providers embed detailed, 
Level 3 data within the card 
transactions they make available for 
import into Expense. With this release, 
a card administrator can now quickly 
review that data in a standalone window when they hover a mouse cursor over the 
card icon in the leftmost column of the Manage Lodge Transactions tab (shown 
below) or the Manage Transactions tab. 

 

Note that not all merchants and card providers include Level 3 data within their 
transactions; however, Expense will display this data when available. 

Configuration 

No additional configuration is required to use this feature. Please note that the card 
icon identification color is configured via the Job Definition import or, for individual 
card accounts, via Manage Accounts. 

Business Purpose 

This enhancement allows the card 
administrator to quickly review card 
transaction data. 
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 Refer to Expense: Company Card Administrator User Guide for more 
information. 

Updates for French Language 

Overview  

The Concur team in France has 
completed review and revision of the 
French (fr) language translations with 
changes to some core terminology, as 
advised in prior release notes.   

Clients with internal training materials and documents in French should expect that 
revisions will be necessary to match the updated terminology.   

Configuration 

No additional configuration is required other than revising existing French language 
training material and documents as described above. 

 Refer to French Language Changes 2012 Fact Sheet for more information, 
including a table showing the changed terminology. 

Travel Allowance Usability Enhancement: Auto-Select Trip 

Overview  

A trip will now be auto-selected for 
import to an expense report in the 
Travel Allowance Itinerary Import 
window when the report was created via 
the trip One-Click feature.  

How It Works 

When the user selects Import on the travel allowance itinerary creation page during 
the report creation process, the trip that started the one-click process will be 
selected by default.  The user may add additional items and may remove this item 
from the list of sources to be used; this is a data entry convenience for the user. 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement aids the user and 
reduces clicks when creating the trip-
based expense report using One-Click. 

Business Purpose 

This enhancement brings additional 
clarity to the French language 
translations. 
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Accessibility Enhancements 

Additional enhancements for 
accessibility to Concur products are 
included in this service release. These 
updates are in accordance with US 
Section 508 and W3C Accessibility 
Guidelines. 

 

Email Notifications: "From" Address is Configurable 

The administrator for Workflow and 
Email Notifications can now configure 
the "From" email address when creating 
their email notifications. With a 
meaningful sender email name display, 
the email may draw more attention 
from the recipient. 

NOTE: This modification does not alter the actual address so that there is no impact 
on junk email filters already in place. 

Workflow 

To support configuration in Workflows, a new Email Contact Name field is available 
in Step 1, General, when creating a new workflow: 

 

Business Purpose 

This enhancement provides better 
accessibility for employees using 
Expense via screen readers. 

Business Purpose 

This enhancement provides additional 
flexibility in how email notifications are 
displayed to the recipient. 
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Email Reminders 

This option is available in Email Reminders under Email Contact Name as well:  

 

Configuration 

 No additional configuration is required to use this feature. 

Tax Forms Allow Country-Specific Data Capture for Tax Calculations 

Overview  

With this release, country-specific Tax 
forms can now be configured to collect 
tax data that is used to calculate value-
added tax based on rules set within the 
Tax Administration tool. These 
configured form fields appear when creating an expense assigned to a location within 
that tax authority. For example, a Number of Rental Days field used to determine 
a car rental tax in England would not be displayed for a car rental expense with a 
location within Germany. 

Benefits 

This enhancement includes a new form type - Tax  and new tax Custom fields, for 
use in collecting information necessary for correctly calculating the value-added tax. 
In addition, the display of tax-specific fields is filtered to show only for the expenses 
incurred in relevant locations.  

How It Works - General Steps 

The general steps to configure the fields for the tax form are: 

Business Purpose 

This enhancement allows tax-specific 
field display based on country and 
expense type. 
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• Configure the Tax form(s) in Forms and Fields, adding the Tax Custom fields 
and renaming to represent the data to be entered 

• Configure the required Tax Authority, Tax & Reclaim Group, and Employee 
Related Configurations using the Tax Administration tool. As part of this tax, 
define the Tax form to use for the Tax & Reclaim Group 

What the User Sees 

When the user creates the expense, they choose the expense type, and then the 
location (via selection of country, state/province and/or city), triggering display of 
the Tax form fields at the bottom of the entry form. In the figure below, the Car 
Rental expense type and the City value of London causes the Number of Rental 
Days field to display: 

  

Configuration 

The user will need to configure the tax forms and Tax & Reclaim Groups using the 
required tools as explained above. 

 Refer to Expense: Value Added Tax (VAT) / Tax Administration Setup Guide 
for more information. 
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Section 4:  Expense Pay 

The following features are included in this service release. 

Expense Pay APA: New Zealand is Now Available 

Overview  

Expense Pay APA has been expanded to 
include payments in New Zealand. The 
payments are in New Zealand Dollars. 
The program uses a direct debit process 
to achieve a four day payment cycle. This offering includes the following features: 

• Localized Funding Bank Account page 

• Localized Employee Bank Account page 

• Employee imports (810 record and Excel) support New Zealand 

• Support for American Express New Zealand Card Program 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

This feature requires a contract with Concur. Contact Concur Client Services to begin 
the process of adding this feature. 

Expense Pay APA: Hong Kong is Now Available 

Overview  

Expense Pay APA has been expanded to 
include payments in Hong Kong. The 
payments are in Hong Kong Dollars. The 
program uses a direct debit (also called 
Autodebit) process to achieve a  five day payment cycle. This offering includes the 
following features: 

• Localized Funding Bank Account page 

• Localized Employee Bank Account page 

• Employee imports (810 record and Excel) support Hong Kong 

• Support for American Express Hong Kong Card Program 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Business Purpose 

This new product expands the Expense 
Pay support in the Asia Pacific region. 

Business Purpose 

This new product expands the Expense 
Pay support in the Asia Pacific region. 
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Configuration 

This feature requires a contract with Concur. Contact Concur Client Services to begin 
the process of adding this feature. 

Expense Pay NA: Mexico is Now Available 

Overview  

Expense Pay NA has been expanded to 
include payments in-country in Mexico. 
The payments are in Mexico Pesos. The 
program provides a three day payment 
cycle. This offering includes the 
following features: 

• Localized Funding Bank Account page 

• Localized Employee Bank Account page 

• Employee imports (810 record and Excel) support Mexico 

• Support for American Express Mexico Card Program 

• Support for pre-funded funding accounts. For more information, refer to the 
release notes below. 

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

This feature requires a contract with Concur. Contact Concur Client Services to begin 
the process of adding this feature. 

Expense Pay NA Mexico: Payment Manager - Pre-Funded Account Now 
Available  

Overview  

An administrator has the ability to 
request a pre-funded funding account to 
be managed by Concur. Pre-funding 
means that the client determines the 
funding levels of accounts that are set 
up by Concur. Clients send in funds via Transferencia Electrónica de Fondos (TEF) or 
wire to fund the reimbursements to expense claim filers and corporate cards. 

Refer to the Expense Pay Guide for Professional/Premium for more information. 

Business Purpose 

This new product expands the Expense 
Pay support in the North America 
region. 

Business Purpose 

This enhancement now allows a client 
to control the cash flow by controlling 
the timing of the batch payments.  
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Configuration 

This feature is only available to NA Mexico clients. 

Expense Pay NA Mexico: Payment Manager - Ability to View Funding 
Account Activity for Pre-funded Accounts  

Overview  

A new tab is added that provides the 
administrator the ability to request and 
access the pre-funded account. They 
can now review past payments, 
upcoming expenses, and available 
balances.  

 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

This feature is only available to NA Mexico clients. 

Expense Pay Card Program Support Expanded 

Support for card programs have been added for the following expense pay offerings. 

• Expense Pay APA 

♦ New Zealand: American Express New Zealand. This card program supports 
negative payments. 

♦ Hong Kong: American Express Hong Kong. This card program supports 
negative payments. 

• Expense Pay NA 

♦ Mexico: American Express Mexico. This Mexican Peso card program does 
not support negative payments 

♦ Canada: HSBC MasterCard Canada. This card program does not support 
negative payments. 

Payment Manager: Cash Account Code Field is Now Available  

Overview  

On the Payment Manager > 
Configure Batches > Batch 
Definition > New Employee Batch 

Business Purpose 

This enhancement is now visible for all 
batch definitions. 

Business Purpose 

This enhancement now allows an 
administrator to review funding levels 
of pre-funded accounts.  
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Definition screen, the Cash Account Code field is now visible at all times.  

This field displays the accounting code that is in the accounting file. Prior to this 
release, this field was not visible for all batch definitions. For the June release, this 
field is now visible for all batch definitions. 

Payment Manager: Export to Excel is Now Added to the View Batches 
Page  

Overview  

You can now export data to an Excel 
spreadsheet when you are in the View 
Batches detail screen.  

 To export data to an Excel 
spreadsheet: 

1. On the Monitor Batches page, click the View Batches tab. 

 

2. Click Send to Excel. This opens an Excel spreadsheet.  

NOTE: The columns displayed in the View Batches page are the same that display 
in the Excel spreadsheet. 

Excel Data is Now Exported into Numeric Fields 

Overview  

When users export funding amount 
detail information into an Excel 
spreadsheet, the amount columns 
display in a numeric format. Prior to this 
release, when the data was exported to Excel, it displayed as text. 

Business Purpose 

This enhancement now shows the 
amount columns as number fields. 

Business Purpose 

This enhancement now provides you 
the ability to send data to an Excel 
spreadsheet.  
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 Refer to the Expense Pay Guide for Professional/Premium for more 
information. 

Configuration 

 No additional configuration is required to use this feature. 
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Section 5:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  
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This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 6:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 11.0 and 12.0 

Support for Firefox versions 11.0 and 12.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Support for Google Chrome v. 17.0 and v. 18.0  

Support for Google Chrome version 17.0 and 18.0 under both the Mac OS X and 
Microsoft Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Chrome v. 19.0 

Support for Chrome 19.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Safari 5.2 and Mac OS X 10.8 

Support for Safari 5.2 under Mac OS X version 10.8 will be included in an upcoming 
release. 

Support for Firefox v. 13.0 

Support for Firefox version 13.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 
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The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
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Release Notes – June 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

120427-
000289 

Expense / Printed Reports 

Russian Print Report prints on two pages. 

120306-
000949 

Expense / Authorized Approver 

Report is missing what Authorized Approver it should go to after CO Auth step 
could find another CO Approver. 

120430-
001124 

120510-
000130 

Expense / Travel Allowance 

Travel allowance - fixed meals field not getting set with default value. 

120523-
001154 

Expense / Training Page  

New Training page does not fully display in IE8 upon opening the page. 

111115-
000456 

Expense / Travel 

 iPhone App - Quick Expense. 

120507-
000732 

Expense / Payment Manager 

Reimbursement Manager - Group Aware - not filtering by group properly. 

120614-
001554 

Expense / Attendees 

Attendee Admin: 'Created By' Search not working. 

120420-
000271 

Expense / Company Card 

Summary window for reports that contain Company Card expenses doesn't 
always show "Amount Due Company Card". 

120519-
000007 

Expense / User Interface 

Unable to shut off the 2 new features Copy report and Allocation favorites. 

120511-
000760 

120520-
000045 

Expense / Travel Allowance 

Czech Republic domestic first/last day allowance not reducing correctly. 

120516-
001735 

Expense / Policies 

Can't copy policy to create a new one. 

111026-
000653 

Expense / Company Card 

Level 3 data - missing dollar amounts. 

120522-
000019 

Expense / Company Card 

Transactions are not showing under credit card module in Concur to assign 
and un-assign and it is taking a lot of time (buffer) to search. 

120521-
000638 

120521-
001584 

Expense / Printed Reports 

Detail Report PDF format is corrupt. Saving pdf of detailed report throws 
Adobe 135 error. 
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Case ID Case/Defect Description 

120524-
001310 

120326-
000747 

Expense / Privileges 

Employee Admin (Read-Only) error: Security Breach window when clicking on 
links under Expense and Invoice Settings. 

120605-
000484 

Expense / Travel Allowance 

Training Configuration Admin is listed as Travel Allowance Under Travel 
Request Admin Role. 

120511-
001031 

120511-
001031 

Expense / My Profile 

Trouble with creating CTE profile. 

120528-
000296 

Expense / Audit Rules 

Random Audit rule has wrong label Percentage = Every nth number of 
expense reports submitted. 

120402-
000244 

Expense / Localization 

Chinese localization changed back to English after Email Reminders are 
activated. 

111201-
000119 

Expense / Workflow 

COA -- approver account change resulting in CONOAPPR exception. 

120327-
000041 

Expense / Delegates 

When in the delegate configuration the "Delegate can submit cash advances 
and reports" setting is disabled completely, the delegates still can see the 
submit report button, instead of the Notify employee button. 

120524-
000474 

Expense / Company Card 

Duplicate card on excel export of company card manage accounts for the user 
Deanna Murlin. 

120521-
000425 

120521-
000121 

120524-
000990 

Expense / Localization 

User Administrator cannot administer employees in German Language. The 
fields are not available under "Expense and Invoice settings". 

120522-
000177 

Expense / Workflow 

Functional Extension - Approval Skip Step workflow is not working. 

120516-
001917 

Expense / Company Card 

Unexpected system error when using Company Card Billing Date in audit rule. 

120517-
000849 

Expense / AREA 

"Null" (4 character word) values in custom fields when saving employee 
record in IE. 

120605-
000274 

Expense / VAT 

VAT tax code - if the final digit of the tax code is a zero it is not displayed to 
processor and removed if entry resaved by processor. 
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Case ID Case/Defect Description 

120530-
001858 

Expense / Payment Manager 

Payment Manager link is not visible via CTE UI. 

120523-
001775 

Expense / Processor 

USGSA (reimb w/ limits) Approved amounts changes after Expense 
Processor's approval. 

120521-
002130 

Expense / Travel Allowance 

Time Entry Error on Itinerary Displays Border Crossing Date & Time. 

120522-
001426 

Expense / User Import 

Travel access removed after loading employee file with card data via User 
Import. 

120528-
000199 

Expense / Copy Report 

Copy Report with French language as Default - No option to enter the starting 
date for expense entries on New report. 

120613-
000114 

120612-
000768 

Expense / Forms & Fields 

Forms not displaying in Expense Admin. 

120503-
000837 

Expense / Company Card 

CTE_CREDIT_CARD_TO_ENTRY_MAPPING field not copied to child entries 
when CC entry matched to cash entry. 

120315-
001343 

Expense / User Import 

UI does not display properly in IE8 or 9 when reviewing import results in User 
Admin. 

120514-
000682 

Expense / Printed Reports 

Detail Print report to PDF displays with large font and using unexpected font 
type. 
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Section 2:  Resolved Issues - Jobs 
Case ID Case/Defect Description 

111026-
000653 

Expense / Company Card 
Include both Unit Price and Extended Line Item Amount in the enhanced data 
pop-up for purchase transactions. 

120503-
001052 

Expense / Company Card 
Recognize and categorize AdjustmentReasonCodes for Bank of America 
MasterCard CDF 3.0 feeds. 

120524-
000474 

Expense / Company Card 
Prevent duplicated row in Excel report in Manage Accounts 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 
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With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, June 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – July 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• Quick Expenses Grid View: 
The Quick Expenses feature allows a user the option of inputting their 
expense entries one after another in rapid succession in an Excel-like work 
pane. 

• Most Recently User (MRU) Approver Functionality: 
The user will now see an MRU list from which they can choose an approver in 
those pages that support approver selection, such as Approval Flow. This 
applies only to regular approver fields and not to authorized or cost object 
approver selections. 

• Exchange Rates Can Now be Marked Up: 
The external rates provided by Concur and used to default exchange rates can 
now be automatically adjusted by a predefined percentage to provide rates 
that are closer to typical market values encountered by travelers. 

• User Admin: Ability to Search for Test Users (Only): 
The User administrator can now use a Test User filter to view only those users 
who are Test Users in the system. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 2:  Expense 

The following features are included in this service release. 

Quick Expenses Allows Rapid Entry of Expense Entries 

Overview 

The Quick Expenses entry grid is a rapid 
data entry page that lets users quickly 
enter many simple expenses in an 
Excel-like format. This is useful for 
users who enter these types of  
repetitive expenses, such as meals and taxis. Expenses associated with card 
transactions may also be entered - the system proposes a match on the save action. 
Once the entries are saved, each entry can then be opened and worked with 
individually, for example, to upload a receipt, in the Edit Expense tab. 

How It Works  

The system prompts the user to try Quick Expenses using an instructional screen 
that displays when they open an  expense report. The instructional screen can be 
dismissed using the Never show this prompt again check box: 

 

The user clicks Quick Expenses to open the Quick Expenses entry grid. The cursor 
focus is set to the first entry to be added, under Date, as shown in the figure below: 

Business Purpose 

This enhancement allows rapid entry of 
common expense types you enter on a 
regular basis. 
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The user then begins entering expense types, with options to: 

• Use the keyboard to tab from field to field, and from the last field to a new 
row 

• Select the currency for all entries: Select from the Expense Currency list 

 

• Replicate the last entry: Click the copy row icon ( ) to create an identical 
row that you can then edit as required 

• Delete an entry: Click the red "X" ( ) to delete that entry row 

In the figure below, a second Company Car Maintenance expense type is generated 
from the initial entry in order to create a similar expense. The second entry is then 
edited under Business Purpose to refine this information:  

 

Field Display and Validations 

In use, the page will dynamically include predefined fields relevant according to the 
selected expense type (custom configured fields are not supported). For example, 
the columns of From Location, and To Location would appear for the Taxi expense 
type. All of the normal field validations and audit rules logic will be employed as part 
of the save process, so expense types with additional fields of type Required will be 
saved with the usual missing required fields notifications for follow-up later, prior to 
submitting the report. 
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NOTE: At this time, mileage-based expense types – which require additional fields in 
order to save – are not supported within the Quick Expenses grid 

Configuration 

No additional configuration is required to use this feature. 

Turning the Quick Expenses Functionality Off 

Quick Expenses is on by default. The administrator can elect to remove the Quick 
Expenses button from the user interface, essentially hiding this functionality from 
report creators. To do this, click Administration > Expense Admin > Site 
Settings and clear (disable) the Allow Expense users to add expenses via 
Quick Expenses grid setting. 

 

 Refer to the online Help for more information. 

Connected Lists: Expense Type as First Segment of List 

Overview  

A connected list definition can now be 
configured with an expense type field as 
the first field in the connected list. This 
allows the administrator to now work 
directly with expense type Item Code 
definitions (Awards = AWRDS) that the system will immediately recognize, causing 
the system to display the connected list within the Expense Entry form based entirely 
on the chosen expense type.  

How It Works 

The administrator may use Expense Type as the top level in the list definition. The 
administrator uses the Connected List tab of Forms and Fields to create the 

Business Purpose 

This enhancement lets the Expense 
Type drive the display of sub-fields 
when entering expense entries. 
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connected list. First, the list is selected and a definition name provided. Then, the 
Expense Type List Item Key field is selected along with additional (non-Hidden) 
fields to create the connected list set of fields.  

 

Then the administrator uses List Management to create their expense type connected 
list, being sure to use the for the expense type key value for the item code. For 
example, AWRDS is the system identifier (Item Code) associated with the Item 
Name "Awards" as shown in the figure below: 

 

Finish the creation of the list, being sure to preview the list (Step 4) and assign to 
the correct form (Step 5).  

What The User Sees  

The user creates their expense report, then adds each entry by selecting the 
expense type "Awards". When they do this, the Expense Type field acts as the first 
field in the connected list, and Connected List Two and Connected List Three are 
displayed with the appropriate values: 
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Additional Information 

Please note the following when using this feature: 

• The Expense Type List Item Key field must be the first item in the 
connected list for this feature to work 

• The Expense Type List Item Key field can only be used in a single 
connected list definition, after which it is no longer available 

• If the name is to appear the same for connected list audit rules, be sure the 
value you input for Item Name matches the Expense Type name exactly 

• This feature is supported under Expense Type and List import functions - 
when you update an expense type that is part of a connected list, be sure to 
update the list import as well to match 

How Do I Find the System Expense Type Item Code Names? 

To find the Item Code values, export a list of system expense types by clicking 
Localization > Export Localization, choosing English, selecting All categories, 
then clicking Export - a list of the system codes (up to 5,000) is generated in a text 
file you can search for the relevant expense type (figure below shows the Awards 
Item Code) and the key ‘AWRDS’. 

 

 Refer to Expense: Forms and Fields Setup Guide for more information. 
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Choose Approver from Most Recently User (MRU) List Type 

Overview  

The Most Recently Used (MRU) 
functionality that provides a list of 
recently-used names is now available in 
the Approval Flow screen. With this 
change, the user editing the approver or adding an ad-hoc step will be provided a list 
of recently-used approvers from which to select a name. 

The list is populated as the user works with choosing approvers. So, for the first 
instance, only the standard search functionality appears within Approval Flow. In the 
figure below, Pat Davis is selected via a filter of Last Name: 

 

However, after selecting one or more approvers, their names will now appear for 
selection when a new step is added. In the figure below, the user has recently 
selected Erin Fletcher and Pat Davis as approvers, and now their names will appear 
for quick selection (note no name has been typed): 

 

To dismiss the MRU list, type directly under User-Added Approver; the names are 
cleared, leaving only the default search functionality.  

Please note the following when using this feature: 

• The MRU functionality is available for all regular approver steps, whether 
predefined or ad-hoc 

• Cost Object Approvers cannot be changed; however, an ad-hoc step will show 
the MRU list just as for other ad-hoc steps 

• This features does not apply to Authorized Approver  

Configuration 

No additional configuration is required to use this feature. 

 Refer to the online Help for more information. 

Business Purpose 

This enhancement speeds selection of 
favorite approvers for the user. 
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Optional Exchange Rates Mark Up Variable Re-Calculates External 
Rates 

Overview  

In order to set a more realistic 
exchange rate, the administrator can 
now elect to ‘mark up’ the interbank 
exchange rate provided by Concur (via 
Oanda) by an additional percent variable (for example, 2%). By entering this 
variable, the final calculation when comparing currencies or drawing on the default 
exchange rate is Oanda + 2%.   

This is useful as credit cards, currency exchange kiosks, and hotels or other 
merchants will mark up their offered exchange rate. 

NOTE: This feature applies only to the external (Oanda) rate exchange calculations, 
and does not apply to those imported and retained as internal exchange rates 
in the exchange rate table - these rates are unaffected by the variable. 

Configuration 

The client should submit a service request to Concur Support, stating the percentage 
variance they want for the Exchange Rates Mark Up feature. 

 Refer to Expense: Currency Admin Setup Guide for more information. 

User Admin: New Test User Filter Criteria Available 

Overview  

A new search criteria, Expense Test 
Users, allows the user administrator to 
configure a search that returns a list of 
users that either  includes or excludes 
users of this type, or returns all users, 
test users or not.  

How It Works 

To use this feature, click Administration > Company Admin > User 
Administration. Then, ensure the Show Filters and User Expense Advanced 
Filters options are selected (enabled). Select one of three options under Expense 
Test Users: 

• All Users: The default; does not filter against Test User 

• Exclude Test Users: Do not include users of type Test User in the search. 

• Only Test Users: Include users of type Test User in the search. 

Business Purpose 

This enhancement supports a more 
realistic exchange rate for the user. 

Business Purpose 

This enhancement lets the user 
administrator quickly find Test User 
type users in their system. 
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NOTE: This filter appears only if the system detects that there are Test Users in the 
system; otherwise, this option is unavailable. 

In the figure below, the search will only be conducted on users who are of type Test 
User - all other user types are ignored: 

 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Shared: User Administration User Guide for more information. 

Password Strength Meter for New/Change Password Function 

Overview  

An interactive password strength meter 
has been implemented for Concur 
Travel & Expense. When a user changes 
his/her password, Concur will indicate if 
the password is Poor, Fair, Strong, or 
Very Strong. 

Rules for determining password strength are: 
 

State Rules 

Too short Less than 7 characters 

Very Strong 7 or more characters and contains: 

• Uppercase character + lowercase character + digit + special character 

Strong 7 or more characters and contains: 

• Uppercase character + lowercase character + digit 
– or – 

• 2 or more digits + uppercase character 
– or – 

• 2 or more digits + lowercase character 

Business Purpose 

This enhancement lets the user 
administrator quickly find Test User 
type users in their system. 



Concur Release Notes Page 12 Expense Professional / Premium 
July 2012 Concur Clients 

– or – 

• 2 or more special characters 

Fair 7 or more characters and contains: 

• Uppercase character + lowercase character 
– or – 

• Lowercase character + digit 
– or – 

• Uppercase character + digit 

Poor 7 or more characters and does not pass the rules for Very Strong, Strong, or 
Fair. 

What the User Sees 

When the user selects Profile > Change Password: 

Less than 7 characters: 
 

 

7 characters – all lowercase: 
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7 characters – lowercase and uppercase: 

 

7 characters – lowercase, uppercase, and a digit: 

 

7 characters – lowercase, uppercase, a digit, and a special character: 
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Section 3:  Central Reconciliation 

The following features are included in this service release. 

Reconcile Transactions Against Employee Spend using Employee ID 

Overview  

With this service release, the Employee 
ID value can now act as the 
reconciliation agent when reconciling 
the Lodge card account import. This 
means that the client can use the 
features of Central Reconciliation 
outside of Travel Request to match imported transactions. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to the Central Reconciliation Setup and User Guides for more 
information. 

Business Purpose 

This enhancement adds another 
reconciliation option and frees a site 
from having to implement Travel 
Request for transactional matching. 
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Section 4:  Expense Pay 

The following features are included in this service release. 

Expense Pay Card Program Support Expanded 

Support for card programs have been added for the following expense pay offerings. 

• Expense Pay EMEA: HSBC Visa UK. This card program does not support 
negative payments. 
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Section 5:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  
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This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 6:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 13.0 

Support for Firefox versions 13.0.1 under both the Mac OS X and Microsoft Windows 
operating systems is certified for this release. 

Support for Google Chrome v. 19.0  

Support for Google Chrome version 19.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Chrome v. 20.0 and v 21.0 

Support for Chrome 20.0 and 21.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 

Support for Firefox v. 14.0  

Support for Firefox versions 14.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 

Support for Safari 6.0 and Mac OS X 10.8 

Support for Safari 6.0 under Mac OS X version 10.8 will be included in an upcoming 
release. 
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Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, July 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – July 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

120511-
000806 

Expense / Attendees 

Attendee Admin search causing an unexpected error. 

120614-
000685 

Expense / Change Log 

Change log records incorrect emp_key when an administrator proxies as a 
user, then goes into administration to make changes. 

120625-
000177 

Expense / Company Card 

Manage Transactions is showing in each credit card transaction a broken 
image instead of a checkbox. 

120626-
000369 

Expense / User Permissions 

Travel Request administrator is available in the entity where TR is not 
activated. 

120614-
000025 

Expense / Attendee Import - Localization 

The Attendee link is not appearing correctly for several localized languages. 

120518-
000802 

Expense / Travel Allowance 

The Travel Allowance user who creates an itinerary assigned to a report and 
submits the report cannot work with a new itinerary that shares the same 
date as the submitted itinerary - the day is locked and unavailable. 

120515-
001820 

Expense / Cash Advance 

The Cash Advance Return expense type will not appear for selection if the 
cash advance is part of a travel request added to the expense report. 

120703-
000230 

Expense / Tier 2 Localized Languages 

Question marks are appearing instead of characters for the Greek tier 2 
language. 
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Section 2:  Resolved Issues - Jobs 
Case ID Case/Defect Description 

111026-
000653 

Expense / Company Card 
Include both Unit Price and Extended Line Item Amount in the enhanced data 
pop-up for purchase transactions. 

120503-
001052 

Expense / Company Card 
Recognize and categorize AdjustmentReasonCodes for Bank of America 
MasterCard CDF 3.0 feeds. 

120524-
000474 

Expense / Company Card 
Prevent duplicated row in Excel report in Manage Accounts 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 
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With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

This document contains proprietary information and data that is the exclusive 
property of Concur Technologies, Inc., Redmond, Washington. No part of this 
document may be reproduced, transmitted, stored in a retrievable system, 
translated into any language, or otherwise used in any form or by any means, 
electronic or mechanical, for any purpose, without the prior written consent of 
Concur Technologies, Inc. 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, July 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – August 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release. 

• Use of Mileage Calculator Can be Made Mandatory 
The use of the mileage calculator can now be made mandatory by the Car 
Configuration administrator, requiring the user to work with the calculator 
when entering new car mileage expenses. 

• Attendees: Change Attendee Type 
The Attendee Type, previously locked down after creating an attendee, can 
now be changed up to the point where the attendee is part of a submitted 
expense report. 

• Receipt Images: Allow More Than One Image for Expense Entry 
More than one image can now be associated at the expense entry level of the 
expense report. 

• Workflow: Direct Approval Routing Under Cost Object Approval 
A cost object can now be routed directly to the approver with the correct 
signing authority, bypassing all other approvers. 

• Change Log: Additional Search Options now Available 
Administrators searching for Change Logs can now draw on search criteria 
such as name or the actual configuration area, such as Car Configuration or 
Audit Rule. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 2:  Expense 

The following features are included in this service release. 

Car Configuration: Force Use of Mileage Calculator 

Overview  

The Car Configuration administrator can 
now enforce use of the mileage 
calculator when users are entering car 
mileage expenses. This helps prevent 
errors when configuring point to point 
and overall distance data by enforcing use of mileage calculations for this purpose, 
and allows the company to require the commute deduction used by the mileage 
calculator. 

How It Works 

To enforce use of calculations measured using the Mileage Calculator window, the 
Car Configuration administrator sets the option in Administration > Expense 
Admin > Car Configuration. The new option is available when creating a new car 
configuration or editing an existing configuration, as shown in the figure below: 

 

In the General step, the administrator now has three selections for the Allow Google 
Maps Integration option: 

Business Purpose 

This enhancement provides controls by 
requiring the Google Mileage Calculator 
calculations. 
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• No: The Mileage Calculator link is hidden, and the user enters the To and 
From Location values manually 

• Yes: The Mileage Calculator link is available and can be used optionally, in 
place of the To and From Location options, to populate these fields 

• Required: The Mileage Calculator window appears automatically when the 
user chooses the car mileage expense types - the To and From Location 
options are disabled and the user must use the calculator to record the trip 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Car Configuration Setup Guide for more information. 

Change Log: Additional Search Filters Now Available 

Overview  

Several new options for searching the 
Change Log feature are now available 
with this service release: 

• Employee First Name 

• Employee Last Name 

• Configuration Type 

These filters are used together with the existing Start Date and End Date filters. 
The administrator first chooses the date range, then filters the criteria further by 
selecting either of the Name options, or the Configuration area within Expense (such 
as Approver or Group), as shown in the figure below: 

 

TIP: To view every configuration area, leave Select as the filter type; all 
configuration areas will appear and can be scrolled through to find specific areas of 
change. 

Business Purpose 

This enhancement provides better 
search tools for locating changes for 
specific areas within Expense. 
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Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Change Log User Guide for more information. 

Spain Travel Allowance: Setting for Rate Location of Single Day Trip 

Overview  

A new property lets the administrator 
set the location that is used to calculate 
single day travel allowance for Spainish 
travelers. The property, 
domestic_rates_for_single_day_trip, 
affects what location the system will 
consider when calculating the travel allowance for a single day trip for the Spanish 
traveler.  

The values are: 

• Y (default): The domestic location will always be used 

• N: The last location visited will be used for the date if foreign locations were 
visited 

Configuration 

The client will need to submit a Service Request to Concur Support to set their 
preferred value for this feature. 

 Refer to Travel Allowance Configuration Guide - Spain for more information. 

Cost Object Approval Workflow: Direct Routing Now Supported 

Overview  

A limit-based Cost Object Approval 
(COA) workflow can now be configured 
for direct routing of a cost object to the 
approver with the correct limit 
authorization amount (signing limit).  
Enabling this feature causes the COA 
limit-based workflow to bypass other approvers who do not have the signing 
authority required to approve the cost object amount. Instead, the cost object is 
routed to the first approver granted approval rights for equal or above the amount of 
the cost object to be approved.  

Business Purpose 

This enhancement adds configurability 
for the location portion of the overall 
calculation for single day travel for the 
Spanish Traveler. 

Business Purpose 

This enhancement speeds COA 
approval by routing the cost object 
directly to the approver with the 
correct limit-based approval rights. 
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How It Works 

When configuring the COA workflow, the administrator selects Limit, which exposes 
the Cost Object Direct Approval check box. This option is off (cleared) by default - 
the administrator selects the check box to enable the feature as shown in the figure 
below: 

 

Now, the cost object will route directly to the first approver with an amount equal to 
or above that associated with the cost object. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Workflow: Cost Object Approval Setup Guide for more 
information. 

Company Card: Show Cancelled Cards in Manage Accounts 

Overview  

The Company Card administrator can 
now use a new filter, Include 
Cancelled Accounts, to return card 
accounts with a status of Cancelled 
when searching for accounts using 
Manage Accounts. 

How It Works 

To use this filter, the administrator selects the desired search criteria, then selects 
the Include Cancelled Accounts check box to include cancelled cards in the result 
set (it is disabled by default) that meet the search criteria.  

Business Purpose 

This enhancement gives the 
administrator more precise search 
tools. 



Concur Release Notes Page 8 Expense Professional / Premium 
August 2012 Concur Clients 

 

The Cancelled? column displays a Yes value when the card account has been 
cancelled by the provider, allowing quick identification and sorting options for the 
administrator. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Company Card User Guide for more information. 

Attendees: Change the Attendee Type of a New Attendee 

Overview  

When a new attendee is created, the 
Attendee Type value is locked down 
once the attendee is saved. With this 
release, the Attendee Type value can 
now be changed after the attendee is created and before that attendee is submitted 
on a report, authorization request, or travel request. 

This feature allows users who mis-identify the type of attendee they have created to  
correct their mistake. Note that, once the attendee is submitted on a report, or an 
authorization or travel request, the Attendee Type value is locked by the system. 
However, if the report has a status of Sent Back, the user is again provided an 
opportunity to change this value if the attendee has not yet been used on a different 
report or request. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Attendee Administrator User Guide and Expense: Attendees 
Setup Guide for more information. 

Business Purpose 

This enhancement provides additional 
flexibility when working with attendees. 
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Imaging: Attach More Than One Image to an Expense Entry 

Overview  

The restriction allowing one receipt 
image for each expense entry is now 
removed, and the report creator can 
now append as many receipt images as 
required to substantiate their expenses at the expense entry level. 

How It Works 

Appending an additional image works exactly the same as attaching the initial (first) 
image, except that the system will ask if you want to append an additional image 
along with the existing image(s). Note that only a single additional image may be 
attached at a time. Bulk image upload is not supported.  

Example 

The user creates the report and, with the entry open, attaches the initial image using 
the Attach Receipt button: 

 

When the user elects to add a second image, the Attach Receipt button is again 
used (for this example - all options function the same); however, the following 
informational message appears, allowing the user to decide if they wish to add an 
additional receipt image (Yes), or cancel the action (No): 

 

Once the image is appended to the existing (prior) image(s), all images are merged 
together and cannot be separated.  

Business Purpose 

This enhancement improves usability 
for users. 
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If the user wants to replace the image attached to the expense with a different one, 
the process has not changed. The user must first detach the existing image from the 
entry and then attach the new image. 

To delete an image, the user uses the following existing options: 

• Click the Receipt Image tab, then click Detach From Entry 

• Hover over the receipt image icon, then click Detach From Entry 

After detaching the image, it is moved to Receipt Store for use later, or deletion if 
you prefer. Note that, if multiple images exist for the expense entry, all of these are 
detached, and all are retained as a single image file in Receipt Store (they are not 
separated for individual use). 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Expense: Image Handling - Receipt Store Setup Guide and Expense: 
Image Handling - Receipt Imaging Setup Guide for more information. 
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Section 3:  Expense Pay 

The following features are included in this service release. 

Expense Pay EMEA – United Kingdom: Payment Manager - Pre-Funded 
Account Now Available 

Overview  

Expense Pay EMEA – UK has been 
expanded to include a pre-fund funding 
option for users based in United 
Kingdom. There are now two funding 
options for UK clients to fund their 
payments: 

• MT101 Reverse Wire (referred to 
as Direct Debit) 

• Pre Fund 

The payments are in Pound Sterling. An administrator now has the ability to request 
a pre-fund funding account that will be managed by Concur. Concur will open a 
Pound Sterling account on behalf of the client in the UK, and the client will send 
funds via Clearing House Automated Payment System (CHAPS), Bankers Automated 
Clearing Services (BACS), or Faster Payment Services (FPS) to fund the 
reimbursements that Expense Pay will then make to their employees and card issuer 
on their behalf. 

This offering includes the following features: 

• Support for pre-funded funding accounts. 

• Localized Pre-fund Funding Account page 

Business Purpose 

This enhancement now allows a client 
to choose how they will fund their UK 
payments: either by sending in funds 
required (Pre Fund) or by authorizing 
Concur to debit their funding account 
(Direct Debit).  
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 Refer to the Expense Pay Guide for Professional/Premium User Guide for more 
information. 

Configuration 

This feature requires a contract with Concur. Contact Concur Client Services to begin 
the process of adding this feature. 

Reconciling Pre-fund Accounts  

Overview  

There is a new tab called Bank 
Statements that is located on the 
Monitor Batches page. This tab allows 
a Reimbursement manager to view the 
available balance, credits, and debits on 
their pre-fund account, and perform 
reconciliations. 

Business Purpose 

This enhancement allows a 
Reimbursement manager to reconcile 
pre-funded accounts. 
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 Refer to the Expense Pay Guide for Professional/Premium User Guide for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Payment Manager: The Manage Card Program Has Moved from the 
Reimbursement Manager to Payment Manager  

Overview  

Manage Card Programs is now 
located on the Configure Batches 
page located on the Payment Manager 
page The new title is Card Programs. 

 

 

If a user is creating a new card program, on the Card Programs tab, click New. 
The following is the new screen for adding a new card program. 

Business Purpose 

This enhancement moves Manage Card 
Programs from the classic interface to 
the current interface. 
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Configuration 

No additional configuration is required to use this feature. 

Payment Manager: Report Payees List Has Enhanced Functionality 

Overview  

Before this release, when the user 
wanted to review the specific report for 
a specific report payee, they had to 
manually enter the Report ID or Batch 
ID that displayed on the Report 
Payees List into the search field of the 
Monitor Payees page. Now, the user can copy and paste Batch ID or Report ID into 
that search field. 

Configuration 

No additional configuration is required to use this feature. 

Expense Pay Card Program Support Expanded 

Support for card programs have been added for the following Expense Pay offerings. 

Business Purpose 

This enhancement allows the user to 
copy and paste a Batch ID or Report ID 
to perform a search. 
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• Expense Pay NA: Iberiabank Visa US (this card program does support 
negative payments) 

Email Alert When a User Changes a Bank Account Number  

Overview  

When users change either the routing 
number or the account number in the 
Bank Information page, they receive 
the following email: 

Subject: Concur banking information 
change 

Dear <User First Name>, 

On <Month, day, year> the bank information we use to process your expense 
reimbursements was changed. If you made this change then no action is required. 

If you didn't make this change, you should login to the Expense service and confirm 
that your bank information is correct. 

Configuration 

No additional configuration is required to use this feature. 

 

Business Purpose 

This enhancement provides an email 
alert to a user if they change a routing 
number or account number to provide 
additional security around this 
sensitive information. 
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Section 4:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  
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This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 5:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 14.0.1 

Support for Firefox versions 14.0.1 under both the Mac OS X and Microsoft Windows 
operating systems is certified for this release. 

Support for Google Chrome v. 20.0  

Support for Google Chrome version 20.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Chrome v 21.0 

Support for Chrome 21.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Firefox v. 15.0  

Support for Firefox versions 15.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 

Support for Safari 6.0 and Mac OS X 10.8 

Support for Safari 6.0 under Mac OS X version 10.8 will be included in an upcoming 
release. 
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Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, August 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – September 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 
• Delegate Can Now Review and Notify Report as Ready for Approval 

A new option for the delegate gives them permissions to review, send back, 
correct, and mark a report as ready for approval (they are prohibited, 
however, from actually approving the report). 

• Separate Delegate Submit Rights for Expense Reports/Travel 
Requests 
Delegates may now be assigned separate submission rights for expense 
reports and travel requests 

• Time Period-Driven Audit Rule Can Total Multiple Expense Types 
An audit rule can now be constructed that analyzes a total from multiple 
expense types, for example, Breakfast, Lunch, and Dinner all at the same 
time, flagging the total if it exceeds a daily, weekly, monthly, or yearly limit. 

• Custom fields for Attendees Unique to Expense 
Additional data about an attendee may be recorded that is unique to the 
specific expense 

• Cash Advance Administrator May Issue and Record Cash Advance 
Returns 
The cash advance administrator may now directly issue cash advances and 
may record cash advance returns. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 2:  Expense 

The following features are included in this service release. 

Cash Advance: Record a Manually-Returned Cash Advance Amount 

Overview  

The Cash Advance administrator can 
now record the cash amount manually 
returned by the user issued the cash 
advance. Since a cash advance can 
exist outside of an expense report, this 
feature allows more flexibility in recording the return of funds. In addition, the 
system will automatically decrement and increment  the available cash advance 
balance on report submit and report recall actions. 

How It Works 

What the Administrator Sees 

The cash advance must be in the following state to use this feature: 

• The cash advance is in an Issued state 

• The cash advance balance is above a balance of zero 

• The Payment Type value is Cash 

When receiving a return of cash from the user, the Cash Advance administrator 
navigates to Expense Admin > Expense Tools > Cash Advance Admin tool. 
Searching on the employee in the Employee Balance tab, they click the name 
directly to populate rows in the Cash Advances section: 

 

Selecting the row under Cash Advance Name, the administrator clicks Record 
Return Amount (this button is activated) to display the Cash Advance Details 
window.  

Business Purpose 

This enhancement facilitates recording 
the accounting of the cash advance 
disbursement. 
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The amount is entered in Amount Returned, and an optional comment is added. If 
the cash advance is in a currency other than the user’s reimbursement currency, the 
amount returned may be recorded in either currency based on what currency is 
received by the administrator. 

What the User Sees 

The user can review the status of the cash advance by clicking View Cash 
Advances > Expense List. The Cash Advance Expenses window shows the 
returned amount and the balance amount. 
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Note the following when using this feature: 

• The currency of the returned amount is of cash advance or cash advance 
request currencies only 

• This data is extracted with a status of Reverse Issuance 

Configuration 

This feature is available by default; no additional configuration is required to use this 
feature. However, if you want to turn this feature off, follow the steps below. 

TURNING THE FEATURE OFF 

This feature is on by default. The administrator can elect to remove this feature from 
the cash advance administrator. To do this, click Administration > Expense 
Admin > Site Settings and clear (disable) the Allow Cash Advance 
Administrator to Record Return Amount setting. 

 

Cash Advance: Administrator Can Now Issue a Cash Advance 

Overview  

The Cash Advance administrator can 
now use options in Employee Balance  
to search for an employee and then 
create and issue a cash advance on 

Business Purpose 

This enhancement simplifies the 
process of issuing cash advances. 
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their behalf. This bypasses the workflow used for approval when the advance is 
requested by the user, allowing for a simplified process. 

NOTE: The extract will show this advance type identically to any other cash advance 
type. 

How It Works 

The Cash Advance administrator first searches for the employee they will issue the 
cash advance to using options in Employee Balance: 

 

With the employee selected, the admin clicks Create & Issue: 

 

The Create and Issue Cash Advance dialog box opens. Using options in this dialog 
box, the admin can name the advance, specify the amount and currency, and add a 
comment as needed: 

 

Clicking Issue causes a confirmation message to appear: 
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In this example, Chris Miller will now see the cash advance in the My Profile view, 
under Cash Advances (shown below), and in Expense > View Cash Advances: 

 

Configuration 

This feature is available by default; no additional configuration is required to use this 
feature. However, if you want to turn this feature off, follow the steps below. 

TURNING THE FEATURE OFF 

This feature is on by default. The administrator can elect to remove this feature from 
the cash advance administrator. To do this, click Administration > Expense 
Admin > Site Settings and clear (disable) the Allow Cash Advance 
Administrator to Create & Issue cash advances setting. 
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Audit Rules: Period-Based Amount Limit Rules on Multiple Expense 
Types 

Overview  

An administrator wishing to configure 
an Audit Rule that can analyze a 
summary total on all meals within a 
date range would have to create a 
separate audit rule for each expense type, Breakfast, Lunch, and Dinner. With this 
release, the user can now build an Audit Rule that can analyze the total of a group of 
expense types, flagging the total when the total of all the expense types exceeds the 
limit during the time period. 

This feature reduces the time spent creating the audit rule and provides the flexibility 
the user needs to group expense types needed for their rule. The total amount of all 
expenses with the listed expense types that occur during the indicated time frame 
will be summed up during the evaluation of the rule limit. 

 

NOTE: Period total rules are calendar-based for month or year. For performance and 
consistency, the start and end dates are not configurable to align with 
accounting periods that are not in sync with calendar months. 

The following are the Entry Data Object options for multiple expense types: 

• Amount – Daily Total (multiple expense types) 

• Amount – Monthly Total (multiple expense types) 

• Amount – Weekly Total (multiple expense types) 

• Amount – Yearly Total (multiple expense types) 

Configuration 

Audit rules are configured under Expense Admin > Audit Rules. A new audit rule 
would be required to use these new total options. 

 Refer to Expense: Audit Rules Setup Guide for more information. 

Business Purpose 

This enhancement allows the admin to 
set up limits across expense types. 
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Delegate Can Preview Report for Approver 

Overview  

With this release, an approver's 
delegate can be allowed to preview each 
expense report in the approver's 
approval queue. This delegate cannot 
approve the expense reports – instead, 
the delegate's task is to ensure that the reports are ready for the approver to review 
and approve. 

The delegate reviews each report, checks for inconsistencies, verifies receipts, and – 
if necessary – sends back to the employee for corrections. When ready, the delegate 
notifies the approver that the report is ready for his/her review.  

NOTE: A delegate that is assigned this new "preview" option cannot also be allowed 
to approve reports on behalf of the approver. 

What the Delegate Sees 

Once the delegate is assigned the proper rights (described below), the delegate 
accesses the approver's approval queue, either on My Concur or by selecting 
Expense > Approve Reports. 

 

The delegate opens the desired expense report and reviews the information, verifies 
receipts, etc. 

 

Business Purpose 

This enhancement allows delegation of 
approval review without authority to 
“sign” the approval. 
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When ready, the delegate clicks Notify Approver.  

Once the delegate clicks Notify Approver: 

• An email is sent to the approver, indicating that the report has been reviewed 
by the delegate (see note below about this email notification). 

• A new icon appears in the approval queue so the approver knows the report 
has been reviewed. This icon is visible to all users who may view this queue, 
both delegates and the approver. 

 

Note the following: 

 

• If the delegate reviewed the report in error, the delegate clicks Mark As Not 
Reviewed. The "reviewed" icon is removed from the approval queue so the 
approver knows the report is not ready. 

 

NOTE: If the delegate marks the report as not reviewed, the icon is removed 
from the report in the approver's approval queue. It does not, 
however, recall the email notification to the approver nor does it send 
an updated email to the approver. 

• The email notification from the delegate is similar to the report preparee to 
the employee that the report is ready for submission - it is system-generated 
and not configurable by the client. 

• The delegate's action is reflected in the audit trail, which is visible to the user, 
delegate, and approver. 
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Configuration 

Configuration is a two-step process: 

• First, the Expense Configuration administrator must add the new option to 
any or all delegate configurations.  

• Then, the User Administrator or employee must select the option for the 
desired delegate(s).  

EXPENSE ADMINISTRATOR 

To use this option, the Expense Configuration administrator must: 

1. Select Administration > Expense Admin > Delegate Configurations (left 
menu). 

2. Select the desired configuration and click Modify. 

 

The Edit Expense Delegate Configuration page appears.  
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3. In the Employee and/or User Administrator column, select the Delegate 
can preview report for approver check box. 

4. Click Save. 

5. Repeat for all desired delegate configurations. 

USER ADMINISTRATOR OR EMPLOYEE 

Once the option has been added to the delegate configuration(s), the Can preview 
for approver option appears in: 

• User Admin (Expense Delegates link in the Expense and Invoice Settings 
section)  
– and – 

• Profile (Expense Delegates link on the left menu). 
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The User Admin or the employee selects Can preview for approver and saves. 

Note the following: 

• Receives Approval Emails should also be selected so the delegate is 
notified about reports to review. 

• A delegate cannot be assigned both the Can Approve and the Can Preview 
for Approver option. 

Attendees: Expense Entry Custom Fields per Attendee Are Now Added 

Overview  

Several custom fields are now added to 
the Attendee-Expense entry level. 
These custom fields allow collection of 
information specific to the attendee on 
the current expense.  

Data included in these custom fields can be extracted using the Attendee Detail 
extract. 

 

Configuration 

Five attendee-specific custom fields are available to add to the Expense Attendee 
Detail View form. 

 Refer to Chapter 7: Standard Attendee Detail Extract of the Expense – Import 
and Extract Specifications manual for more information. 

Business Purpose 

This enhancement adds Custom 
attendee fields at the entry level. 
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Send Back Expense Feature is Now Available to Reports with Travel 
Allowance 

Overview  

The Send Back Expense (Split Report) 
was not available on reports that were 
linked to a Travel Allowance itinerary. 
Now, this enhancement allows 
expenses that are not Travel Allowance-
related to be sent back from such a 
report. 

The expenses that are excluded are: 

• Fixed meals or fixed lodging expenses 

• Reimbursable expenses: meals or lodging expenses that have the Travel 
Allowance box checked 

Configuration 

The Send Back Expense feature must be enabled to take advantage of this change. 
To do this, add the Send Back Expense field to the applicable expense entry forms. 

Delegate Submit Option Separated – One for Travel Requests; One for 
Expense Reports 

Overview 

For clients who use Travel Request, the 
option allowing a delegate to submit has 
been changed:  

• The existing option – Can 
Submit Reports – applies to 
cash advances and expense 
reports only; it no longer includes travel requests. 

• A new option – Can Submit Travel Requests – applies to travel requests. 

Business Purpose 

This enhancement expands the option 
to send back entries to reports 
containing travel allowances. 

Business Purpose 

This enhancement allows the client to 
have separate delegate "submit" 
options for Expense and Travel 
Request. 
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Configuration 

For this release, configurations that already use Delegate can submit cash 
advance and reports will automatically be assigned the Delegate can submit 
travel requests option. 

If you want to make changes, note that configuration is a two-step process: 

• First, the Expense Configuration administrator must change any or all 
delegate configurations.  

• Then, depending on the change, the User Administrator or employee may 
have to update the options for the desired delegate(s).  

EXPENSE ADMINISTRATOR 

To change any or all configurations, the admin follows these steps: 

1. Select Administration > Expense Admin > Delegate Configurations. 

2. Select the desired configuration and click Modify. 

3. In the Employee and/or User Administrator column, select or clear – 
whichever is desired – the Delegate can submit travel requests check 
box. 
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NOTE: This new Delegate can submit travel requests option appears on 
the delegate configuration page only if the Expense client also uses 
Travel Request. 

4. Click Save. 

USER ADMINISTRATOR OR EMPLOYEE 

Once the delegate configuration(s) has been changed, depending on the changes, 
the individual delegate options may need to be updated. To do so, the User 
Administrator or employee can access the delegate information here: 

• User Admin (Expense Delegates link in the Expense and Invoice Settings 
section; Travel Request uses Expense delegates)  
– and – 

• Profile (Expense Delegates link on the left menu). 
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Section 3:  Expense Pay 

The following features are included in this service release. 

Payment Manager: Allow Employee to Modify their Bank Information 
Selection is Now Moved to Payment Manager  

Overview  

A new function Allow Employee to 
Modify their Bank Information has been 
moved from Expense Admin > Group 
Configuration and is now added to the 
Batch Definition page on the 
Payment Manager tool. This selection 
displays when the user selects either to modify an employee definition or to add a 
new employee definition. 

If allowed, this selection allows employees to edit their bank account information.  

 

 Refer to the Expense Pay User Guide for Concur Professional/Premier for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

The enhancement gives clients more 
capability on the Batch Definition page 
of the Payment Manager tool. 
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Expense Pay EMEA - UK: Employees Can Now Enter Either IBAN or Sort 
Code and Account Number  

Overview  

Before, if UK employees were 
reimbursed in GBP, the employees could 
enter only the IBAN for their bank 
account. Now, employees will have a 
choice to either enter a six-digit Sort 
Code and an eight-digit Account 
Number for their bank account or the IBAN. 

 Refer to the Expense Pay User Guide for Concur Professional/Premier for more 
information. 

Configuration 

No additional configuration is required to use this feature. 

Expense Pay Sweden: New Funding Banks for Sweden are Now Added 

Overview  

The Expense Pay Sweden funding bank 
support has been expanded to include 
the following banks: 

• Nordea Bank 

• Bank of America 

These banks now appear on the Funding Account page in the Bank Name list. 

Configuration 

No additional configuration is required to use this feature.  

Expense Pay Card Program Support Expanded 

Support for card programs has been added for the following Expense Pay offerings. 

• Expense Pay NA: SunTrust Visa and MasterCard US (these card programs do 
not support negative payments)  

• Expense Pay NA: Capital One MasterCard US (this card program does not 
support negative payments)  

Business Purpose 

This new feature expands funding bank 
support in Sweden. 

Business Purpose 

This enhancement provides greater 
flexibility for UK employees to enter 
their banking in Expense in either IBAN 
or the local account number format. 
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• Expense Pay APA: Citibank MasterCard AUD (this card program does not 
support negative payments)  

• Expense Pay APA: Citibank MasterCard SGD (this card program does not 
support negative payments)  

Configuration 

No additional configuration is required to use this feature. 

Expense Pay Account Confirmation Email Subject Line is Changed  

Overview  

Before, when the Expense Pay service 
sent out an email notification that the 
service had completed an account 
confirmation transaction to your bank 
account, the subject line in the email 
was as follows: 

Expense Pay Notification: Account Confirmed. 

Now the subject line reads as follows: 

Expense Pay Notification: Account Confirmation Sent 

Configuration 

No additional configuration is required to use this feature. 

 

Business Purpose 

This enhancement changes the email 
subject line on an Expense Pay 
notification.  
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Section 4:  Jobs 

Addition to the Employee Import - Travel Request Delegate Submit 

Column 15 has been added to the 550 record of the Employee Import. 

With this release, the delegate option allowing a delegate to submit has been 
changed, and the import has been changed accordingly. 

• The existing option – Can Submit Reports – applies to expense reports; it 
no longer includes travel requests. 

• A new option – Can Submit Travel Requests – applies to travel requests. 

 For more information, refer to the Employee Import chapter of the Expense – 
Import and Extract Specifications Guide. 
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Section 5:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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Administrative Help Opens to Administrative Setup & User Guides 

Overview  

With this release, the administrative Help commands for Expense, Invoice, and 
Travel Request now open a table listing the available administrator setup, user, and 
shared guides.  
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This change allows the administrator to draw on the most comprehensive and 
complete documentation available for the task at hand.  
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Section 6:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 14.0.1 

Support for Firefox versions 14.0.1 under both the Mac OS X and Microsoft Windows 
operating systems is certified for this release. 

Support for Google Chrome v. 20.0  

Support for Google Chrome version 20.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Chrome v 21.0 

Support for Chrome 21.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Firefox v. 15.0  

Support for Firefox versions 15.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 

Support for Safari 6.0 and Mac OS X 10.8 

Support for Safari 6.0 under Mac OS X version 10.8 will be included in an upcoming 
release. 

 

 



Concur Release Notes Page 27 Expense Professional / Premium 
September 2012 Concur Clients 

Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, September 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – September 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

120102-
000011 

Expense / Travel Allowance 

Netherlands Antilles remains within travel allowance rate feed - this has been 
reorganized into 3 separate countries. 

120124-
001246 

Expense / Search Function 

Action of the dropdown list is causing the search criteria to disappear - the 
value should remain as additional characters are typed. 

120502-
000699 

Expense / Administration Menu 

The system generates an error when the user attempts to access the 
Administration menu directly after logging in (but not after any other action, 
such as accessing another menu or moving to another page). 

120530-
000561 

Expense / Card Charges 

A charge is not matched to its Pending Card Transaction expense in an 
expense report when imported from the My Concur page. 

120604-
000722 

Expense / Proxy 

Proxy is not able to see the trip itinerary in the Smart Expense list. 

120625-
002136 

Expense / Credit Card 

Card details do not appear as expected when hovering over card icon. 

120710-
000481 

Expense / Email Notifications 

The customizable email From entry is changed, but that change is not 
reflected for all approvers notified about a pending report. 

120716-
001351 

Expense / Travel Allowance 

A travel allowance location of British Indian Ocean territories does not add the 
incidental rate to the per diem meal calculation. 

120717-
000007 

Expense / Forms & Fields 

Copy down action from Header to Entry is not correctly performed. 

120725-
000057 

Expense / Localization - German 

The Name on Account field is not localized for the German language. 

120725-
001840 

Expense / Copy Report 

Invalid characters are being allowed when naming the copied report using the 
Copy Report feature. 

120726-
000070 

Expense / Smart Expenses 

The incorrect currency is shown in the Smart Expense match confirmation 
dialog box from a travel reservation. 

120801-
001016 

Expense / Lodge Transactions 

Lodge transactions that have been assigned to an employee cannot be 
managed using options in Manage Transactions. 
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Case ID Case/Defect Description 

120802-
000033 

Expense / Itemizations 

Taxes are not being shown for Total Tax Posted and Total Tax Reclaimed 
fields. 

120803-
000196 

Expense / Travel Allowance 

Travel Allowance rates are incorrect for the their specified transaction dates. 

120806-
002010 

Expense / Training Page Display 

The client's logo is being cut off in the Training Page display format. 

120808-
000764 

Expense / Printed Reports 

The Employee ID and Employee Last Name fields are incorrectly displayed 
multiple times. 

120816-
000799 

Expense / Exchange Rates 

The application generates an error when the user attempts to change the 
exchange rates to divide and proceeds to itemize (example: 66 GBP x 
1.27410000 = 84.09 EU Divide = 51.80) 

120818-
000056 

Expense / Itemizations 

The system is not responding to the user when they click the Itemize button 
for a hotel expense. 
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Section 2:  Resolved Issues - Jobs 
Case ID Case/Defect Description 

120209-
000926 

Expense / Card Import 

An invalid date format is causing an arithmetic overflow error during import. 

120302-
000028 

120802-
001543 

Expense / Card - Length Check Logic 

A minimum of 6 characters to 24 is now enforced on card check - prior to this 
change the span was 14 - 24. 

120503-
001219 

Expense / Card Import 

The Item Description should be added to the has code calculation in order to 
add a distinguishing attribute and prevent false "Duplicate Transaction" for 
these purchasing detail transactions. 

120807-
000162 

Expense / MasterCard CDF 

AdjustmentReasonCode 0162 is now categorized as a Finance Charge instead 
of regular expense. 

120822-
001073 

Expense / MasterCard CDF 

The 6509 AdjustmentReasonCode value is added for JPMC. 

120824-
000764 

Expense / Card Import 

Bank of the West MasterCard Corporate Card CBCP - US Import not longer 
fails when the import is run. 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 
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With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, September 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – October 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 

Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 

Release Documentation > Release Notes to select and download additional 

product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 

The enhancements include: 

 Mileage Calculator Enhancements 

New updates allow users to avoid tolls, avoid highways, select from route 

options, and drag-and-drop routes when using the mileage calculator. 

 Track Balance Due the Company Forward to a Future Report 

Any amount an employee owes the company can now be applied to offset 

cash expenses included in a future report. There is an optional setting to 

enable this tracking of the amount due company feature per Policy. 

 Select and Change Multiple Custom Fields in a Single Action 

Custom fields shared across forms as a common Custom field can now be 

selected and changed to a different value in a single action. 

 Selected Car Expense Fields Now Available in Audit Rules 

The Business Distance, Personal Distance, Passenger Count, Round Trip 

Deduction, and Has Mileage Calculator fields are now available for 

configuration in Audit Rules. 

 Most Recently Used List for Expense Types 

A Most Recently User (MRU) function lets you choose your expense type from 

a list of those you have used in the recent past. 

 Approvers Can Filter Report Approvals 

The Approver can now use search filter options that let them find expense 

reports they have approved previously. 

 New Summary View Shows Subtotal for all Allocations in a Report 

A new Summary button lets a user open a window that displays a summary of 

subtotals for all allocation records across all expenses (including the system 

allocation records) in the expense report. 

 User Administrator can Maintain Vehicle Registration Information 

New options let user admins view cars, edit car registration information 

(including initial distance), and register new cars for the user. 

 Travel Allowance: 

 US Travel Allowance: Imported Air and Hotel Itinerary Logic  

A new option will create the itinerary in a manner optimized for US 

defense contractor companies following the US GSA rules. Specifically, 

hotel reservations will be used for itinerary rows in place of air 

reservations.  

 Add a Mapping for a Rate Record Via User Interface 

The View link that shows mapped locations and allows you to delete 

mappings is now updated to allow the user to add mappings. 

 Travel Allowance: Admin Can View and Edit Calculation Method 

Properties 

Selected administrators can now view the travel allowance calculation 

method properties and their values in the UI, and the Global admin can 

change these values in the user interface. 
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 Each of the features in this section is described in brief here, and in more 

detail in their respective sections within this document - if you need additional 

information please refer to these sections. 

Section 2:  Expense 

The following features are included in this service release. 

Expense Types: Most Recently Used (MRU) Pick List for User  

Overview  

Users creating an expense report can 

now choose from a list of their most 

recently used expense types. This 

feature lets the user quickly select an 

expense they've used in the recent 

past, or are using repetitively, speeding the overall report creation process. 

How It Works 

On first use after this service release, no expense types are listed, as none have yet 

been chosen. However, once the first expense type is selected for a report, that 

selection becomes the first expense type listed in the area directly above All 

Expense Types, as shown in the figure below: 

 

Each different expense type is added following its selection, and the system drops 

the "last used" to retain a total of five different expense types at any time. These 

expense types are based on the user's Policy, so the selection is also based on the 

Policy under which the report is being created. 

Business Purpose 

This enhancement speeds the report 

creation process by displaying a list of 
most used expense types. 
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Configuration 

No additional configuration is required to use this feature. 

Expense entry field labels are accessible via Expense Admin > Localization. Select 

the applicable language (including English) and then Modify for the category Column 

Labels. The fields are under the area CT_REPORT_ENTRY on the resulting list of 

fields. 

Select and Change Multiple Custom Fields in a Single Action 

Overview  

The multiple expense edit feature lets a 

user select multiple expense entries for 

a report and then edit the data for 

shared fields so that the same value 

appears for all. With this release, Custom field types are now included in the fields 

that can be edited across multiple selected entries.  

Configuration 

In the example below, several expenses are added, including three under Default 

(meals) and one under Entertainment. Selecting all four entries, the options are 

displayed to the right as shown in the figure below: 

 

Business Purpose 

This enhancement provides more 

speed of entry options for users. 
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Notes: 

 The field must be editable, and not hidden or read-only  

 The field label defined for Expense Entry Field is displayed, since multiple 

expense types may have different labels on the respective forms 

 Custom fields referencing different Lists are not displayed 

 Refer to the Multiple Expense Edit Fact Sheet for more information. 

Approvers Can Filter Report Approvals 

Overview  

Approvers can now use a new search 

function to filter previously approved 

expense reports they wish to review. 

This capability is similar to the 

Processor search function, allowing the 

user to enter criteria such as Report Name and Employee ID.  In addition, an 

additional view for All Reports You Approved has been added.  

How It Works 

The search function allows additional filtering of the view selected by the approver. 

The Approver works with the search function just as they do for other areas of 

Expense, selecting first the appropriate view and then optionally selecting and 

supplying the initial search criteria (Employee ID, etc.). 

The figure below shows a search for an employee with the last name Fletcher. Note 

that a maximum of 500 returned records is still enforced, so use of the new All 

Reports You Approved view will probably require additional search criteria to reduce 

the return list to a level where all can display. 

 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement provides the 

approver better tools for accessing 
past approvals. 
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Balance Due Tracking 

Overview  

A new option provides a tool for 

tracking balances due from employees 

to the company, and for collecting those 

funds against future reports. 

How It Works 

When activated, an expense report with a balance due to the company from the 

employee will generate an internal tracking record for that balance due to the 

company. A subsequent report with an amount due the employee from the company 

will automatically have this balance applied at the point in time that the processor 

approves the report for payment, netting out the amount due to the employee 

against the amount remaining that is due to the company from the prior report.  

If the outstanding amount due company is not fully utilized, the remaining balance 

continues to be tracked and applied to another future report. If a report with an 

applied balance tracking record is recalled, the balance tracking amount is removed 

from the report and may then subsequently be re-applied when that report is again 

approved by the processor. 

What the User Sees 

The employee will see a new row on the report totals page for a report with a 

balance due applied so that they can see why the cash due to the employee has 

been reduced. 

If for some reason the balance tracking record needs to be adjusted – perhaps the 

employee has paid the amount to the company – the cash advance administrator 

may record the amount paid against that balance and thus reduce the outstanding 

balance. (See September 2012 release notes for how to allow the cash advance 

administrator to record a return.) 

The information on the internal balance tracking record creation (issuance) can be 

included in the standard accounting extract by configuring it to include cash advance 

records. The data will appear in a record similar to a normal cash advance with three 

specific differences: 

 Report ID field will identify the report that generated the balance due to the 

company 

 Report Key will also identify that same report 

 Cash Advance Transaction Type will be 3 

Business Purpose 

This enhancement provides options for 
managing funds due from employees. 
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The following example demonstrates key fields in the accounting extract for a 

balance tracking record and a traditional cash advance issuance record, both for 

50.00: 
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The application of the balance tracking record will also impact the financial extract, 

and will show information about the source of the funds used to net against the 

amount due employee. This is always included, and is not controlled by the inclusion 

of cash advance records. 

The following example demonstrates the key information in the expense journal 

records when a cash advance or balance due record is utilized as payment for the 

amount due employee: 
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Configuration 

The balance due tracking feature may be enabled per policy, so that reports under 

that policy will generate a balance tracking record for application on any future 

report (regardless of policy). 
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Clients wishing to activate this option should first ensure that their financial systems 

receiving the data from Concur Expense are prepared for the new information. When 

they are ready to activate the tracking, submit a change request to Concur Support 

that identifies the policies for which to activate the balance due tracking. 

 To edit the policy: 

1. As the Expense Configuration administrator, click Administration > Expense 

Admin. 

2. Click Policies, then select a policy and click Modify. 

3. Select the Use Balance Carry Forward check box to enable the feature. 

 

4. Click Save. 

 Refer to Chapter 9: Standard Accounting Extract of Expense – Import and 

Extract Specifications, and the Expense: Policies Setup Guide for more 

information. 

New Summary View Shows Subtotal for all Allocations in a Report 

Overview  

A summary view of all allocations within 

an expense report can now be viewed 

using a new Summary button. This 

provides a view for the user (Approver, 

Processor, etc.) that lists all allocations 

for the expense report in subtotal format. 

Business Purpose 

This enhancement provides  of 

Allocation summary totals in a separate 
window. 
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Configuration 

No additional configuration is needed to use this feature. 

The summary function appears according to the user's Policy configuration. 

Specifically, depending on the choice made for the Allocation View Print Format 

option setting as shown in the figure below: 

 

The summary view function appears according to the value chosen: 

 None: The Summary button appears in the Allocations for Report 

window: 
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 Any Value: The Summary command is found under the View menu: 

 

In either configuration, clicking the Summary button or command causes the 

information to display for the user.  

 Refer to Expense: Allocations Setup Guide for more information. 

Fleet Data Now Added to Rich Data   

Overview  

Fleet Data is now added to the list of 

rich data available from various card 

transactions imported into Expense. 

Configuration 

No additional configuration is required to use this feature. 

 Refer to Rich Data Company Card Transactions as Receipts Fact Sheet for 

more information. 

Car Configuration: User Admin Can Manage Car Configurations 

Overview  

With this release the user administrator 

role can now view, edit, and register 

cars on behalf of a selected user. This 

includes the ability to: 

 View the car configuration(s) 

 Edit them, based on Access Rights values set in Form Fields 

 Edit initial distance directly to correct user errors 

 Register (add) a new car on the user's behalf based on a new setting in 

Expense Car form, where this ability can also be restricted 

Business Purpose 

This enhancement adds another data 

item to card transactions containing 
rich data. 

Business Purpose 

This enhancement provides flexibility in 
user management. 
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How It Works - User Admin 

This feature works by exposing the Personal Car and Company Car links to the 

Employee Administrator role through the User Administration page. The User 

Admin selects a user to manage and uses these links to open the identical car 

configuration page the user sees through their Profile access to car configuration.  

 

The User Admin is given permissions to work with car configurations for a user in the 

following ways: 

 New: A new permission in Expense Car form, Allow user administrator to add 

car, allows or restricts new car additions for the user: 

 

 By Car Type: The Expense Car form applies to either a Personal or Company 

Car, so user administration edit permissions are divided along these lines as 

well - configuration allows selective configuration by car form. 

 Edit/Read-Only: The Expense Car form fields can be modified for the 

Employee administrator role to prevent or allow modification of the selected 

field: 

 

When the user administrator opens the car registration page, the fields they see and 

the actions they take are based on the Forms and Fields configuration. 
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The ability to edit (fix) the initial distance will be allowed, as users often make errors 

in this field value. It is important to note that any edited value in this field will be 

used for new car expenses, but will not be used to recalculate paid expenses. 

Configuration 

To configure this feature the administrator: 

 Configures Expense Car form to enable or disable the admin's ability to add a 

car 

NOTE: For existing configurations, the admin will not be allowed to add new 

cars unless this setting is altered. 

 Sets the Admin's Access Rights settings for selected Expense Car form fields 

NOTE: For existing configurations, the admin will be allowed to edit the initial 

distance but not any other fields unless the field settings are altered. 

 Tests the configuration as the Employee administrator in User Administration 

 Refer to Expense: Forms and Fields Setup Guide and Expense: Car 

Configuration Setup Guide for more information. 

Car Configuration: Google Maps Mileage Calculator V. 3 Support 

Overview  

The version 3 map calculator 

functionality of Google Maps is now 

integrated into Expense for use when 

mapping personal and company car 

mileage.  

Business Purpose 

This enhancement incorporates the 

latest Google Maps technology in 

Expense. 
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This version includes the following new features: 

 Avoid Tolls and Highways: Select either check box to prevent the 

suggested route(s) from including tolls or travel on highways 

 Multiple Suggested Routes: More than one route is provided, giving the 

driver a choice  

 Drag and Drop Route: Grab a route and reposition it to generate an 

updated route 

 Better International Coverage: International travelers can draw on 

improved route presentation 

The updated interface is shown in the figure below, with Avoid check boxes, and 

display of multiple proposed routes: 

 

Configuration 

No additional configuration is required to use this feature. 

Audit Rules: New Fields Available in This Release 

Overview  

CAR-TYPE FIELDS 

The following Car-type expense fields 

are now available for configuration in 

workflow, tax, and audit rules as part of the Entry data object: 

 Business Distance 

 Personal Distance 

Business Purpose 

This enhancement adds additional 
flexibility to audit rules. 
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 Passenger Count 

 Round Trip Deduction 

 Has Mileage Calculator  

COMPANY CARD  

Administrators can now use the new Company Card Transaction Type field when 

building an audit rule using the Company Card object. This field is ideal for rules that 

should trigger based on card charges and fees the client would like analyzed by the 

system. 

This new field is made available by accessing Expense Admin > Audit Rules and 

selecting Company Card as the Data Object. In the figure below, the Credit Card 

Transaction Type Helper lets the administrator select the value that will trigger the 

audit rule: 

 

Configuration 

No additional configuration is needed to use this feature. 

 Refer to Expense: Audit Rules Setup Guide for more information. 

Accounting Admin: Receipt Status Field Available in Hierarchy 

Overview  

The Receipt Status field is now added as 

a hierarchy segment choice at the 

Report Entry level within Accounting 

Administration. This feature is designed 

for those clients who prefer that 

Business Purpose 

This enhancement brings additional 

flexibility to the Account Codes 
assignment function. 
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selected expense types where the user has supplied a tax receipt should generate an 

alternate account code for the ledger.  

Configuration 

The client should contact Concur Support to have this feature configured. 

 Refer to Expense: Account Codes Setup Guide for more information. 

Travel Allowance (US): Imported Air and Hotel Itinerary Logic Changed 

Overview  

A new choice will now create the 

itinerary in a manner optimized for US 

defense contractors companies 

following the US GSA rules.  

Specifically, hotel reservations will be 

used for itinerary rows in preference over air reservations.  

Examine the following travel reservation information: 

 

 Depart Time Arrive Time 

1 Seattle SEA Day 1   23:30 Chicago ORD Day 2   05:00 

2 Chicago ORD Day 2  06:30 Orlando MCO Day 2  09:00 

3 (Hotel)   Oak Ridge, FL Day 2  - 4 

4 Orlando MCO Day 4      

5 Orlando MCO Day 4   17:15 Detroit DTW Day 4  21:00 

6 Detroit DTW Day 4   21:40 Seattle SEA Day 4  23:30 

Upon import to the travel allowance feature this new option will take the initial 

departure location and final trip end location from the air reservation. All other 

information on the resulting travel allowance will be based on the hotel locations.  

The resulting travel allowance itinerary will contain the following rows: 

 

Depart Time Arrive Time 

Seattle Day 1   23:30 Oak Ridge Day 2  10:00 

Oak Ridge Day 4   14:00 Seattle  Day 4  23:30 

Business Purpose  

This enhancement aids US defense 

contractors by optimizing the 
information to their needs.  
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Configuration 

Disable the Create itinerary rows based on air setting within the travel allowance 

configuration to enable this behavior. To do this, click Administration > Expense 

Admin > Travel Allowance > Configuration tab, then open the configuration and clear 

the setting. The setting is shown below with the tooltip for clarity: 

 

NOTE: This option is available for use with any travel allowance configuration even 

though it is optimized for the US model. 

 Refer to Travel Allowance Configuration Guide – US / GSA for more 

information. 

Travel Allowance (US): New Module Property Sets Rate Location 

Overview  

A new module property, Use arrival 

location for in transit days, sets how the 

rate location is determined when a user 

is in transit at the end of the day (the 

midnight boundary) for the US GSA travel allowance module. 

The property functions based on the setting: 

 No (default): The departure location is used to set the rate location 

 Yes: The arrival location is used to set the rate location 

Configuration 

The new Travel Allowance Administration tool allows the administrator to view and 

modify calculation properties. The ability to edit may depend on role permissions for 

the Expense Configuration administrator. Consult your Expense representative for 

more information about configuring this property. 

 Refer to this document for information about the new administrative tool, and 

the Travel Allowance Configuration Guide – US / GSA for more information. 

Business Purpose  

This enhancement provides additional 
flexibility when setting rate locations. 
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Travel Allowance Administration: Add a Mapping for a Rate Record Via 

User Interface 

Overview  

A new Add Location Map link lets the 

administrator add location mappings 

using options in the user interface. 

Previously this could only be done via 

import. The button is located on the main page for a rate that has no existing 

locations mapped to it: 

 

It is located on the View Locations dialog for rates that do have existing locations 

mapped: 

 

Configuration 

The ability to access this feature may depend on role permissions for the Expense 

Configuration administrator.  

 Refer to Expense: Travel Allowance Setup Guide for more information. 

Business Purpose  

This enhancement makes the task 
easier to do. 
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Travel Allowance Administration: Admin Can View and Edit Calculation 
Method Properties 

Overview  

The Global Expense Configuration 

administrator can now view and edit 

Travel Allowance calculation method 

properties and their values in the user 

interface. This is done using the new Calculation Properties tab of Travel 

Allowance. 

 

Configuration 

The new Travel Allowance Administration tool allows the administrator to view and 

modify calculation properties. The ability to edit may depend on role permissions for 

the Expense Configuration administrator. Global Expense administrators may view 

this information; however, the unrestricted role is necessary to edit the values. 

 Refer to Expense: Travel Allowance Setup Guide for more information. 

Travel Allowance Administration: Troubleshooting Itinerary Issues 

A new option allows the expense administrator to view travel allowance itineraries 

and expenses for a specific user and date, providing a valuable troubleshooting tool 

for locked itinerary issues. 

Business Purpose  

This enhancement provides visibility to 
the settings. 
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Section 3:  Expense Pay 

The following features are included in this service release. 

Payment Manager: Selected Payment Manager Screens are Now 
Enhanced 

Overview  

Before, when the user wanted to get 

specific report summaries or audit trail 

details, he/she needed to go to the 

Processor and enter the Report ID. 

Now, the Payment Manager is 

enhanced to provide multiple ways to access and view this information other than 

using the Processor. The following describes how a user can access and view the 

information via the View Funding, View Batches, and List Payees pages. On 

these pages, you can click on the following links to get the following information. 

When you click on the: 

 Report Name column, you get a report summary 

 Report ID column, you get a report audit trail 

 Payment Demand ID, you get the identification number of the payment 

demand 

For more information about what each screen looks like, refer to How Each Screen 

Displays. 

 To view the Funding Detail information: 

1. On the Payment Manager > Monitor Batches, click View Funding. 

 

2. Click Report Name, Report ID, and/or Payment Demand ID for the 

desired information. 

Business Purpose 

This enhancement provides easier 

access to report summaries and 

detailed audit and payment demand 
information. 
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 To view the Batch Detail information: 

1. On the Payment Manager > Monitor Batches, click View Batches. 

 

2. Click Count. The following page opens. 

 

3. Click Report Name, Report ID, and/or Payment Demand ID for the 

desired information. 

NOTE: Before, on this page, if you wanted to access the Payment Demand ID 

information, you clicked on the Audit Trail link. Now, the Audit Trail link is 

renamed to Payment Demand ID. When you click the Payment Demand ID link, 

you now get the same payment demand information you had gotten when you 

clicked on the Audit Trail link. 

 To view the Report Payees List information: 

1. On the Payment Manager > Monitor Payees, click Report Payees. 
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2. Click Report Name, Report ID, and/or Payment Demand ID for the 

desired information. 

How Each Screen Displays 

The following shows what information displays when you click on a specific link.  

 When you click the Report Name link, the Expense Report Summary screen 

displays: 

 

 When you click the Payment Demand ID link, the Payment Demand audit 

trail screen displays: 
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 When you click the Report ID link, the Audit trail on the Report and Entry 

Levels screen displays: 

 

 For more information, refer to the Expense Pay User Guide for 

Professional/Premium. 

Configuration 

No additional configuration is required to use this feature. 

Payment Manager: Change Text on Funding Page 

Overview  

Before, on the Configure Batches > 

Funding Accounts page, the text 

located under the Primary and 

Secondary contact fields read as 

follows: 

Enter the contact that can resolve funding issues 

Now the text reads: 

Enter the treasury contact who can wire funds to Concur if the Expense Pay 

funding transaction fails. 

Business Purpose 

This enhancement changes text about 
contacts to be more informational. 
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Configuration 

No additional configuration is required to use this feature. 

Pre-fund Email Notification is Now Being Sent Out  

Overview  

An email will now be sent to advise 

clients of their available balance for 

reimbursing expense claim filers and 

whether they must send additional 

funds into their pre-fund bank account 

to fund their payments. This notification is for Expense Pay Mexico clients and for 

Expense Pay UK clients who are using the pre-fund funding capability. 

The pre-fund email notification identifies the Expense Pay bank account by name, 

currency and masked number. 

When the email is generated, the notification shows the available balance in the bank 

account, the total amount of pending payments, and the total funding required, 

which would be the pending payments minus the available balance. 

The email is delivered before business hours in the local time zone, allowing the 

clients to fund their bank account in a timely manner. 

 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement notifies a client 

about the status of a pre-fund account.  
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Expense Pay EMEA - UK: New Funding Bank for the United Kingdom is 

Now Added  

Overview  

The Expense Pay UK funding bank 

support has been expanded to include 

the following banks: 

 ING Bank 

This bank now appears on the Funding Account page, in the Bank Name list. 

Configuration 

No additional configuration is required to use this feature. 

Expense Pay Card Program Support Expanded 

Expense Pay NA: Diners MasterCard CA now supports negative payments (the 

processing of credits). 

 

Business Purpose 

This enhancement expands funding 

bank support in the United Kingdom. 
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Section 4:  Jobs 

The following features are included in this service release. 

Import Authorization Request and Travel Request Roles and Default 
Approvers  

Overview  

With this release, a new site setting 

directs the system on how to import 

employee data for the AR and TR roles 

and default approvers. To do this, the 

setting uses the existing approver role 

in the Employee ID of the Travel Request Approver field to determine 

assignment. 

How It Works 

To change the import functionality a new entity setting Set AR and TR Approver 

based on the approver roles is enabled (set to Yes). The behavior is as follows for 

this setting: 

 No (default): The import will use the existing logic 

 Yes: The import references the roles of the Approver specified in the 

Employee Import 300-level Employee ID of the Travel Request Approver 

field as follows: 

 If Travel Manager role: The user is assigned this approver for 

authorization requests 

 If Request Manager role: The user is assigned this approver for Travel 

requests 

 If both roles: The user is assigned this approver for both authorization 

requests and Travel requests 

Configuration 

The client does not need to do anything if they prefer the current logic, which is the 

default functionality. If the client wishes to use the new logic (explained above), they 

should submit a Service Request to Support to have the Set AR and TR Approver 

based on the approver roles setting enabled (set to Yes).  

 

Business Purpose 

This enhancement makes it easier to 

assign approvers for your AR and TR 

users. 



Concur Release Notes Page 29 Expense Professional / Premium 

October 2012 Concur Clients 

Section 5:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 

new document summarizing Concur's 

monthly feature set. This new 

document, the Client Admin Release 

Summary, is an abbreviated list with 

short descriptions of each feature. By reviewing this document the client can quickly 

determine what features to further investigate. This information has been available 

for Expense for some time and has now been expanded to other areas. 

 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

 Using the Expense Admin Help: Clicking Help > Expense Administration 

Help opens the help system - use the upper-left link to open the summary 

doc: 

Business Purpose 

This enhancement provides a quick 

overview of the key changes, reducing 
the time it takes to review. 
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(Other administration help modules have similar links.) 

 

 Concur Client Central: Log in, then proceed to Resources > Release Docs > 

Client Admin Release Summary 
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Section 6:  Supported Configurations 

The following configurations are either supported or no longer supported with this 

service release.  

Certifications for This Release 

Support for Firefox v. 15.0.0 

Support for Firefox versions 15.0.0 under both the Mac OS X and Microsoft Windows 

operating systems is certified for this release. 

Support for Google Chrome v. 21.0  

Support for Google Chrome version 21.0 under both the Mac OS X and Microsoft 

Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 

included in an upcoming release. 

Support for Chrome v 22.0 

Support for Chrome 22.0 under both the Mac OS X and Microsoft Windows operating 

systems will be included in an upcoming release. 

Support for Firefox v. 16.0  

Support for Firefox versions 15.0 under both the Mac OS X and Microsoft Windows 

operating systems will be included in an upcoming release. 

Support for Safari 6.0 with Mac OS X 10.8 

Support for Safari 6.0 under Mac OS X version 10.8 will be included in an upcoming 

release. 
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Certifications for This Release 

Support for Firefox v. 14.0.1 

Support for Firefox versions 14.0.1 under both the Mac OS X and Microsoft Windows 

operating systems is certified for this release. 

Support for Google Chrome v. 20.0  

Support for Google Chrome version 20.0 under both the Mac OS X and Microsoft 

Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 

included in an upcoming release. 

Support for Chrome v 21.0 

Support for Chrome 21.0 under both the Mac OS X and Microsoft Windows operating 

systems will be included in an upcoming release. 

Support for Firefox v. 15.0  

Support for Firefox versions 15.0 under both the Mac OS X and Microsoft Windows 

operating systems will be included in an upcoming release. 

Support for Safari 6.0 and Mac OS X 10.8 

Support for Safari 6.0 under Mac OS X version 10.8 will be included in an upcoming 

release. 
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Legal Notice 

Information contained in this document applies to the following products in effect at 

the time of this document's publication: 

 

Travel & Expense, October 2012 

 

The above product(s) and information contained in this document are subject to 

change without notice. Accordingly, Concur Technologies, Inc. disclaims any 

warranties, express or implied, with respect to the information contained in this 

document, and assumes no liability for damages incurred directly or indirectly from 

any error, omission, or discrepancy between the above product(s) and the 

information contained in this document.  

 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 

reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 

product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 

18400 NE Union Hill Road 

Redmond, Washington  98052 

 



Concur Release Notes Page 1 Resolved and Known Issues Case List 
October 2012 Concur Clients 

Concur Release Notes 

Resolved and Known Issues Case List 

Month Includes Audience 

October 2012 
Case fixes for Expense Premier 
and Professional, Imaging, 
Expense Pay, Jobs, and HMC 

Concur Clients 

Contents 

Release Notes – October 2012 .....................................................................................2 
Finding Additional Product Release Notes..................................................................... 2 

Section 1: Resolved Issues - Expense .........................................................................3 

Section 2: Resolved Issues - Jobs ...............................................................................5 

Section 3: Documentation Updates..............................................................................6 
New Client Admin Release Summary Document............................................................ 6 
Release Notes Now Available in Product-Specific Documents .......................................... 7 

 



Concur Release Notes Page 2 Resolved and Known Issues Case List 
October 2012 Concur Clients 

Release Notes – October 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

120221-
001382 

Expense / Travel Allowance: 
The Per Diem for fixed meals is incorrect. 

120624-
000031 

120913-
000817 

Expense / Forms & Fields 
The system is not updating more than two fields at a time when using the 
multiple edit feature for forms and fields. 

120702-
000010 

120823-
001719 

120724-
000623 

Expense / User Administration: 
Users with the Employee Maintenance role cannot access user's profiles. 

120705-
001132 

Expense / Delegates: 
"You are administering for: Guest Traveler" continues to appear at the top of 
the page when working in the Expense tab after a users has logged in as a 
travel administrator for Guest Traveler. 

120718-
000195 

Expense / Itinerary Import: 
Enhance tooltip to explain why unmatched trip expenses are imported as a 
zero amount and not the estimated amount.  

120725-
000515 

Expense / JPT: 
tax field disappears (and other fields render incorrectly) after adding routes to 
Japan Public Transportation entry. 

120730-
000307 

Expense / AREA: 
A limit of 60 records is being incorrectly enforced by the system when 
importing credit card charges into an expense report. 

120808-
000552 

Expense / Quick Expense: 
A cell in the Quick Expense grid, when clicked, may cause all other cells to 
lose focus under Internet Explorer v 8.0 and v 9.0. 

120817-
000041 

Expense / Authorization Request: 
Russian employees are incorrectly getting a red Exception flag when 
attempting to submit an authorization request. 

120823-
000975 

Expense / Allocations: 
An Approver can use the Favorites button to add allocations, overriding the 
logic of Read-Only access at the form field level. 

120905-
000834 

Expense / Expense Types (Train): 
A Train expense type can cause the system to randomly ask for a Save action, 
even when nothing has been changed. 

120905-
001212 

Expense / Allocations: 
Nulling the fields on an expense report header does not result in a null 
condition for values in the allocations. 

120906-
000465 

Expense / Printed Reports: 
User cannot add a picture to the printed report. 
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Case ID Case/Defect Description 

120912-
000883 

Expense / Quick Expense: 
The Quick Expense grid is not accepting a comma as a decimal separator as it 
should. 

120917-
000075 

Expense / Expense Totals: 
On the Active Report and Reports Pending Approval pages both the Total and 
the Requested Amount are the same. This is not the case as when you click 
into the report -  the Total Amount and the Total Requested Amount is a true 
reflection of the report. 

120917-
001094 

Expense / Expense Pay: 
The employee banking information cannot be modified even when the 
Expense Pay type is set to Employee Banking only. 

120918-
000622 

120921-
000714 

120925-
001664 

Expense / Imports: 
The Travel Manager field is not being updated as expected by the 350 
Employee Import record. 

120918-
001973 

Expense / Approver: 
The Approve button needs to be placed into its old position - it has moved in 
the user interface. 

121001-
001222 

Expense / Localization: 
Check in and expose updated selections of the Polish language after review by 
Polish internal staff members. 

121002-
001861 

Expense / Expense Types: 
The Show on Mobile device option for an expense type cannot be cleared 
(unchecked and disabled) under Expense Admin > Expense Types. 
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Section 2:  Resolved Issues - Jobs 
Case ID Case/Defect Description 

120113-
000498 

Expense / Company Card: 
Include emp_key in card transaction audit when an employee deletes a card 
transaction. 

120815-
000576 

Expense / Audit Rules: 
Exposed Card Transaction Type in audit rules. 

120902-
000072 

Expense / Company Card: 
Read Travel Agency Invoice Number from the core financial transaction in the 
VISA VCF 4.0. 

120923-
000082 

Expense / Company Card: 

Provide the ability to set both Authorization Request and Travel Request roles 
and default approvers via employee import. 
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Section 3:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 
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With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, October 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – November 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release: 

• User May Choose None as Travel Request Link at Expense Entry Level 
The user adding a new expense entry to a report associated with a travel or 
authorization request can now choose None to not link that expense to the 
corresponding request entry. 

• Select Multiple Expenses and Change Them All At One Time 
A user may now open their report, select multiple expense entries, and use 
options in the Edit Multiple Fields dialog box to choose a different expense 
type(s) for all of the entries they have selected.  

• Delegate Notify Employee Enhancements  
The Notify Employee function used by delegates to "preview" a report and 
notify the employee the report is ready now includes new functionality for this 
release. 

• Notification: Authorization Request Administrator Retired in Classic 
The Authorization Request Administrator tool is now retired from the Classic 
interface, and is available in the Current interface. 

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 2:  Expense 

The following features are included in this service release. 

Change the Expense Type for Multiple Selected Entries   

Overview  

NOTE: This feature is complementary to 
the Custom field multiple edit feature 
described in October's release notes. 

The user can now decide to change the 
expense type for several expense entries within a report all at one time. This feature 
is useful whenever any two or more entries must be changed to the same expense 
type, for example when card transactions imported as Undefined must be set to a 
single expense type. 

How It Works 

The user first opens the report, then selects two or more expense entries. Expense 
displays a set of options from which an action may be taken. The user selects Edit: 

 

The Edit Multiple Fields dialog box appears. Under Expense Type, the user selects 
the expense type to apply to all selected expense entries. In the figure below, the 
Undefined card entries are adjusted to the Meals' Dinner expense type: 

 

Business Purpose 

This enhancement speeds the entry of 
data so users can avoid repetitive 
tasks. 
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System Checks and Changes When Changing the Expense Type 

Expense analyzes the new expense type, and then may add or remove fields from 
this dialog box depending on the form definition. Some fields may be pre-filled with 
information from the copy down configuration. Where Custom fields for all of the 
selected expenses have the same value, that value will be pre-filled on the dialog 
field. When the user clicks Save, Required field checks are performed, and Expense 
saves the change. Audit Rules, validations, and tax calculations are also updated as 
applicable to the new expense types.  

Configuration 

No additional configuration is required to use this feature. 

 Refer to the Multiple Expense Edit Fact Sheet for more information. 

Delegate Enhancements When Previewing a Report for Employee 

Overview  

Several enhancements are now added 
for the delegate with Can Prepare (only) 
rights.  

They are: 

• The addition of a new icon ( ) that appears next to any report reviewed by 
the delegate who has used the Notify button to alert their delegator that the 
report has been reviewed. This icon is visible to all users who may view this 
queue, both delegates and the employee. 

 

• The ability to reverse the notification for a selected report using the new 
Mark as Not Complete button, which removes the "reviewed" icon ( ) from 
the report row so the employee knows the report has not been completed by 
the delegate. 

 

Business Purpose 

This enhancement provides visual cues 
that a report is ready for review. 
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NOTE: If the delegate marks the report as not reviewed, the icon is removed 
from the report in the employee's report queue. It does not, however, 
recall the email notification to the employee nor does it send an 
updated email to the employee. 

• The addition of an audit trail entry whenever the delegate clicks the Notify 
button to alert their delegator that the report has been reviewed. 

 

Configuration 

No additional configuration is required to use this feature, it is available to any 
delegate granted Can Prepare but not Can Submit authority by the employee. 

 

 Refer to Shared: Delegate Configuration Setup Guide for more information.  

New None Option Available When Linking Expenses to Travel Request 

Overview  

The user adding a new expense entry to 
a report associated with a travel or 
authorization request can now choose 
None to not link that expense to the 
corresponding request entry. This frees 

Business Purpose 

This enhancement provides flexibility 
when linking expense entries to a 
travel or authorization request. 
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the user to include expenses for multiple purposes on the report, and not just those 
applying to the pre-approved trip or charges. Prior to this change the user was not 
able to decline a match made by the system. 

How It Works 

In the figure below, the user is adding Seminar Fees as an expense entry to their 
opened report. The Request field offers two Seminar-type unmatched travel request 
entries that the system detects as possible matches.  

 

The user instead chooses None as a value, bypassing the existing request matches 
and adding the expense entry to their report without any tie to a request. 

Behavior Change to Auto-Matching a Single Linked Request 

For an expense with only one possible match in the linked request, the field was not 
displayed in the past. Now it will still be automatically matched to the request entry, 
but also visible so the user will have the option to unlink by selecting None. 

Configuration 

No additional configuration is required to use this feature. 
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Central Reconciliation: Support for Lodge Transactions Using Concur's 
Enhanced Feed 

Overview  

Clients may now process their Lodge 
Card transactions through the Central 
Reconciliation feature using the Concur 
Enhanced feed format. Prior to this 
change, the Central Reconciliation 
feature was only compliant with a 
selected set of specific Lodge card feeds. Now, the restriction of a proprietary 3rd-
party feed no longer prevents the user from processing the transactions through 
Central Reconciliation.  

Configuration 

The client will work with Concur to create and process the correct feed format for 
their card transactions. 

 Refer to Expense: Central Reconciliation Setup Guide for more information 

Authorization Request Administrator Now Retired From Classic UI 

Overview  

The Authorization Request 
Administrator tool is now retired from 
the Classic Expense interface. It is 
available in the Current user interface 
when working with requests ready for 
processing. 

 Refer to Expense: Authorization Requests Setup Guide for more information. 

Date, Time, and IP/Region Appears at Login 

Overview 

Starting with the November release, 
users will see the date and time of their 
last login to Concur. 

Business Purpose 

This enhancement moves another tool 
from the Classic to the Current 
interface. 

Business Purpose 

This enhancement gives the client 
another way to work with their 
transactions without the restrictions of 
a proprietary bank feed format. 

Business Purpose 

This enhancement provides additional 
security by displaying login data to the 
user. 
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Each user should review this information to ensure that it matches their actual last 
login. If not, it might be an indication that someone else has accessed the user's 
Concur account. If the date and time seems suspicious, the user should 
immediately: 

• Change his/her Concur password – and – 

• Notify the user's company security department or help desk 

The date and time message is visible for a short time. Once the user navigates away 
from the initial page, the message disappears.  

The user can click History to see additional information. The IP address and the 
location shown on the Login History page are based on the service providing 
internet access and may be different from the user’s actual location. The user 
should verify this information with his/her company. 
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Configuration 

This feature is automatically on for all users and cannot be turned off. 
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Section 3:  Expense Pay 

The following features are included in this service release. 

Funding Accounts and Bank Information: Denmark is Now Added to 
Expense Pay Euro Payments 

Overview  

Expense Pay Euro has been expanded 
to include Denmark. This allows clients 
to make Euro payments in Denmark, 
and also fund their euro payments from 
a euro-denominated funding bank 
account held at a bank in Denmark. 

Configuration 

No additional configuration is required to use this feature. 

View Funding - Switzerland: SWIFT/BIC Field is No Longer Required for 
Swiss Franc Payments 

Overview  

With this release, on the Funding 
Account and Bank Information pages 
for Switzerland, the user only has to 
enter and re-enter IBAN. The 
SWIFT/BIC field has been removed 
these pages for CHF payments. It is still a required field for euro payments in 
Switzerland. 

Configuration 

No additional configuration is required to use this feature. 

View Funding: Pre-fund Screen Displays Test and Inactive Accounts 

Overview  

With this release, on the Monitor 
Batches  > View Funding page of the 
Payment Manager, the test and/or 
inactive accounts now display on the 

Business Purpose 

The enhancement changes the View 
Funding and Bank Information pages 
for Switzerland. 

Business Purpose 

The enhancement updates the Pre-fund 
screen display. 

Business Purpose 

This enhancement expands the 
supported list of countries for Euro 
payments.  
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Mexico and UK Pre-fund tab when you select the Show Test Accounts and/or 
Show Inactive Accounts check boxes. 

 

Configuration 

No additional configuration is required to use this feature. 

Payment Manager: Currency and On Hold Columns are Now Added 

Overview  

With this release, on the Configure 
Batches > Funding Accounts page of 
the Payment Manager, Currency and 
On Hold columns have been added. 
 

 

Configuration 

No additional configuration is required to use this feature. 

Funding Account: Confirmation Batches are Now Displayed 

Overview  

With this release, on the Monitor 
Batches > View Batches page of the 
Payment Manager, the  confirmation 
batches now properly display in the 
Type column. You must select 

Business Purpose 

The enhancement updates the Monitor 
Batches capability. 

Business Purpose 

The enhancement improves the 
functionality on the Funding Accounts 
page. 
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Advanced Search to view and access the Type column. Prior to this change, when 
the user attempted to view  confirmations in the Type column, those confirmations 
did not display. 

 

Configuration 

No additional configuration is required to use this feature. 
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Section 4:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. This information has been available 
for Expense for some time and has now been expanded to other areas. 

 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 
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(Other administration help modules have similar links.) 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 
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Section 5:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 15.0.0 

Support for Firefox versions 15.0.0 under both the Mac OS X and Microsoft Windows 
operating systems is certified for this release. 

Support for Google Chrome v. 21.0  

Support for Google Chrome version 21.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Chrome v 23.0 

Support for Chrome 23.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Firefox v. 16.0  

Support for Firefox versions 15.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 

Support for Safari 6.0 with Mac OS X 10.8 

Support for Safari 6.0 under Mac OS X version 10.8 will be included in an upcoming 
release.
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Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, November 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – November 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

120611-
000698 

Expense / Forms & Fields: 
When updating a child entry to an expense type with different form fields than 
the prior expense type, the different fields will not receive the values from the 
parent-level as they should if they are configured to copy down with an 
"Itemization Field Source" of "Parent Expense". 

120613-
001350 

Expense / Workflow: 
Report is not going to the defined approver for the hierarchy node and is 
instead going to that approver's default approver after resolving up the 
hierarchy to the Global node. 

120917-
002084 

Expense / Printed Reports: 
The employee field State/Province appears with the values for country sub 
code instead of expected State and Province name. 

120918-
000498 

Expense / Localization: Russian: 
The Russian language checkins required to finalize the Password screen are 
now incorporated into the system. 

120919-
000995 

Expense / VAT: 
Selected customer databases include entries that do not have VAT entries in 
their Tax tables. 

120919-
001370 

Expense / Receipt Imaging: 
The size of a receipt image in the window that displays when the Approver 
hovers over the receipt icon for a report is too small, causing the user to have 
to increase the size of the window. 

120921-
000747 

Expense / Localization: 
Attempting to localize a form field results in the browser becoming 
unresponsive. 

120923-
000120 

Expense / Travel Allowance: 
Changing an expense type to that which requires the display and selection of 
the Travel Allowance check box results in the check box being incorrectly 
cleared (disabled). 

120923-
000142 

Expense / Localization: 
List Field with List Helper can only handle ASCII Letters and cannot handle 
any other letters such as Japanese Hiragna and CJK Ideograph Characters at 
all. 

120925-
000108 

Expense / Currencies: 
Amounts in Vietnamese Dong appear with a decimal (.00) on the My Concur 
Tab. Amounts appear without the decimal everywhere else as expected. On 
the individual report, when listed in users or approvers queue, and in process 
reports. 

121002-
001288 

Expense / Workflow: 
The report stops at the step it should have skipped per the workflow rules and 
no errors are logged or displayed. 

121010-
000493 

Expense / Cash Administrator: 
The Cash Admin cannot add comments after clicking Record Return Amount. 

http://jira.concur.com/jira/browse/MAN-17820
http://jira.concur.com/jira/browse/MAN-17820
http://jira.concur.com/jira/browse/MAN-17820
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Case ID Case/Defect Description 

121010-
001672 

Expense / Travel Allowance: 
The "Rate of Last Resort" (All Other Destinations) used when no other rate is 
applicable does not appear for selection in the user interface. 

121011-
001371 

Expense / List Management: 
Modifying Item Name and Item Code in List Management results in changes 
that are not saved and the warning message Timeout expired. The timeout 
period elapsed prior to completion of the operation or the server is not 
responding. 

121012-
001342 

Expense / Itineraries: 
Hovering over an itinerary in an expense report results in an application error. 

121015-
000722 

Expense / Email Notification: 
Email addresses are erased when configuring a workflow rule using the Send 
Email action, making it impossible to save this action in the rule. 

121019-
000865 

Expense / Attendees: 
An itemization with attendees added displays the Required Field: Attendees 
error message even though the user is listed as an attendee. Resolution 
requires re-saving the report. 

121022-
001907 

Expense / Credit Card: 
The Credit Card Transaction window persists in appearing at the bottom of the 
browser window, forcing the user to have to reposition the window to see the 
entire contents. 

121023-
000452 
121024-
001354 
121022-
000959 
121025-
000464 

Expense / Allocation Favorites: 
When clicked, the favorite allocation is not appearing on the expense report as 
expected. 

121023-
000811 
121022-
000365 

Expense / Test User: 
A Test environment is incorrectly sending out email notifications - these 
should not be sent out of this entity type. 

121023-
001249 

Expense / Multiple Expense Edit: 
The user is unable to select from connected list fields when editing multiple 
expenses. 
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Section 2:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 

 



Concur Release Notes Page 8 Resolved and Known Issues Case List 
November 2012 Concur Clients 

With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 

 



Concur Release Notes Page 9 Resolved and Known Issues Case List 
November 2012 Concur Clients 

Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, October 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2012 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – December 2012 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Enhancements From Client Suggestions Forum 

The following features were submitted using Concur's Suggestion service, available 
via Concur's forums. They are now included in this service release: 

• Set a Default Payment Type for Your Expense 
Expense can now be configured to automatically preset the payment type for 
a user when manually adding an expense to their expense report. This feature 
allows the client to minimize errors when their employees forget to adjust the 
payment type during report creation, and suggest a standard payment type 
across all manually-entered expenses.  

 Each of the features in this section is described in brief here, and in more 
detail in their respective sections within this document - if you need additional 
information please refer to these sections. 
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Section 2:  Expense 

The following features are included in this service release. 

Set a Default Payment Type for Manually-Created Expenses   

Overview  

With this release, the Expense 
Configuration administrator can 
configure the system to pre-select the 
preferred Payment Type value for users 
when they manually create their 
expenses. This optional step in Group Configurations for payment types lets the 
admin decide to set a default value for payment type. If no default is configured, the 
system will continue the current behavior of selecting the first option (in alphabetical 
order). In either model, the user may always choose any type from the list. 

Setting a default payment type is useful whenever you want to direct your 
employees to use a preferred payment type for their manually-created expenses, or 
when you wish to reduce errors when the user makes no change for Payment Type. 

What the User Sees 

The user will note the new behavior only when the administrator selects a default 
payment type - they will see the current behavior (first alphabetical choice) if they 
have not selected any check box for a payment type in Group Configurations.  

With a preferred payment type selected, the user prepares their expense report and, 
when creating an expense, sees this payment type as the default value in the 
Payment Type field (Company Paid in the figure below). Without selecting a 
different value, the expense is completed and the default payment type is saved.  

 

The user can elect to change the value - the system will not prevent them from 
choosing any other available payment type activated for their group.  

Business Purpose 

This enhancement guides the user to 
the preferred payment type, 
preventing errors. 
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Configuration 

This feature is configured using the procedure below. 

1. As the Expense Configuration administrator, click Administration > 
Expense Admin > Group Configurations. 

2. On the Expense tab, select a group, then click Modify under Payment 
Types. 

 

3. In the Configuration for Group dialog box, select the preferred, active 
payment type under Default Payment Type. 
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Only one payment type may be selected, and by selecting any you clear the 
prior choice. A choice of no selections at all is also supported. 

NOTE: The payment type must be active to also be set as the default - you 
may take both actions at this time. 

4. Click Save. 

 Refer to the Expense: Payment Types Setup Guide for more information. 

Travel Allowance: Set Selected Meals to Default to Provided Status   

Overview  

The administrator can now elect to set 
the Meals expense types of Lunch and 
Dinner to a default status of Provided. 
This feature is designed for clients who 
wish to force their employees to 
manually indicate meals allowances they wish reimbursed. By forcing manual 
adjustment to gain the allowance, the system is also prevented from automatically 
granting this allowance, possibly in error, on behalf of the user. 

Why Use This Feature? 

In practice – and when using an allowance calculation method where time-based 
adjustments are not automatically made for partial days of travel -  a user might 
erroneously include a meals allowance for a First, Last, or other partial day where 
allowance rules do not allow reimbursement of that meal. By pre-setting the 
Provided status for Lunch or Dinner, the allowance amount is reduced to zero, and 
the employee seeking recompense is required to review their travel dates and adjust 
the daily allowance accordingly. This changes the user viewpoint from excluding 
meals that are not eligible to including meals that are appropriate for 
reimbursement. 

NOTE: This approach is not suitable for travel allowance methods that adjust the 
allowance for partial days of travel.  It is suitable for methods that do not the 
allowance, such as Generic Standard. 

What the User Sees 

When the feature is enabled, the user sees that the Breakfast Provided, Lunch 
Provided, and Dinner Provided check boxes for a given day of travel are selected 
by default, indicating that the employee will not be reimbursed for these meals.  

Business Purpose 

This enhancement reduces errors in 
using the Lunch and Dinner Meals 
expense types under Travel Allowance. 
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The employee must now manually clear the check boxes to adjust the final totals and 
claim the meals as per company rules for travel. In the figure below, the employee 
clears the Dinner Provided check box for the first day of travel, and clears the 
Breakfast Provided and Lunch Provided check boxes for on the second day to 
adjust the total under Allowance. 

 

Special handling for Breakfast 

If, in the configuration, only breakfast is defaulted to provided, then breakfast is 
assumed to not be provided for a traveler on their first day of travel. However, 
where all meals – Breakfast, Lunch and Dinner - are set to Provided, then there is no 
special handling for breakfast on the first day of the trip and all meals on all days will 
default to provided. 

Configuration 

Meals are not set to a Provided status by default - the administrator must select 
these options to enable the feature. Use the procedure below to configure these 
options. 

1. As the Expense Configuration administrator, click Administration > 
Expense Admin > Travel Allowance. 

2. On the Configurations tab, select a travel allowance row, then click Modify. 

3. Scroll down to Meals Options, then select any of the following options: 

♦ Default Breakfast to Provided: Select this check box to set the 
Breakfast portion of the allowance as provided, and not included in the 
day’s allowance. 

♦ Default Lunch to Provided: Select this check box to set the Lunch 
portion of the allowance as provided, and not included in the day’s 
allowance. 
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♦ Default Dinner to Provided: Select this check box to set the Dinner 
portion of the allowance as provided, and not included in the day’s 
allowance. 

 

4. Click Save. 

 Refer to the Expense: Travel Allowance Setup Guide for more information. 

Complex Distance Tax Calculation Method Now Available for VAT   

Overview  

A new tax calculation method, Complex 
Distance, is now available for calculating 
value-added tax for business 
mileage/kilometer reimbursement. This 
feature allows the system to now calculate the potential VAT on a per distance unit 
basis for variable reimbursement amounts. This allows calculation of the right 
amount based on the lower of the tax authority fuel advisory rate (stored as Distance 
Rate) and the client reimbursable rate. 

How The Rate is Calculated 

This calculation is based on the Distance Rate (e.g. UK’s HMRC Advisory fuel rate), 
and the Tax Percent (e.g UK currently set at 20%). In use, the potential VAT 
calculation employs the lower of either the Distance Rate, or the client reimbursable 
rate, plus the combination of miles travelled, and the tax percent. 

Business Purpose 

This enhancement adds flexibility when 
calculating VAT rates for car mileage. 



Concur Release Notes Page 9 Expense Professional / Premium 
December 2012 Concur Clients 

This approach separates the maintenance of car reimbursement rates from the 
maintenance of tax rates, allowing each administrator to independently make 
adjustments without consideration of potential impact to the other area. 

What the Administrator Sees 

The administrator configuring Complex Distance calculations in Tax Administration 
will see both the Distance Rate and the Tax Percent columns for this calculation type.  

 

 Configuration 

This feature is accessed using the procedure below: 

1. As the Expense Configuration administrator, click Administration > 
Expense Admin > Tax Administration. 

2. Click the Tax Authorities tab, then click New. 

3. Complete the steps in Step , then click Next. 

4. In Step , click New, name the tax rate type, then select Complex Distance 
under Calculation Method. 

 

5. Complete the configuration steps as required. 

 Refer to the Expense: Value Added Tax (VAT) / Tax Administration Setup 
Guide for more information. 
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Section 3:  Expense Pay 

The following features are included in this service release. 

Expense Pay EMEA - Euro: Payment Manager - Pre-Funded Account 
Now Available  

Overview  

Expense Pay EMEA– Euro has been 
expanded to now include a pre-fund 
funding option for clients based in Euro 
countries. There are now two funding 
options for Euro clients to fund their 
payments: 

• SEPA B2B Direct Debit 

• Pre Fund 

The payments are in Euro. An administrator now has the ability to request a pre-fund 
funding account that will be managed by Concur. Concur will open a Euro account on 
behalf of the client in London, and the client will send funds via SEPA Credit Transfer 
or wire to fund the reimbursements that Expense Pay will then make to their 
employees and card issuer on their behalf. 

This offering includes the following features: 

• Support for pre-funded funding accounts. 

• Localized Pre-fund Funding Account page 

 Refer to the Expense Pay User Guide for Professional/Premium for more 
information. 

Configuration 

This feature requires a contract with Concur. Contact Concur Client Services to begin 
the process of adding this feature. 

Payment Manager - Employee Banking: Account and Routing Numbers 
are Now Masked  

Overview  

For this release, when a user enters 
account and routing numbers to the 
Profile > Bank Information page, the 
numbers now become masked except 
for the last four digits. The account and 

Business Purpose 

This enhancement now allows a client 
to choose how they will fund their Euro 
payments: either by sending in funds 
required (Pre-fund) or by authorizing 
Concur to debit their funding account 
(Direct Debit).  

Business Purpose 

This enhancement provides additional 
security on the Bank Information page. 
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routing numbers are displayed unmasked if they are in Failed status so that the 
employee can update their banking information. 

 

Configuration 

No additional configuration is required to use this feature. 

Payment Manager - Funding Account: Account Numbers are Now 
Masked  

Overview  

For this release, when a user enters 
account numbers to the Funding 
Account page, the numbers now 
become masked except for the last four 
digits. The account numbers are 
masked for internal user and any user with a proxy role. For users with 
reimbursement management roles, the account numbers are masked if they are 
confirmed and unmasked if they are not confirmed.  

Business Purpose 

This enhancement provides additional 
security on the Funding Account page. 
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Configuration 

No additional configuration is required to use this feature. 

Payment Manager - Funding Account: US Direct Debits Now Include 
Client-defined Batch Names 

Overview  

For this release, direct debits in the US 
will now include the name of the batch 
as defined by the client in Payment 
Manager. This allows clients with 
multiple batches and who use a single 
funding account to see the batch names 
they have defined in Payment Manager 
on their bank account statement. This 
facilitates easier reconciliation. 

Configuration 

No additional configuration is required to use this feature. 

Business Purpose 

This enhancement allows clients with 
multiple batches and who use a single 
funding bank account to see the batch 
names they have defined in Payment 
Manager on their bank statement for 
easier reconciliation. 
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Section 4:  Jobs 

The following features are included in this service release. 

Support for MasterCard Virtual Card Accounts (VCA)  

Overview  

With this release, support for the 
MasterCard Virtual Card Account (VCA) 
is now integrated into Expense. Now, 
card transactions of the VCA type ("V") 
can be configured and managed in the 
Manage Accounts tab of Company Card. This feature is ideal for clients who 
integrate their purchasing portal with the card issuer's application in order to 
generate the VCA. 

Configuring for Virtual Card Accounts in Company Card Admin 

In order to support VCAs, Concur Expense requires information about the Managing 
account; that is, the account higher in the hierarchy which has the liability for the  
VCAs.  A company may have one or many Managing accounts in use; each account 
must be pre-created in Expense prior the import of VCAs and transactions. 

When the Company Card admin opens the Manage Accounts tab, they will see the 
new Managing choice under the Account Type drop down list. 

 

The available Payment Types are limited to CBCP payment codes. Once configured, 
the Payment Type choice cannot be changed in Expense.  

Business Purpose 

This enhancement further integrates 
support for the VCA card type in 
Expense. 
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Searching for VCA Card Accounts 

To accommodate the new card account type, the Search function now features "All 
Individual and Managing Accounts" as a search criteria the Card admin can draw on. 

 

Configuration 

The client should submit a Service Request to Support to enable this feature. 

 Refer to Expense: Company Card User Guide for more information. 
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Section 5:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly feature set. This new 
document, the Client Admin Release 
Summary, is an abbreviated list with 
short descriptions of each feature. By reviewing this document the client can quickly 
determine what features to further investigate. This information has been available 
for Expense for some time and has now been expanded to other areas. 

 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

Business Purpose 

This enhancement provides a quick 
overview of the key changes, reducing 
the time it takes to review. 



Concur Release Notes Page 16 Expense Professional / Premium 
December 2012 Concur Clients 

 

(Other administration help modules have similar links.) 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 
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Section 6:  Supported Configurations 

The following configurations are either supported or no longer supported with this 
service release.  

Certifications for This Release 

Support for Firefox v. 15.0.0 

Support for Firefox versions 15.0.0 under both the Mac OS X and Microsoft Windows 
operating systems is certified for this release. 

Support for Google Chrome v. 21.0  

Support for Google Chrome version 21.0 under both the Mac OS X and Microsoft 
Windows operating systems is certified for this release. 

Upcoming Certifications 

Support for Internet Explorer v. 10.0 and Windows 8 

Support for Internet Explorer 10.0 under Microsoft Windows version 8.0 will be 
included in an upcoming release. 

Support for Chrome v 23.0 

Support for Chrome 23.0 under both the Mac OS X and Microsoft Windows operating 
systems will be included in an upcoming release. 

Support for Firefox v. 16.0  

Support for Firefox versions 15.0 under both the Mac OS X and Microsoft Windows 
operating systems will be included in an upcoming release. 

Support for Safari 6.0 with Mac OS X 10.8 

Support for Safari 6.0 under Mac OS X version 10.8 will be included in an upcoming 
release.
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Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, December 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2013 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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Release Notes – December 2012 

FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR 

Finding Additional Product Release Notes 

For Travel release notes, log in to Concur Client Central, then click Resources > 
Document Library > Travel and then either TMC Partner or Direct Customers. 

For all other products, log in to Concur Client Central, then click Resources > 
Release Documentation > Release Notes to select and download additional 
product-specific release notes matching your Concur solution(s): 

 

https://community.concur.com/web/guest/home
https://community.concur.com/web/guest/home
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Section 1:  Resolved Issues - Expense 
Case ID Case/Defect Description 

121029-
000202 

Expense / Jobs - Extracts: 
Issues with the midtier are causing extracts to fail. 

121029-
000115 

Expense / Localization - Simplified Chinese: 
Client-requested translation change for instructional text. 

120916-
000089 

121129-
000871 

Expense / Authorization Request: 
Header fields are editable free-form fields, without list capability as expected. 

121105-
001692 

Expense / Google Maps: 
Google Maps is reverting back to the original route that was changed to add 
waypoints, then re-opened for additional waypoint changes. 

121120-
000151 

121126-
001664 

121128-
000671 

Expense / Tax and Reclaim Groups: 
Access is denied when attempting to access Tax and Reclaim Groups 
(Australia GST) as administrator. 

121203-
000327 

Expense / Edit Multiple Expenses: 
The correct date string format is not saved by the system when editing a 
Custom field configured with the Date datatype. 
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Section 2:  Documentation Updates 

The following documentation changes are included in this service release. 

New Client Admin Release Summary Document 

Overview  

Clients can now take advantage of a 
new document summarizing Concur's 
monthly administrative feature set. This 
new document, the Client Admin 
Release Summary, is an abbreviated list 
with short descriptions of each feature. By reviewing this document the client can 
quickly determine what features to further investigate. 

Where to Find the Client Admin Release Summary 

Clients can find this document in one of two ways: 

• Using the Expense Admin Help: Clicking Help > Expense Administration 
Help opens the help system - use the upper-left link to open the summary 
doc: 

 
 

• Concur Client Central: Log in, then proceed to Resources > Release Docs > 
Client Admin Release Summary 

Business Purpose 

This enhancement reduces the time it 
takes to review the monthly release 
feature set. 
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Configuration 

The will to know and desire for knowledge is required to use this feature. 

Release Notes Now Available in Product-Specific Documents 

Overview  

With this release the client can now 
choose from product-specific release 
notes, each document or group of 
documents matching a specific Concur 
offering. Now, if one administrator is 
tasked with reviewing resolved issues, 
they can download a document with only case information in it. The Invoice user can 
download either Invoice release notes, or both Invoice and Mobile if that solution 
applies to the client site. 

How It Works - Concur Client Central 

Beginning in April a table will now be displayed when the user logs in to Concur and 
proceeds to Release Documentation > Release Notes using the Resources menu. 
The design of the table allows the client to use the uppermost row of the table to 
quickly identify their Concur product and what notes are applicable to their solutions: 

Business Purpose 

Administrators can now build the set of 
release notes they need for their site 
without sorting through unnecessary 
material. 
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Each set of release notes include descriptions on the cover detailing what supporting 
products can be found within the document. For example, the client who reviews 
Expense Pay changes does so by downloading the Expense - Professional/Premium 
release notes. 

Help System Updates 

The Concur administrative Help systems now include links to release notes as well. 
When the user opens administrative Help (only), the leftside navigational area now 
features the What's New link for the product release notes, plus additional links to 
Mobile if that product is applicable to the solutions at the client site. 
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With this update the administrator can now avoid logging in to Concur Client Central 
to view the release notes for their product(s). 

Restrictions 

To ensure security and "no see" restrictions, only the administrative Help systems 
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links - 
no End User Help system allows viewing of the notes. 

Configuration 

No additional configuration is required to use this feature. 
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Legal Notice 

Information contained in this document applies to the following products in effect at 
the time of this document's publication: 

 

Travel & Expense, December 2012 

 

The above product(s) and information contained in this document are subject to 
change without notice. Accordingly, Concur Technologies, Inc. disclaims any 
warranties, express or implied, with respect to the information contained in this 
document, and assumes no liability for damages incurred directly or indirectly from 
any error, omission, or discrepancy between the above product(s) and the 
information contained in this document.  

© 2004 – 2013 Concur Technologies, Inc., Redmond, Washington. All rights 
reserved. 

Concur® is the trademark of Concur Technologies, Inc. All other company and 
product names are the property of their respective owners. 

Published by Concur Technologies, Inc. 
18400 NE Union Hill Road 
Redmond, Washington  98052 
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